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  I 

Precautions 

Warning 

 

 

Remove power from the controller before installing option cards, changing 
switch settings, changing jumper settings, or doing hardware maintenance 
tasks. 

Failure to observe these precautions can result in exposure to a potentially 
lethal shock hazard. 

All wiring should be done by an experienced technician and be installed in 
accordance with national and local electrical codes.  To avoid serious 
personal injury and damage to equipment, follow all warnings and cautions 
provided in the controller installation manuals. 

 

Caution 

 

 

If a controller shows signs of having been damaged during shipping, do not 
power up or install the controller.  Save all packing materials and report any 
damage to the carrier immediately. 

When the controller is powered up, the outputs may be activated.  Consider 
the effects on your process before powering up the controller.   

Read the grounding guidelines in this manual before grounding the 
sensors, external power supply, or controller board. If the grounding 
guideline scenarios in this manual do not cover your situation, consult the 
factory before grounding the sensors, external power supply, or controller 
board. 

We recommend placing the controller in standby mode until you have 
configured the controller for your application.   

 Instructions for using an optional display board to put the controller in standby 
mode are in Chapter 10.  

 Instructions for using a MODBUS master to put the controller in standby 
mode are in Using the MODBUS Protocol with 2C and 4C Controllers 

Remove power from the controller before changing DIP switch settings.  

 



 

II 
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About this Guide 
 

This guide contains information about: 

 controller features, hardware, and installation – see Section A 

 Multi-Comm software installation and use – See Section B 

 2C and 4C display boards – see Section C 

 2C and 4C configuration parameters – see Section D 

 frequently asked questions – see Section E 
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Section A – Controller Features, Hardware, 
and Installation 

 
This section contains information about: 

 controller features and setup sequence – see page 1-1 

 order codes and specifications – see page 2-1 

 hardware setup and wiring – see page 3-1 

 mounting 2C and 4C boards – see page 4-1 
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1. Introduction to 2C and 4C Controller 

1.1 Overview 
The 2C and 4C controllers are control boards that can perform PID or On/Off 
temperature control for two zones (2C) or up to four zones (4C).  

I/O for the 2C includes two analog inputs, three digital inputs, and ___ digital outputs. 

I/O for the 4C includes four analog inputs, four digital inputs, and six digital outputs. 

Smaller modular plug-in boards provide communication options. 

Several optional display boards with buttons are available. When connected to the 
4C board with a ribbon cable, a display board can be used to: 

 select a zone 

 view the process value and setpoint for the selected zone as shown below 

 change the setpoint 

 view and change configuration parameter values 

You can also use a personal computer to do all these tasks.  See 1.3.3 for more 
information. 
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1.2 Setup and Configuration Process 
A high-level view of the setup process is provided by the table below. 

Step Task Section or 
Chapter in this 

Guide 

1 Mount the 2C or 4C board and the optional display board.  Connect the 
display board (if used) to the 2C or 4C board using the ribbon cable 
provided with an optional display board. 

4 

2 If you plan to use the 2C or 4C board with different input types than those 
specified when you ordered the board, set the input jumpers.1 

3.2.2 

3 Unless you plan to communicate with the 2C or 4C controller using only 
an optional display board, set the starting MODBUS address for each 2C 
and 4C board. 

3.3 

4 Wire inputs and outputs. 3.6 

5 Install power supplies and connect power supplies to the 2C or 4C board. 3.5.1 

6 Decide whether to ground the 2C or 4C board.  Read the grounding 
guidelines in this manual before grounding the sensors, an external power 
supply, or the 2C or 4C board. If the grounding guideline scenarios in this 
manual do not cover your situation, consult the factory before grounding 
the 2C or 4C board, an external power supply, or the sensors. 

3.5.2 

7 If you plan to configure the 2C or 4C board using a personal computer, 
connect the 2C or 4C board to the PC (or to the network to be used to 
communicate with the PC). 

3.4.4 

8 If you plan to configure the 2C or 4C board using a personal computer, 
set up the appropriate communication port on the PC. 

3.4.5 

9 Power up the 2C or 4C board. 3.5 

10 If you plan to configure the 2C or 4C board using a Multi-Comm computer, 
install Multi-Comm and configure all zones using the procedure in this 
manual. 

– or – 

If you plan to configure the 2C or 4C using an optional display board, 
follow the procedure in this manual. 

– or – 

If you plan to configure the 2C or 4C using a MODBUS host, read Using 
the MODBUS Protocol with 2C and 4C Controllers. 

Descriptions of all control parameters are in this manual. 

Section B     
  

 

Section C 
 

 

— 
 

Section D 

 

                                                      

1 Input jumpers are set at the factory for the input types you ordered. 
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A more detailed look at the configuration and tuning process for each zone is 
provided below.  

 
Step 

 
Action 

1 Power up the controller. 

2 Select the zone. 

3 Put the controller in standby mode. 

4 If you plan to use a temperature input (thermocouple or RTD) and do not plan 
to use the default units of measure Fahrenheit, select the units of measure. 

5 Specify the input type for each zone only if different from the input types 
specified when the controller was ordered.  If the input is linear, scale the input.
 
Changing the input types requires recalibration of the affected zones. 

6 Optional – If you plan to use an optional display board, specify the number of 
decimal places to be stored and displayed, and the display refresh rate.  If you 
do not configure these display parameters, the controller will use the defaults 
listed in Section D. 

7 Choose how the outputs will be used and configure the parameters that apply 
to the output function.  

8 For on/off control, customize the output operation using the hysteresis (heating 
only or cooling only) and deadband (heating and cooling). 

For Autotuning, prepare the process and initiate the operation. 

For manual tuning of PID, specify a manual offset and other tuning values. 

9 Optional – Configure alarms. 

10 Optional – Configure single-setpoint ramp or multi-segment recipe (4C only). 

11 Recommended – Specify the loop break time, and configure failsafe outputs to 
be used if the controller detects a problem with the input. 

12 Adjust the setpoint. 

13 Put the controller in normal (automatic) mode. 

14 Change the security access level to the most restrictive level that is appropriate 
for your site. 
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1.3 2C and 4C Features and Benefits 

1.3.1 Control Versatility 

The 2C and 4C boards can implement PID and on/off control, as well as execute 
custom recipes.  The 2C and 4C boards also support a manual mode that overrides 
automatic control.  In manual mode operators can use an optional display board or a 
personal computer to control the outputs by entering a fixed output percentage value.  
Transfer from PID to manual is “bumpless”.  Information about the advantages of 
each of these supported control types is in 1.6. 

When PID control is selected, you can take advantage of the controllers’ Autotune 
feature for easy tuning of the proportional, integral, and derivative components of the 
control algorithm. 

1.3.2 Alarm Annunciation 

The 4C boards can be configured to use one or more outputs for annunciation of high 
or low process alarms, deviation alarms, inverse band alarms, normal band alarms, 
or recipe events.   

You can also view process alarms and controller error codes for both 2C and 4C 
boards with an optional display board, or a personal computer running Multi-Comm or 
serving as a MODBUS host.  Each display board has an LED dedicated to alarm 
annunciation. 

1.3.3 Ease of Configuration 

To configure a 2C or 4C device, you have several options. 

 An optional display board (display, buttons or keypad, and LEDs) can be 
connected to the 2C or 4C control board with a ribbon cable.  This display 
and keypad can be used to configure all of the setup parameters described 
in this manual, and to monitor process values and setpoints for all zones.  
For information about using the optional display, see Chapter 15. 

 A personal computer and the Multi-Comm application can be used to 
configure the 2C and 4C configuration parameters using USB or RS-232 
one-to-one communication, or using an RS-485 multi-drop network.  Multi-
Comm has a convenient user interface that also makes it easy to monitor 
zone process values, save configurations, and load configurations to 
multiple 2C and 4C boards quickly and easily.  For information about using 
Multi-Comm, see Section C. 

 A personal computer serving as a MODBUS host can be used to configure 
all 2C and 4C parameters over a network.  The MODBUS host can also 
read process values, status messages, and other information about the 2C 
and 4C devices.  For information about using the MODBUS protocol with 2C 
and 4C boards, see Using the MODBUS Protocol with 2C and 4C 
Controllers. 
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1.3.4 Ramp/Soak Recipes 

The 4C board can be configured to execute ramp/soak recipes on demand.  A recipe 
consists of up to eight segments.  For each segment you can configure a unique 
ramp time, soak level (setpoint), and soak time.   

If your process is not responsive enough to achieve the setpoint within the ramp time 
(or maintain the soak level for the entire soak time), you can use the recipe 
“holdback” parameter to “stop the clock” on the ramp time (and soak time) if the 
setpoint differs too much from the process value.  

Execution of a recipe can be started, paused, resumed, and terminated using an 
optional display board or using a communications interface. 

If your process requires recipes with more than the eight segments that the 4C on-
board parameters can handle (or you want to run recipes through a 2C board), you 
can set up a personal computer as an operator station running Multi-Comm.  You can 
use Multi-Comm to create more complex recipes, store the recipes on the PC, and 
execute the recipes on the 2C or 4C under the direction of the Multi-Comm PC.  

Alternatively, 4C boards can be configured to execute a single gradual ramp to 
setpoint at startup or on demand.  Holdback can also be applied to this operation.  
See Chapter 12 for more information about ramp/soak capabilities.  

1.3.5 Communication Options 

Plug-in communication option cards are available.  Any of these communication 
options can be used with any 2C or 4C board.  These communication options allow 
your personal computer to communicate with a 2C or 4C board.   

 The RS-232 option card or USB option card makes it easy to use Multi-
Comm to communicate with a single board. 

 Option cards are also available to allow your PC to communicate with 
multiple boards via Ethernet or an RS-485 multi-drop network.  Your PC can 
serve as a MODBUS host or a Multi-Comm configuration and operation 
station.  
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1.4 Modes of Operation 
1.4.1 Control Modes 

Unless all standard outputs are set to     or     (alarm), the 2C and 4C 
devices support several modes of operation for control, as well as a special mode 
used to tune the unit automatically for PID control.2 

The table below summarizes the control modes and shows the display (on an 
optional display board) used to select each.  Instructions for using an optional display 
board to display and change the mode are in Chapter 10.  

Control 
Mode 

Selection 
Display 

Description 

normal     

   

When the controller is in normal mode, the outputs are based on 
the controller’s calculations in accordance with the configured 
control strategy, dependent on the input received.  

standby     

    

When the controller is placed in standby mode, the controller does 
not calculate any outputs until the controller is taken out of 
standby.  While in standby, the control outputs are in their 
unactivated state.  

manual 
(fixed output 
percentage) 

     

   

When the controller is placed in manual mode, then, regardless of 
the configured control strategy and the input received, the outputs 
used are the fixed percentages specified by the operator using the 
percent 1 and percent 2 values.  See 16.5 for the procedure. 

Autotune     

     

When Autotune is selected, the PID outputs are put under the 
control of the Autotune algorithm, and dependent on the input 
received.  Autotune is not always available.  The controller and 
the process must be prepared before the controller is placed in 
Autotune mode.  See 29.2 for details.  

ramp/soak 
start 

    

 .  

If the controller’s ramp/soak parameters have been used to 
enable the controller to execute a single-setpoint ramp or a multi-
step recipe, then this choice is available.  When ramp/soak start is 
selected from the list of available modes, the single-setpoint ramp 
or multi-step ramp will be executed, based on the values stored in 
the controllers ramp/soak parameters.  The outputs will be 
calculated by the controller to achieve the recipe setpoint.  The 
recipe setpoint will be manipulated by the controller in accordance 
with the ramp and soak segments configured using the controller’s 
ramp/soak parameters. See Chapter 25 for details. 

ramp/soak 
hold 

    

  .  

If the controller is running a multi-step recipe based on the 

ramp/soak parameter values (that is, if  .  is alternating with the 
display of the PV), then the ramp/soak hold choice is available on 
the list of modes.  When this choice is selected, the setpoint is 
held at the level reached when the recipe was put on hold. 

resume 
ramp/soak  

    

  .   

If a recipe is currently being held (that is, if   .   is alternating 
with the display of the PV), then the resume ramp/soak recipe 
choice is available on the list of modes.  When this choice is 
selected, the controller resumes execution of the recipe.   

                                                      

2 When all standard outputs are off or used for alarm annunciation, the instrument functions as a non-
controlling indicator.  When the outputs are not used for control, the operating modes are not applicable 
(because they are all related to the behavior of outputs), so no mode is displayed when you press the 
mode enter key.  
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1.5 Security 
A 2C or 4C board can be configured to limit the values that can be changed using an 
optional display board.  For example, the access level can be set to allow operators 
to change only the setpoint or the manual mode output percentage. 

A controller can be set to any of the access levels in the table below.  The sequence 
of levels in the table is from most restrictive to least restrictive.  New 2C and 4C 
boards are shipped with the access level set to      (configuration).  

Instructions for changing the access level are in Chapter 30 

Displayed 
Abbreviation 

Access 
Level 

 
Description 

   .  keypad lockout Highest security level; no access. 

While the access level is “keypad lockout”, no controller values can 

be changed, not even the setpoint. To escape, press the   key 

for approximately ten seconds, until       is displayed, then 

press . 

   setpoint only Setpoint or manual outputs can be adjusted; no access to 
mode or menus. 

When the access level is “setpoint only”, the keypad can be used to 
change the setpoint or the manual mode output percentage.  
However, the operator will not be able to change the controller from 
normal (automatic) mode to manual, and vice versa.  

     setpoint plus 
mode 

Setpoint or manual outputs can be adjusted; mode can be 
changed; no access to menus. 

When the access level is “setpoint plus mode”, the keypad can be 
used to change the setpoint, manual mode output percentage, and 
control mode, including executing recipes, and switching from 
normal (automatic) to manual, and vice versa.  

     user All the “setpoint plus mode” functions, and limited access to 
menus.  

When the access level is “user”, the keypad can be used to do all 
the functions available in “setpoint plus mode”.  At the “user” level, 
the keypad can also be used to view and change the values on the 
control menu (tuning parameters), adjust the Autotune damping 
parameter, and view and change all the ramp/soak parameters. 

     configuration All the “user” functions, and access to all menus except 
calibration. 

When the access level is “configuration”, the keypad can be used to 
perform all controller functions and access all menus, except the 
calibration menu.   

    







factory 

 
 

 

Access to everything. 

When the access level is “factory”, the keypad can be used to do all 
controller functions, including re-calibrating the controller. 

The controllers are calibrated at the factory.  If you don’t change the 
input type, usually the controllers will never need re-calibration.  See 
19.2 for the circumstance that dictates re-calibration.  Do not leave 
the controller set to this access level after you have re-
calibrated the controller. 
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1.6 Control Types Supported 

1.6.1 Overview 

A 2C or 4C board supports PID and on/off control.  Autotuning is available for PID 
control.  The type of control for each of the standard outputs is specified using the 
output menu output type parameter.  The outputs can be set for different types of 
control.  One or more outputs can be used for alarm annunciation instead of control.   

The advantages and disadvantages of both types of control are described briefly 
below. 

1.6.2 PID Control 

When Proportional-Integral-Derivative (PID) control is used, the controller modulates 
output power by adjusting the output power percentage within a proportional band.  
Power is proportionally reduced as the process temperature gets closer to the 
setpoint temperature.  The integral action affects the output based on the duration of 
the process value’s variation from the setpoint, and the derivative action affects the 
output based on the rate of change of the process value. 

PID control has the following advantages: 

 minimizes overshoot 

 enhances stability 

 compensates for process lag 

The proportional band, derivative action (rate), and integral action (auto reset) 
parameters are automatically adjusted by the Autotune operation described in 
Chapter 28.  

PID control is appropriate for processes with the following characteristics: 

 temperature lags exist 

 load changes are present 

 overshoots need to be minimized 

 very accurate control is required 

PID is not appropriate for: 

 underpowered processes 

 processes that use compressors, blowers, or other mechanical devices that 
cannot tolerate constant cycling 

1.6.3 On/Off 

On/off control has two states, fully off and fully on.  

On/off control can be used where: 

 process is underpowered and has very little heater storage capacity 

 some temperature oscillation is permissible 

 electromechanical systems (compressors) make rapid cycling undesirable 
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To prevent rapid cycling, the controllers allow you to configure a deadband and a 
hysteresis value for on/off control. 

1.6.3.1 Use of Hysteresis 

If you are using a single output for control, then use the hysteresis parameter to 
reduce frequency of cycling. 

The hysteresis value represents a temperature value that the controller uses to 
separate the on and off transitions of the individual outputs.  (You configure the 
Output 1 and Output 2 hysteresis values independently.)  

For example, in the diagram below, the setpoint is 100 and the hysteresis value is 10.  
In this case the output would be on from startup until the process value reaches 105 
(the setpoint plus half the hysteresis value).  After overshoot, the PV falls, but the 
controller does not turn the output on again until the temperature falls to 95 (the 
setpoint minus half the hysteresis value).  

  

 

1.6.3.2 Use of Deadband 

The controllers also permit you to specify a deadband value for each on/off output.  
In an application where two of the controller’s outputs are used to control heating and 
cooling of the zone, this has the effect of defining a band around the setpoint in which 
neither the heating nor the cooling output is on.  This avoids having the heating and 
cooling devices working against one another.3 

To allow you to optimize the control of your process, the heating deadband and the 
cooling deadband can be different values.  When the deadband value is applied to an 
output, it has the effect of shifting the setpoint and the hysteresis for that output.  In 
the diagram below we refer to the setpoint the controller actually uses as the 
“effective setpoint.”  When a deadband is configured, the value of this effective 
setpoint is different from the value of the displayed setpoint. 

                                                      

3 However, if your application sometimes requires use of heating and cooling simultaneously, you can 
specify a negative deadband value.  The range of valid deadband values is affected by input type; see 
22.2.2 for details.  
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For a heating (reverse-acting) output, a positive deadband (value greater than zero) 
moves the effective setpoint used by the controller below the displayed setpoint.  For 
cooling (direct-acting outputs), a positive deadband moves the effective setpoint used 
by the controller above the setpoint displayed.4   

In the diagram below, the setpoint is 100, the hysteresis for each output is 10, and a 
deadband of 10 has also been configured for each output.  (These are probably not 
realistic values for most processes, but we’re using these values to demonstrate the 
controllers’ behavior when hysteresis and deadband are configured for both heating 
and cooling outputs.)  

 

The heating output is on until the process value reaches 95 (setpoint minus heating 
deadband plus one half heating hysteresis), but the overshoot does not trigger the 
cooling output until the temperature reaches 115 (setpoint plus the cooling deadband 
plus half the cooling hysteresis).   

The cooling output stays on until the PV reaches 105 (setpoint plus cooling 
deadband minus one half cooling hysteresis).  The heating output does not come on 
until the PV has dropped to 85 (setpoint minus heating deadband minus one half 
heating hysteresis).  The heating output goes off when the PV gets to 95 (setpoint 
minus heating deadband plus one half heating hysteresis).   

1.7 Setpoint 

1.7.1 Introduction 

The value of the PV and the setpoint currently being used (“active setpoint”) are 
always displayed (for the selected zone) on an optional display board when a 2C or 
4C device is operating in normal mode.    The setpoint used (and displayed) can 
come from these sources.  

 The active setpoint can be set using the keys on a display board. 

 The active setpoint can come from an active recipe stored in the controller.   

 The active setpoint can be written to the controller from host computer. 

If a single setpoint ramp or multi-step ramp/soak recipe stored in the controller is 
active, this setpoint takes precedence over a setpoint from a remote host. 

                                                      

4 A negative deadband value has the opposite effect. 



Introduction to 4C Controller 

900M231U00A  Athena Controls, Inc. 1-11 

1.7.2 Setpoint from a Recipe 

Each zone of a 4C device can be configured to execute a single ramp to setpoint, or 
a multi-step ramp and soak recipe (eight steps maximum).  As execution of the ramp 
or recipe progresses, the setpoint is changed by the controller as specified in the 
recipe.  Starting, pausing, and terminating recipe execution is described in 12.5.  
Instructions for configuring recipes are in Chapter 25.   The setpoint range applied to 
recipe soak levels is configured using the setpoint low and high limit parameters 
described in 19.6.2 and 19.7.2. 

Multi-Comm software can be used to configure Multi-Comm recipes that have any 
number of steps.  (The recipes are stored on the Multi-Comm host computer, not in 
the controllers.)  If a 2C or 4C controller is connected to a Multi-Comm host 
computer, the operator can execute a Multi-Comm recipe under the direction of the 
host, which sends the controller setpoint values in accordance with the recipe.  
Instructions for configuring Multi-Comm recipes are in Section B. 

1.7.3 Setpoint from a Host Computer 

If a controller is connected to a Multi-Comm host computer or to a MODBUS host 
(master), the setpoint in the controller may have been written to the controller by the 
host computer.  The setpoint range applied to setpoints that are configurable using a 
host computer is configured using the setpoint low and high limit parameters 
described in 19.6.2 and 19.7.2. 

Host computers can write a new setpoint to either RAM or the EEPROM (or to both).  
The controller uses the setpoint stored in RAM.  If the setpoint is also stored on the 
EEPROM, the setpoint will be retained, even when power to the controller is turned 
off.  The setpoint stored on the EEPROM will be written to RAM when the controller is 
powered up.  

However, a host computer can wear out the EEPROM by writing to it too many times.  
Do not write the setpoint to the EEPROM when you are writing a temporary setpoint 
to the controller, such as when you are ramping to a final setpoint under the direction 
of a MODBUS master. 

1.8 Alarm Annunciation 

1.8.1 Alarm Types Configurable 

Each alarm can be configured to be activated when a specific condition exists.   

 process alarm – Activated when the process variable reaches the alarm value 
(alarm setpoint parameter value), independent of the PV’s relationship to the 
process setpoint.  A high process alarm activates at and above the alarm 
setpoint.  A low process alarm activates at and below the alarm setpoint.  For 
example, if you want an alarm to alert the operator when the PV goes up to 200, 
then configure the alarm as a high process alarm, and specify the alarm setpoint 
as 200. 

 deviation alarm – Activated when the process variable deviates from the 
process setpoint by the amount specified using the alarm setpoint parameter 
value.  A high deviation alarm activates when the PV is above the process 
setpoint by the amount specified using the alarm value.  A low deviation alarm 
activates when the PV is below the process setpoint by the amount specified 
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using the alarm value.  For example, if you want an alarm to alert the operator 
when the PV is 50 below the setpoint, then configure the alarm as a low deviation 
alarm, and specify the alarm value (using the alarm setpoint parameter) as 50. 

 inverse band alarm – Activated when the process value is within a specified 
band centered around the setpoint.  For example, if you want the alarm to alert 
the operator when the PV is 10 units (or less) above or below the process 
setpoint, then configure the alarm as an inverse band alarm, and specify 10 for 
the alarm setpoint parameter value. 

 normal band alarm – Activated when the process value is outside a specified 
band centered around the setpoint.  For example, if you want the alarm to alert 
the operator when the PV is 10 units (or more) above or below the process 
setpoint, then configure the alarm as a normal band alarm, and specify 10 for the 
alarm setpoint parameter value. 

The type of alarm (process high, process low, deviation high, deviation low, inverse 
band, or normal band) is referred to as the alarm operation.  The alarm menu 
contains an alarm operation parameter for each of the two alarms. 

For each alarm there is also an alarm action parameter.  When an optional display 
board is used for configuration, this parameter is the first in the alarm menu for each 
of the two alarms, and is used to specify how the alarm will be used.  The choices 
are: 

 off – The alarm will not be used. 

 normal –  The alarm will be indicated (on a Multi-Comm display, for 
example) only while the alarm state occurs.  The alarm indication will clear 
when the alarm state has cleared. 

 latching – Once the alarm has been indicated the alarm will remain active 

until the operator presses the  key (or a command from a host computer 
resets the alarm), even if the alarm condition has cleared before the alarm 
has been reset. 

 event – This special use of an alarm indicates that the controller has reached 
a particular point in a ramp/soak recipe.  Setting the alarm action to “event” 
reserves the alarm for use by a ramp/soak recipe.  However, the specific 
recipe event(s) that will trigger the alarm are configured using the     
(ramp/soak) menu as described in Chapter 25.  

1.8.2 Viewing Alarms on a Host Computer 

The state of alarms configured with the     (alarm) menu can be viewed on a 
Multi-Comm computer and read by a MODBUS host. 

1.8.3 Using an Output to Trigger an External Device 

Depending on the number of outputs needed for zone control, 4C devices can be 
configured to use outputs connected to external devices to annunciate alarms.   

When standard hardware outputs are used for alarm annunciation, the alarms are 
configured using alarm parameters on the      (output) menu.  These output 
menu alarm parameters provide the same configuration choices for alarm operation 
and action as the alarm menu parameters described in Chapter 23, with the 
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exception of the “event” alarm action.  Recipe events can be associated with a 
“logical” alarm only using the alarm menu.   

Alarms configured using the output menu and alarms configured using the alarm 
menu are independent of one another.   
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1.9 Configuration Sequence Matters 
A 2C or 4C board is a versatile instrument that is capable of using many types of 
input values and implementing several types of control strategies.  To support this 
versatility, a 2C or 4C board is capable of storing values for many configuration 
parameters.  Interrelationships exist between the parameters.  Therefore, it is 
important that you configure the parameters in the correct sequence.   

If you plan to use a thermocouple or RTD input and if you do not plan to use degrees 
Fahrenheit (the default unit of measure), the first step is always to specify the unit to 
be used (Celsius or Kelvin) using the      (display) menu      parameter.5  
The controller uses this unit of measure for internal operations, as well as for external 
communications.   

When you change the units of measure for temperature inputs, the controller 
recalculates any values that have already been specified.  For example, if you want 
the setpoint to be 100 C, then you must change the units from the default F to C 
before you write the setpoint of 100 to the controller.  If you change the units after 
you write the setpoint of 100 to the controller, the controller will convert the 100 F 
setpoint to 37.8 C.  In this case, you would have to reconfigure the setpoint to 100 
C to implement the control needed by your process. 

After the unit of measure has been changed, if necessary, from degrees Fahrenheit 
to your choice of Celsius or Kelvin, the next step is always to specify the type of input 
that each controller will receive if you plan to use a different type of input than the 
type specified when you ordered the 2C or 4C board.  (The 2C and 4C boards are 
configured at the factory to use the input type you ordered for each zone.) 

If you decide to use a different input type, you must reconfigure the input type to 
specify the type of thermocouple or RTD that will provide the input to the controller, 
or, in the case of a linear input, the range and units of the input (0 to 20 mA, 0 to 5 V, 
1 to 5 V, etc.)  The type of input specified affects how the controller processes the 
input signal and calculates the output needed to achieve the setpoint. 

With the exception of the unit of measure, generally the parameters should be 
configured in the sequence in which they are presented in the menus in this manual.  

In addition to being aware of the sequence in which parameters should be 
configured, you should also remember that not all parameters apply to all 
applications.  For example, if you specify that the input type is a thermocouple or 
RTD, then you will not see the low scale and high scale parameters in the input 
menu.  However, if you use a linear input, then you must specify scaling values, or 
accept the defaults (-1999 to 9999).6      

                                                      

5 The input type parameter is configured at the factory to match the type of input specified when the 
controller was ordered (see 19.5.1).  If the controller was configured at the factory for a linear input type, 
the units of measure parameter will not be included in the display menu until you change the input type.  
When changing the input from a linear to a temperature input (or vice versa), the input jumper settings 
must also be changed as described in 19.3, Re-calibration is also necessary. 

6 The database values in new (“out of the box”) 2C and 4C boards are always the default values shown in 
the tables in Section D, except in the case of the input type parameter, which is configured at the factory 
to match the type of input ordered.   
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1.10 What Happens When You Power Up the Controller 

1.10.1 Outputs 

When the controller is powered up, under some circumstances the outputs may be 
activated.  If the controller has been configured, this is good.  However, if the 
controller is new (not yet configured), then we recommend placing the controller in 
standby mode until you have configured the controller for your application.   

For instructions for putting a 2C or 4C device in standby using an optional display 
board see Chapter 16.  

A Multi-Comm computer or MODBUS host can also be used to put the controller in 
standby. 

1.10.2 Display 

When a 2C or 4C device is first powered up, the following occurs if an optional 
display board is connected to the 2C or 4C board: 

1). All segments of both lines of the optional LED display light briefly while the 
controller goes through a series of self-diagnostics.   

2) The top line briefly displays the type of controller, while the lower line displays a 
firmware version number.  Write it down and save your note!7   

3) The top line displays     , while the lower line displays the type of 
communication protocol the controller supports.   

4) The quantity of active zones is displayed.  (The controller can be configured to use 
fewer than four zones.) 

5) The quantity of detected hardware inputs is displayed. 

6) The quantity of detected hardware outputs is displayed. 

7) Finally, the process variable (PV) and process setpoint value (SV) are displayed.  
This is the normal operator display.  See Chapter 15 for more information about the 
controller displays. 

1.10.3 Setpoint 

Once the controller has been configured, its behavior at startup depends on the 
choices made during configuration. 

A 4C controller can be configured to ramp gradually up to the setpoint after the 
controller is powered up.   

If this single-setpoint ramp function has not been enabled as described in 25.3, then 
the controller’s control algorithm will use the outputs to achieve the configured 
setpoint using the configured control strategy as quickly as possible.    

                                                      

7 It is a good idea to make a note of this number.  If you phone for technical support you will be asked for 
this version information, as well as for the complete model number of the controller in question. 



2C and 4C Controller Installation, Configuration, and Operation Guide 

1-16  Athena Controls, Inc. 900M231U00A 

1.11 Menu Convention Used in This Manual 
The instructions in this manual use the following format to tell you to use a particular 
item from a menu:  <menu name> > <function>.  For example, to tell you to access 
the Alarms function on the Multi-Comm Controller menu, the instructions will say 
“Select Controller > Alarms”.  
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2. Order Codes and Specifications 

2.1 Hardware Overview 
The 4C board is designed to control up to four zones.  The 2C board is designed to 
control up to two zones. 

The 4C board features four 24 Vdc isolated digital inputs and six 24 Vdc isolated 
digital sourcing outputs that share 750 mA of current.  

The 2C board features three 24 Vdc non-isolated inputs and four 24 Vdc non-isolated 
digital sourcing outputs for which 800 mA of current is available. 

The 16-bit analog inputs can be standard process-types (4–20 mA or 0–10 Vdc), or 
low level sensors such as T/C or RTD.  

Smaller modular plug-in boards allow for communication with a personal computer. 
An optional display board is available.  

Available optional communication cards include RS 232, RS 485, USB, and Ethernet. 
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2.2 2C and 4C Model Number Breakdown (Order Codes) 

2.2.1 Analog Input Types  

Requires two selections for 2C and four selections for 4C: 

T Thermocouple (ungrounded) 

R RTD (2 wire) 

S Decimal RTD 

M Millivolt Linear 

V Volt Linear  

C Current Linear 

2.2.2 Communications 

00 None  

02 RS 232 (p/n 785A379U02) 

04  RS 485 Modbus RTU (p/n 785A379U01) 

0B USB (p/n 785A382U01) 

0E Ethernet (p/n 785A418U01) 

2.2.3 Display 

0 None 

C 4-inch square display (p/n 785A406 U01) 

H Horizontal (p/n 785A378U01) 

V Vertical (p/n 785A399U01) 

4 ¼ DIN (p/n 785A415U01) - default in code 

 
All display boards are supplied with a 36-inch (91.4-centimeter) cable. 

If you order a display board at the same time you order a 2C or 4C controller, the 
controller will be configured at the factory to use this display board. If you add a 
display board other than the small square board (p/n 785A415U01), you must use a 
MODBUS host to configure a “display type” setting on the controller. 

2.2.4 Special Options 

Consult the factory for availability of special options. 

2.3 Example of Order Number 
The example below shows the order number for a 4C controller equipped with an RS 
485 communication card and a horizontal display. 

Series Analog Inputs (4) Communications Special 
Options 

 

4C -T-T-R-C 4 H 000 

4 zones Input 1 TC 

Input 2 TC 

Input 3 RTD 

Input 4 Current 

RS 485 horizontal
display 

None 
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2.4 Accessories 
614A102U01 Connector Kit 

218B044U01 Relay (SPST 30 amps)  

218B043U01 Relay (SPDT 20/10 amps)  

560E164U01 Transformer (115/230 Vac to 18 Vac @ 25 VA)  

560E165U01 Transformer (115/230 Vac to 18 Vac @ 43 VA) 

785A364U01 Power Supply (18Vac to 24Vdc @1.75 amps)  

 

2.5 Communication Cards 
You can specify a communication card when the controller is ordered; see 2.2.2. 

You may also purchase a communication card later. Part numbers follow. 

785A379U01 RS485 

785A379U02 RS232 

785A418U01 Ethernet 

785A382U01 USB 

 
Any communication card is recognized automatically by the controller.  For 
information about communication parameter defaults and available settings, see 
Chapter 28 
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2.6 Default Output Assignments 
The default output assignments depend on the number of active zones.  Instructions 
for specifying the quantity of active zones are in 16.6.   

Note that the default assignments for the first four hardware outputs with one and two 
active zones are identical in both the 4C (which has six digital outputs) and the 2C 
(which has four digital outputs). 

One Active Zone 

Hardware 
Output 

 
Use 

1 Zone 1 – heat   

2 Zone 1 – cool 

3 not used 

4 not used 

5 Zone 1 – alarm 1  

6 Zone 1 – alarm 2 

 

Two Active Zones 

Hardware 
Output 

 
Use 

1 Zone 1 – heat   

2 Zone 1 – cool 

3 Zone 2 – heat 

4 Zone 2 – cool 

5 Zone 1 – alarms 1 and 2  

6 Zone 2 – alarms 1 and 2 

 

Three Active Zones 

Hardware 
Output 

 
Use 

1 Zone 1 – heat   

2 Zone 1 – cool 

3 Zone 2 – heat 

4 Zone 2 – cool 

5 Zone 3 – heat  

6 Zone 3 – cool 
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Four Active Zones 

Hardware 
Output 

 
Use 

1 Zone 1 – heat   

2 Zone 1 – cool 

3 Zone 2 – heat 

4 Zone 2 – cool 

5 Zone 3 – heat  

6 Zone 4 – heat 

2.7 Dimensions 
4C: 4.5 by 7 inch (11.4 x 17.8 cm) PC board. All components are on top side. For a 
mounting dimension drawing, see 4.3.  

2C: 3 by 5 inch (7.6 x 12.7 cm) PC board. All components are on the top side. All 
components are on top side. For a mounting dimension drawing, see 4.2. 

2.8 Control Loops 
4C hardware supports a maximum of four control loops (one for each analog input). 
2C hardware supports a maximum of two control loops (one for each analog input). 

2.9 Operating Limits 
Ambient Temperature: 32°F to 158°F (0°C to 70°C) 
Relative Humidity Tolerance: 90%, non-condensing 
Power:18 Vac, 24 Vdc 
Power Consumption: < 100 mA @ 18 Vac for control and display; < 1 A @ 18 Vac 
for digital I 

2.10 Performance 
Accuracy:±0.20% of full scale (±0.10% typical), ±1 digit 
Setpoint Resolution: 1 count/0.1 count 
Repeatability: ±1 count 
Temperature Stability: 5 μV/°C (maximum) 
TC Cold-End Tracking: 0.05°C/°C ambient 
Noise Rejection: 100 dB common mode 
Process Sampling: 126 ms x number of active zones + 1 

2.11 Control Characteristics 
Proportional Band: 2 to span of sensor 
Integral: 0 to 9600 sec 
Derivative: 0 to 2400 sec 
Cycle Time: 0 = 200 ms; 1 to 120 sec 
Control Hysteresis: 1 to span of sensor 



2C and 4C Controller Installation, Configuration, and Operation Guide 

2-6  Athena Controls, Inc. 900M231U00A 

2.12 Input Types 
Thermocouple: B, C, E, J, K, N, NNM, R, S, T, Platinel II; Maximum lead resistance 
100 ohms for rated accuracy 
RTD: Platinum 2-wire,8 100 ohms at 0°C, (DIN curve standard 0.00385) 
Linear: 0–50 mV; 10–50 mV; 0–20 mA; 4–20 mA; 0–10 mV; 0–50 mV; 0–100 mV; 0–
1 V; 0–5 V; 0–10 V; 1–5 V 

All sensors or other analog input devices must be floating and isolated with reference 
to any ground.  For more information about grounding, see 3.5.2. 

2.13 Digital Inputs 
4C: Four channels, 24 Vdc input, optically isolated. This is the same power supply 
used by the digital outputs and shares the same 1 Amp fuse.  

2C: Three channels, 24 Vdc input; this is the same non-isolated power supply used 
by the rest of the controller and shares the same 1 Amp fuse.   

On both the 4C and the 2C each input is sourced with the internal I/O 24 Vdc power 
supply. The user’s switch is wired between the +24 Vdc convenience pin and each 
individual input pin.  

2.14 Digital Outputs 
4C: Six channels, 24 Vdc sourcing outputs, optically isolated. Total current capacity 
for all six outputs is fused at 1 Amp. The fuse is field-replaceable.   All 4C digital 
outputs are powered with the isolated internal I/O 24 Vdc power supply. The user’s 
load is wired between each individual output pin and the common 24 Vdc return pin. 
A diode clamp is provided for inductive loads.   

2C: Four channels, 24 Vdc sourcing outputs, non-isolated. Total current capacity for 
all four outputs is 800 mA available for the digital outputs. The 1 Amp fuse is shared 
between the digital I/O and the logic sections of the controller. The fuse is field-
replaceable.  

All 2C digital outputs are powered with the non-isolated internal I/O 24 Vdc power 
supply. The user’s load is wired between each individual output pin and the common 
24 Vdc return pin. A diode clamp is provided for inductive loads  

2.15 Power Supplies 
4C: If I/O isolation is not required, an 18 Vac Class Two transformer or a Class Two 
24 Vdc power supply can be connected to the two J4 power inputs.  

2C: An 18 Vac Class Two transformer or a Class Two 24 Vdc power supply can be 
connected to the J14 power inputs. 

For both the 2C and 4C an 18 Vac secondary, when rectified and filtered, will 
produce 24 Vdc unregulated.  

Consult us for transformer sizing.  

                                                      

8 Consult us for availability of support for 3-wire RTDs. 
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2.16 Display Board Interface 
An optional display board with buttons can be connected to the 2C or 4C board with 
a ribbon cable.  (Several display boards are available. See 2.4 for display board part 
numbers.)  The display board can be used to: 

 select a zone 

 view the process value and setpoint for the selected zone 

 change the setpoint 

 view and change configuration parameter values 

A display board overview is in Chapter 15.  Detailed instructions for using the keypad 
on an optional display board are in Chapter 16. 

2.17 Communications Interfaces 
Optional Isolated RS-485, RS-232 or 10/100 baseT Ethernet or USB.  
Protocol: Modbus RTU through serial port or Modbus TCP/IP with10-base T 
Ethernet. 

2.18 LEDs 
The 4C board has seven LEDs. 

D26 is the status LED, which flashes when the board is active. 

The following LEDs are lit when the associated hardware output is active: 

 D28 (also labeled “1”) 

 D29 (also labeled “2”) 

 D30 (also labeled “3”) 

 D31 (also labeled “4”) 

 D32 (also labeled “5”) 

 D33 (also labeled “6”) 

The 2C board has five LEDs. 

D21 is the status LED, which flashes when the board is active.  

The following LEDs are lit when the associated hardware output is active:  

 D10 (also labeled “1”) 

 D14 (also labeled “2”) 

 D13 (also labeled “3”) 

 D16 (also labeled “4”) 
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2.19 Software Configurability 
Multi-Comm, a user-friendly PC-based program, provides significant configurability 
function beyond that of standard or “hard-coded customized” controllers. The PC 
program will interface to the controller via the PC’s standard serial, USB, or Ethernet 
port and provide full duplication of configuration parameters accessible via optional 
display board (i.e. alarms, PID values, set points, etc.) so that the end-user can 
configure the entire system at once. 

Alternatively, a MODBUS host can be used to configure the controller, as well as to 
read process values, status messages, and other information about 2C and 4C 
devices.  For information about using the MODBUS protocol with 2C and 4C boards, 
see Using the MODBUS Protocol with 2C and 4C Controllers. 
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3. Hardware Setup and Wiring 

3.1 Overview 
Before you can use a 2C or 4C board you should set the on-board switches and 
jumpers appropriately for your application.  

 Analog sensor jumper setting and remote excitation voltage settings are 
described in 3.2. 

 The switches that can be used to specify the starting MODBUS address for 
a 4C board are described in 3.3. (An optional display board and the Serial 
menu or a MODBUS host can be used to set the starting address in either a 
2C or a 4C controller.) 

You may need to install the communication option card as described in 3.4. 

Power wiring diagrams and grounding guidelines are in 3.4.6. 

The I/O wiring diagrams are in 3.6. 

Instructions for mounting the 2C and 4C boards are in the next chapter. 
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3.2 Jumper Settings 

3.2.1 Introduction 

Jumper settings on the 2C or 4C board must match: 

 the type of sensor feeding each analog input 

 the remote excitation voltage 

Input jumpers for standard inputs are set at the factory to match the input types you 
specified when the controller was ordered.  The model number indicates the input 
types specified when the controller board was ordered.  To determine the inputs 
ordered for the controller board in hand, compare the model number on the board’s 
serial tag with the model number breakdown in 2.2.   

3.2.2 Analog Sensor Jumper Tables 

Analog Input 1 — 2C and 4C 

Sensor Type JMP 1 JMP 2 JMP 3 JMP 12 

0–1 Vdc out out in out 

0–10 Vdc out in in out 

thermocouple pins 1 and 2 out in out 

two-wire RTD pins 2 and 3 out in out 

0–20 mA, 4–20 mA out out in in 

 

Analog Input 2 — 2C and 4C 

Sensor Type JMP 4 JMP 5 JMP 6 JMP 20 

0–1 Vdc out out in out 

0–10 Vdc out in in out 

thermocouple pins 1 and 2 out in out 

two-wire RTD pins 2 and 3 out in out 

0–20 mA, 4–20 mA out out in in 
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Analog Input 3 — 4C only 

Sensor Type JMP 7 JMP 8 JMP 9 JMP 21 

0–1 Vdc out out in out 

0–10 Vdc out in in out 

thermocouple pins 1 and 2 out in out 

two-wire RTD pins 2 and 3 out in out 

0–20 mA, 4–20 mA out out in in 

 

Analog Input 4  — 4C only 

Sensor Type JMP 10 JMP 11 JMP 13 JMP 22 

0–1 Vdc out out in out 

0–10 Vdc out in in out 

thermocouple pins 1 and 2 out in out 

two-wire RTD pins 2 and 3 out in out 

0–20 mA, 4–20 mA out out in in 

 

3.2.3 Remote Excitation Voltage Table 

Voltage 2C—JMP 7 
4C—JMP 14 

2C—JMP 8 
4C—JMP 25 

20 Vdc in out 

10 Vdc out pins 2 and 3 

5 Vdc out pins 1 and 2 
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3.3 4C Switch Settings 

3.3.1 Introduction 

A set of DIP (dual in-line package) switches on the 4C board are used to set up the 
controller to use the MODBUS starting address9 stored on the EEPROM or the 
switches are used to set the starting MODBUS address for the board. 

The location of the 4C DIP switches is shown on the diagram below.  Note that the 
ON position for each switch is AWAY from the edge of the board. 

Power down the controller before changing switch settings. 

 

3.3.2 Restoring Parameter Default Values 

If all DIP switches are set to the ON position while the controller is off (no power), 
then when the power is turned back on, all parameter values will be set to their 
defaults and the message          will be displayed.  Cycle power to clear 
this message.  Re-configure all configuration parameter values, including input type.  

A MODBUS host or the Supervisor menu (see 26.5) can also be used to set al 
parameter values to their defaults. 

Restoring default values using DIP switches, the Supervisor menu, or a MODBUS 
host has no effect on stored calibration values, nor on the display board type the 
controller is set to use (and the standard button switches on that display board). 

                                                      

9 The MODBUS starting address is the address of the first zone on the card. 
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3.3.3 Setting the Starting MODBUS Address 

Regardless of the communication option selected, each zone needs a unique 
MODBUS address. If you plan to use one-to-one communication between a personal 
computer and the 4C controller, you can use the factory setting. 

When a standard 2C or 4C board leaves the factory it is set to use the MODBUS 
starting address stored on its EEPROM.    

By default, Zone 1 has the starting address of 1 (stored in the EEPROM).  
(Therefore, Zone 2 is 2; Zone 3 is 3; Zone 4 is 4.  

You can use an optional display board and the      menu (or a MODBUS host) 
to store a different starting address on the EEPROM.  Alternatively, on a 4C you can 
use DIP switches 1, 2, and 3 to assign a starting address to the board. (The starting 
address on a 2C cannot be set via DIP switches.) 

The address change will not take effect until the power to the controller has been 
cycled.  For your own convenience, we strongly recommend that you use contiguous 
numbers for zone addresses on a single board. 

The illustration below shows the 4C switch settings for starting addresses 1, 5, 9, 13, 
17, 21, and 25. 

4C Starting Address Switch Settings 
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3.4 Communication Option Cards 

3.4.1 Introduction 

Communication option cards are available for the 2C and 4C boards.  An option card 
can be installed at the factory.  However, installing one in the field is easy.  

Use the nylon snap-on stand-offs supplied with the option card to install it at the 
locations shown in the illustration below. 

Install the option card with the controller power off. 

When a 2C or 4C board is powered up after a communication option card has been 
installed, the card is detected automatically, and the controller automatically begins to 
use the new card. 

3.4.2 2C Communication Card Mounting Location 

The picture below shows a 2C board without an optional communication card 
installed. 
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The picture below shows a 2C board with an optional communication card installed. 

 

3.4.3 4C Communication Card Mounting Location 

The picture below shows a 4C board without an optional communication card 
installed. 
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The picture below shows a 4C board with an optional communication card installed. 

 

3.4.4 Communication Cards, Wiring, and Setup 

ATTENTION: All wiring should be done by an experienced technician and 
be installed in accordance with national and local electrical 
codes.   

3.4.4.1 Introduction 

An optional display board, which can be used to configure the controllers, can be 
connected to the 2C or 4C board with a ribbon cable.  For information about using an 
optional display board, see Chapters 15 and 16.      

3.4.4.2 Communication Options 

Communication options include isolated RS-485, RS-232 or 10/100-baseT Ethernet 
or USB.  
Protocol: Modbus RTU through serial port or Modbus TCP/IP with10/100-base-T 
Ethernet. 

3.4.4.3 RS-232 and RS-485 Connections 

When connecting communication wiring to the RS 485 or RS-232 option cards, note 
the terminal labels on the option board. 

Note: RS232 protocol requires three-wire cabling (see diagram below).  Grounding 
the RS-485 option card is optional (but grounding improves noise rejection).  The 4C 
board itself may be grounded under some circumstances; see 3.5.2 for grounding 
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guidelines.   

Each communication option card is isolated. If you ground a communication ground 
connect it to the PC ground, NOT the controller chassis ground.  

For information about configuring your computer to communicate with a 4C controller, 
see 3.4.5. 

 

3.4.4.4 Ethernet and USB Connections 

Ethernet and USB communication option cards are equipped with standard 
connections.  Cable the Ethernet or USB communication option card as you would 
any other Ethernet or USB device. 

The 2C and 4C controllers see a USB communication option card or an Ethernet 
communication option card as a serial port.  For information about configuring your 
computer to communicate with a 2C or 4C controller via a USB communication card, 
see 3.4.5. 

For information about configuring your computer to communicate with a 2C or 4C 
controller via an Ethernet communication card, see 3.4.6. 

3.4.5 Serial Communication Settings 

The 2C and 4C default communication settings are:      

 8 data bits 

 no parity 

 1 stop bit 

The serial port used to communicate with a 2C or 4C controller must be COM1, 
COM2, COM3, or COM4 when Multi-Comm is used.  Other software applications 
may be able to use other ports. 

Use your operating system’s Device Manager to match these settings on the serial 
port used to communicate with the 2C and 4C devices. 

For example, to set a communication port on a Windows XP machine: 
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1. Open the System Properties window by selecting Start > Control Panel > 
System. 

2. In the System Properties window, click on the Hardware tab.  

3. Open the Device Manage window by clicking on the Device Manager button on 
the Hardware tab. 

4. Expand the list of ports. 

 

5. Open the port’s Properties window by double-clicking on the name of the port. 

6. Click on the Port Settings tab and compare the port settings with 2C/4C defaults.  
If necessary, adjust the computer’s port settings. 
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7. If the operating system on your computer has not assigned the 2C/4C controller’s 
communication card to COM1, COM2, COM3, or COM4, access the Advanced 
Settings window by clicking the Advanced button in the port’s Properties 
window. 
 
In the Advanced Settings window, pick COM1, COM2, COM3, or COM4 from the 
list of ports, and then click on OK to close the Advanced Settings window. 
(Sometimes the operating system indicates that a port is in use when it really is 
not. If you are sure that a device is not on the port, you can select a port that is 
labeled “in use.”) 

8. Save the new settings for the port by clicking on OK in the port’s Properties 
window. 

3.4.6 Ethernet Settings 

The optional Ethernet communication card is set at the factory to use Dynamic Host 
Configuration Protocol (DHCP).  

To configure your computer to use the 2C/4C Ethernet communication option card, 
which uses a Lantronix® XPort® embedded Ethernet device server, use the free 
DeviceInstaller configuration utility. You can download this utility from the Lantronix 
website <http://www.lantronix.com>. 
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3.5 Power Wiring and Grounding 

Caution 

 

 

If a controller shows signs of having been damaged during shipping, do not 
power up or install the controller.  Save all packing materials and report any 
damage to the carrier immediately. 

When the controller is powered up, the outputs may be activated.  Consider 
the effects on your process before powering up the controller.   

Read the grounding guidelines in this section before grounding a 2C or 4C 
board. In some installations, it should not be grounded. If the grounding 
guideline scenarios in this manual do not cover your situation, consult the 
factory before grounding a 2C or 4C board. 

We recommend placing the controller in standby mode until you have 
configured the controller for your application.  

 Instructions for using an optional display board to put the controller in standby 
mode are in Chapter 10. 

 Instructions for using a MODBUS master to put the controller in standby 
mode are in Using the MODBUS Protocol with 2C and 4C Controllers 

Remove power from the controller before changing DIP switch settings.  

 

3.5.1 Power Wiring 

Power supplies must be supplied by the customer.  For more information, see 2.15 
and 3.5.2.  

Do not ground the power supply until you have read 3.5.2. 

The power wiring must be connected to the as shown in 3.6.      

3.5.2 Grounding Guidelines 

3.5.2.1 General Grounding of Controller Board and Power Supplies 

Before grounding the controller board, the sensors, or a power supply, read the 
following general guidelines.  Next, read the subsections below that apply to your 
sensor type.  

 A system can have only one ground point.10 

 If the sensor is a grounded thermocouple, then that can be the only ground. 
(See 3.5.2.2.2 below for guidance when multiple grounded thermocouples 
are used.) 

                                                      

10 Optional communication cards are fully isolated; therefore, the grounding point of an RS232 or RS485 
communication card (which should be connected to the PC ground, NOT the controller chassis ground) is 
NOT considered the grounding point for the system. 
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 With ungrounded sensors, grounding the control board (using the provided 
grounding lug illustrated below) to the chassis is the best choice. This 
should give the best noise performance. If the control board is grounded to 
the chassis, then the power supply and all sensors or other analog inputs 
MUST be isolated from ground. (See below for additional issues with 
powered sensors).  

 

 

4C grounding lug 
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 Grounded power supplies:  If you use a 24 Vdc power supply to provide 
power to the control board (instead of an 18 Vac transformer) and the 
negative output of the 24 Vdc power supply must be grounded to the 
chassis, then the control board and all sensors of any type MUST be 
isolated and float. The board and sensors will be grounded via the control 
board’s power supply through the bridge rectifier.  
 
In this scenario the board’s logic ground will be one diode drop (from the 
bridge rectifier) negative from the grounded power input pin.  
 
On the model 2C the grounded power input pin is J2 Pin 11.  Pin J2 12 is 
the fused positive input under this method.   
 
On the model 4C J4 pin 2 is the negative power input. J4 pin 1 is the fused 
positive input under this method.  
 
On both the 2C and the 4C boards the sensor ground is one diode drop 
positive from the logic ground. This would make the sensor ground and the 
power supply ground very close, but since the diodes do not have exactly 
the same characteristics, the two diodes (bridge rectifier and analog diode) 
do not cancel out perfectly and some difference will remain. If the sensor 
did not float, large currents would flow and damage the circuits.  

 If the control board is grounded, then the sensor ground is one diode drop 
positive with respect to the chassis. Placing the sensor conversion circuit 
approximately 0.65 V above ground allows for negative-going sensors (such 
as thermocouples) when reading below ambient or for other millivolt bipolar 
sensors. 

2C grounding lug 
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3.5.2.2 Sensor Grounding and Common Power Supplies for Active 
Sensors 

3.5.2.2.1 Introduction 

The 2C and 4C multizone controllers can be used with grounded sensors under 
certain circumstances. 

The controller’s analog input circuits have the following features/restrictions.   

 Each input channel is fully differential, with a jumper available for 
connecting the negative differential input to analog signal ground.  

 Analog signal ground is one diode drop ABOVE board ground.   

 The analog process input types are unipolar. The maximum input range is 
0.0 Vdc to +1.0 Vdc if the 10:1 jumpers are NOT used. If the 0–10 V 
jumpers ARE used, the maximum allowable input range is 0.0 Vdc to +10.00 
Vdc.  See 3.2.2 for analog input jumper tables. 

 The maximum allowable common-mode input voltage is –0.200 mVdc to 
+2.50 Vdc. 

 The analog input is bipolar only when selecting the thermocouple input type.  

3.5.2.2.2 Grounded Thermocouples 

When grounded thermocouples are required, special care must be taken.  

1. First measure both the ac and dc voltage between the ground at control board 
mounting location (chassis ground) and each sensor mounting location.  

2. The voltages cannot be greater than 50 mV ac or dc.  

3. The grounding lug on the control board cannot be used.  

4. The output of the 24 Vdc power supply or the transformer 18 Vac secondary 
powering the controller board cannot be grounded. All grounding will be through 
the sensor attachment itself. You must ensure that this method of grounding 
meets all safety requirements.   

5. For each controller select one and only one of the thermocouples and make sure 
the ground shunt for that channel is in place. Remove the ground shunts from all 
other grounded thermocouples connected to this controller board.  

3.5.2.2.3 Powered Sensors Overview 

Powered sensors typically come in three formats: two-wire, three-wire and four-wire. 
When deciding how to power these sensors, please refer to the guidelines below. 

 Sensors can be powered by the on-board excitation power supply, or 
powered by a separate isolated floating power supply.  

 The on-board sensor supply can be configured for +5 Vdc, +10 Vdc and +20 
Vdc.  

 The return for this supply is the analog sensor ground.  
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 The load capacity for this supply is dependent on the compliance voltage for 
which it is set.   

 When the on-board excitation power supply is used, typically, only one  
0–20ma type sensor can be powered because of the current limit of the on 
board supply. In contrast, multiple voltage-out sensors can be powered from 
the on-board supply up to the current limit of the compliance voltage 
selected.  

 All sensors must comply with the input voltage limitations, including the 
sensor compliance voltage limitation. 

3.5.2.2.4 Two-Wire Sensor  

Two-wire sensors are usually a 20 milliamp type. 

If powered by the on-board excitation supply, connect the plus sensor terminal to the 
remote excitation position in the analog connector. Connect the negative terminal to 
the plus position of the sensor channel. The negative position is not used. The 
sensor current is returned via the grounding jumper for that sensor channel. 

3.5.2.2.5 Three-Wire Sensor with Voltage Output 

The output signal for a three-wire sensor with voltage output must be ground 
referenced or the output signal common mode level must be below 2.5 Vdc and the 
max signal level, plus common mode level cannot exceed 4 Vdc. All limitations listed 
in 3.5.2.1 must be considered and requirement in that subsection must be met. It is 
important to check with the sensor manufacture for sensor circuit design. Using a 
fully isolated power supply for the sensor may be a better option than using the on-
board excitation supply.  

3.5.2.2.6 Three-Wire Sensor with Current Output 

The output signal of a three-wire sensor with current output must be ground 
referenced. Therefore, they cannot be powered by the on-board power supply. This is 
rarely true with current-output three-wire sensors. All limitations listed above must be 
met. In most cases, a fully isolated power supply for the sensor will be required.  

3.5.2.2.7 Four-Wire Sensors  

The output signal of four-wire sensors must be ground referenced if powered by the 
on board supply. All limitations listed in 3.5.2.1 must be met. Bridge-type sensors and 
voltage-type sensors can sometimes use the on-board excitation power supply. It is 
important to meet the common mode and max signal level voltage requirement. This 
may mean using a lower compliance voltage. Four-wire current sensors will always 
require a fully isolated power supply. 
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3.6 I/O Wiring   
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4. Mounting 2C and 4C Boards 

4.1 Choosing a Location 
The 2C and 4C controller boards are designed to be easily mounted in almost any 
enclosure.    

See 2.9 for operating ambient temperature. 

When choosing a location, do remember that switches and jumpers on the top side of 
the board must be accessible during 2C and 4C setup. 

You must maintain at least 0.250 inch clearance between a 2C or 4C board and a 
conductive surface.  
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4.2 2C Mounting Dimensions 
The 2C mounting dimensions are shown below.   

The mounting holes are sized for US #6 machine screws. 
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4.3 4C Mounting Dimensions 
The 4C mounting dimensions are shown below.   

The mounting holes are sized for US #6 machine screws. 
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Section B – Multi-Comm Installation and Use 
 

This section contains information about: 

 introduction to Multi-Comm – see page 5-1 

 installing the software and logging in – see page 6-1 

 establishing communication with controllers – see page 7-1 

 configuring local alarms – see page 8-1 

 viewing process values and changing setpoint – see page 9-1 

 changing controller mode and using Autotune – see page 10-1 

 viewing and changing controller configuration parameters – see 
page 11-1 

 configuring and running ramp and soak recipes – see page 12-1 

 storing and loading controller configurations – see page 13-1 

 logging PV and SP values – see page 14-1 
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5. Introduction to Multi-Comm 

5.1 Features 

5.1.1 Transforms a PC into an Operator Station 

Multi-Comm software makes it easy for operators to use a personal computer to 
monitor networked controllers.  Linked to the controllers by an RS-485 network, the 
PC can be used to read process values, change setpoints and other parameters, 
change controller mode, and monitor for alarms.11  Multi-Comm is also ideal for 
quickly configuring a single controller in a lab or service department, using the 
controller’s RS-232 or USB communication option.   

The Multi-Comm application uses the MODBUS protocol to communicate with 2C 
and 4C devices.  All the configuration parameter values stored in non-volatile 
memory in 2C and 4C devices can be saved to the PC for backup, and loaded to the 
same or different controllers.    

 

 

                                                      

11 Up to 32 controllers can be included on an RS-485 network without using a network repeater device.  
The Multi-Comm software can address up to 254 controllers. 
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5.1.2 Graphical Interface   

The Multi-Comm software uses a graphical user interface and familiar point-and-click 
techniques.  The main Multi-Comm display shows a virtual front panel for each zone 
in the 2C and 4C devices networked to the computer.  This virtual front panel shows 
PV and SP.   

The Multi-Comm system can be set up to show all zones on the networked 2C and 
4C devices on a single display, or only selected zones.  Any message that can be 
displayed on a 2C or 4C optional display board will also be shown on the Multi-Comm 
display.  Operators can see at a glance if a controller is in standby or other special 
mode, and if the controller detects a problem, such as an open sensor. 

Double-clicking (left button) on any zone in the main display will call up a display of 
all the parameters for that zone  A right-click on a zone displays the form used to 
change its setpoint.  A left-click on a zone selects the zone for functions on the 
Controller menu.  Many additional functions are accessible using the other Multi-
Comm menus. 

A “text only” view is available for operators who prefer to see zone setpoints and 
process variables in list form.  A left-click on a zone in the list selects the zone for 
functions on the Controller menu. 
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5.1.3 Automated Ramp and Soak Cycles  

Use the Multi-Comm Ramp and Soak function to configure any number of recipes 
consisting of any number of ramp and soak steps.  These recipes are stored on the 
Multi-Comm computer.  Under the direction of Multi-Comm, any zone on a networked 
controller can execute your choice of recipe. 

The Multi-Comm displays also provide a quick way to configure and run recipes that 
use the controller’s own recipe parameters.   

5.1.4 Logging 

The Multi-Comm application supports optional logging of SP and PV for all zones at 
configurable intervals.  Logs are saved in ASCII text files with comma-separated-
value format.  These files can be viewed, printed, and manipulated with other 
applications, such as word processing and spreadsheet software. 

5.1.5 Storing and Loading Configuration Parameter Sets 

All the zone configuration parameter values stored in non-volatile memory in a 
controller can be saved to the PC, and loaded to the same or different zones.  
Backing up a unique controller configuration on a PC is always prudent.  If a 
controller is damaged later and must be replaced, its custom configuration can be 
loaded quickly to a spare controller, minimizing down time. (If the 2C and 4C device 
was configured to support multiple zones, each zone’s configuration must be saved 
separately.) 

In large installations where many zones use the same (or almost the same) 
configuration, its easy to configure one zone using the Multi-Comm display, save the 
parameter set to the PC, then load the same parameter set to many other zones on 
the networked controllers.   

Multi-Comm can change the values of all those parameters that can be changed 
using the optional display board (that is, all the parameters described in Section D).  
To change other parameters, use a MODBUS host. 

The ability to store and load a zone configuration also enables you to reuse tuning 
parameter values that have proved to be best for certain process conditions.  If the 
responsiveness of your process is altered at times, you may find it desirable to save 
sets of tuning parameters to be used under different circumstances. 

For example, if you autotune a zone for optimum control of the temperature of an 
engraving cylinder while one size is in use, save the parameter set before installing a 
larger or smaller cylinder.  The different size cylinder may heat at a different rate, 
requiring different tuning parameters to be used for optimum control.  Save the new 
tuning as a parameter set with a different name.  When the day comes that you have 
to reinstall the first cylinder, reload the parameter set, including the tuning parameters 
that were optimized for that cylinder. 
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5.1.6 Alarm Annunciation  

If a zone is in alarm, the A1 or A2 indicator on the zone’s “front panel” on the main 
display will appear to be lit (red).  The process value on the Multi-Comm graphic 
display will also change color from magenta (normal) to red (alarm).     

As a bonus, the Multi-Comm supports “local alarms”.  These two process alarms can 
be configured in Multi-Comm for each zone on the networked 2C and 4C devices.  If 
a controller’s PV exceeds (high alarm) or falls below (low alarm) the configured local 
alarm limit, the alarm indicators on the main graphic display will “light” and the PV will 
change to red.  

5.2 Computer Hardware and Software Requirements 
The computer used to run the Multi-Comm software must meet the following 
requirements:   

 Pentium class processor 

 CD drive (if you plan to install from a CD) 

 256 MB RAM memory 

 at least 20 MB free disk space on hard drive 

 a port available for communication with one or more 2C and 4C boards; this 
port must be compartible with the communication option card installed on the 
controller board; see 3.4.4 for more information 

 Windows XP Pro SP 2 operating system; consult us for compatibility with older 
operating systems 
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5.3 Overview of Setup Tasks for Multi-Comm 
The following tasks must be performed in this sequence to use the Multi-Comm 
application successfully with an RS-485 network.  The same basic process applies to 
using the Multi-Comm application to communicate with a single controller over an 
RS-232 or USB link.  In the case of RS-232 or USB links, the “network” consists of 
only the controller and the PC.   

Step Task Subsection 
in this 
Guide 

1 Use the default starting MODBUS address stored on the EEPROM, 
which is address 1, or use an optional display board or a MODBUS host 
to change the address.  (The 4C board also has DIP switches that can 
be used for this purpose.) 

3.3.2 

2 Connect the controllers and personal computer to the network. 3.4.4 

3 Power up the controllers. ---- 

4 Install the Multi-Comm software and log in. 6.1 

5 Change the password on the default account “MULTI” (not required, but 
strongly recommended). 

6.4 

6 Set up operator accounts and assign passwords. 6.5 

7 Configure the Multi-Comm communication parameters and port 
selection.  (The Multi-Comm communication settings will override, but 
not change, the operating system settings for the selected port on your 
PC.) 

7.2 

8 Use the Multi-Comm software to recognize each controller on the 
network automatically. 

7.4 

9 Name the controllers (optional, but recommended).  By default, each 
controller’s name will be its zone address. 

7.6 

10 Save the .MCS (Multi-Comm system) file so that the process of 
recognizing the controllers does not have to be repeated if Multi-Comm 
is restarted. 

7.7 

14 Set up alarms (optional). 8 

At this point you are ready to configure new controllers, or to begin monitoring process 
variables with the Multi-Comm computer. 

To change setpoints, see Chapter 9. 

To change controller mode, including use of Autotune, see Chapter 10. 

To view and change controller configuration parameters, see Chapter 11.  

To configure and run ramp/soak recipes, see Chapter 12. 

To save and load controller configuration parameter sets, see Chapter 13. 

To log PV and SP values, see Chapter 14. 
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5.4 Overview of Multi-Comm Menus 

5.4.1 Availability of Functions 

The following tables provide an overview of the functions available on the Multi-
Comm menus.  Not all functions are available all the time.  If a function is not 
available, its name is displayed on the Multi-Comm window in gray instead of black.  
If a keyboard shortcut is available for a function, the shortcut appears on the menu to 
the right of the function name.  

File Menu  

Function Purpose Described 

New Start a new Multi-Comm Setup (.MCS) file12.  This function can 

also be invoked using the  button on the toolbar.13 

--- 

Open Open an existing Multi-Comm Setup (.MCS) file.  This function 

can also be invoked using the  button on the toolbar. 

--- 

Close Close the Multi-Comm Setup (.MCS) file open now. 7.8 

Save Save the Multi-Comm Setup (.MCS) file open now using the 
same file name.  This function can also be invoked using the 

 button on the toolbar.    

7.7 

Save As Save the Multi-Comm Setup (.MCS) file open now to a file with 
a different name.  

6.3 

Login Log into the Multi-Comm application. 6.8 

Logout Log out of the Multi-Comm application without closing the 
application. 

 

Recent File Once you have saved your Multi-Comm setup to an .MCS file, 
this placeholder will be replaced by the name of the most 
recently used .MCS file.  Up to four additional file names will 
appear on this menu. 

-- 

Exit Exit the Multi-Comm application.  If you have not saved the 
current setup to an .MCS file, you will be prompted to save 
before the application is closed. 

--- 

 

 

                                                      

12The contents of the .MCS file determine what controllers appear on the main display.  The ability to 
create, save, and open a variety of .MCS files enables you to create displays that do not include all the 
controllers on the network hosted by the PC.  For example, if Operator A is interested only in Controllers 
1, 2, and 9, you can create an .MCS file that would cause the Multi-Comm display to show only those 
controllers when Operator A uses that file.  Operator B could use a different .MCS file to see a different 
custom display, one containing only Controllers 3, 4, 6, and 9, for example. 

13 If the Multi-Comm toolbar is not visible, use the View menu’s Toolbar item to display the toolbar. 
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Edit Menu  

Function Purpose Described 

Password Enables operators to change their own passwords. --- 

Operators Allows “Super Users” (Multi-Comm Administrators) to set up 
operator login accounts and specify what Multi-Comm 
features each operator will be allowed to use. 

6.5 

 

View Menu  

Function Purpose Described 

Graphic Display images of zone “front panels” on main Multi-Comm 
display. 

-- 

Text Display a list of zones, their setpoints, and process variables 
on the main Multi-Comm display. 

-- 

Toolbar Turn on and turn off display of Multi-Comm toolbar. -- 

Status Bar Turn on and turn off display of Multi-Comm status bar at the 
bottom of the window.  The right side of this status bar shows 
what address number is being checked when the Option 
menu “Start Find Controllers” function is used.  During normal 
operation the left side of the status bar displays the name of 
the zone that the Multi-Comm software is polling.  

-- 

 

Controller Menu 
Before you can use a function marked with an asterisk (*) below, you must select a 
controller on the main graphic display (or text view) by using the left button to click 
on the controller’s image (or name in text view). 

Function Purpose Described 

Add * Establish communication with a single controller.  To use 
this function you must know the controller’s network 
address. 

7.4.3 

Delete * Sever communication with a single controller.   Once this 
function has been used and the .MCS file saved, the Multi-
Comm computer will not be able to communicate with the 
controller until you use the Add function on this menu, or the 
Start Find Controllers function on the Options menu. 

7.5 

Delete All Sever communication with all controllers. Once this function 
has been used and the .MCS file saved, the Multi-Comm 
computer will not be able to communicate with the 
controllers until you use the Add function on this menu, or 
the Start Find Controllers function on the Options menu. 

--- 

Select All Select all zones in the controller. -- 

Unselect All Unselect all zones in the controller. -- 

Configure * Access the window used to change the name or network 
address of a controller with which the Multi-Comm computer 
can communicate. 

7.6 
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Controller Menu 
Before you can use a function marked with an asterisk (*) below, you must select a 
controller on the main graphic display (or text view) by using the left button to click 
on the controller’s image (or name in text view). 

Function Purpose Described 

Alarms* Configure the alarms. 8 

Graph* Display a graph showing the controller’s SP and PV in real-
time. 

9.3 

Setpoint* Access the window used to change the controller’s setpoint. 9.4 

Parameters* Access the window used to view and change the controller’s 
configuration parameters.  A shortcut for accessing the 
parameter display is double-clicking (left button) on the 
controller on main graphic display. 

11 

Standby* Place the controller in Standby mode.  The PV for the 
controller in Standby will alternate with the display of “StbY”.  
This item will be checked on the menu when accessed after 
selecting a controller in Standby mode. 

10 

Manual 
Control* 

Place the controller in Manual mode.  The PV for the 
controller in Manual will alternate with the display of “FOP” 
(fixed output percent).  This item will be checked on the 
menu when accessed after selecting a controller in Manual 
mode. 

10 

Auto tune* Place the controller in Autotune mode.  The PV for the 
controller in Autotune will alternate with the display of “Atun”.  
This item will be checked on the menu when accessed after 
selecting a controller in Autotune mode.  Before putting a 
controller in Autotune mode, be sure to read Chapter 29.  
Autotune will not work correctly unless you prepare the 
process and the controller as described in that chapter.   

10 

Start Recipe* The functionality of this item depends on how the controller 
is configured (for multi-step ramp, single-step ramp, or 
ramping disabled). 

If a multi-step ramp and soak recipe based on parameter 
values stored in the controller has been configured and 
enabled use, Start Recipe to run that multi-step ramp and 
soak recipe. 

If the single-step ramp to setpoint function has been 
enabled, use Start Recipe to ramp the current process 
variable to the current setpoint over the time period specified 
using the appropriate parameter. 

If the single-step ramp to setpoint function has been 
disabled, use Start Recipe to ramp the current process 
variable to the current setpoint, which always occurs at 
startup.  However, if ramping is set to “disabled”, then a 
confirmation message is displayed before the PV is ramped 
using the default ramp time, one minute. 

12.5 
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Options Menu  
Before you can use a function marked with an asterisk (*) below, you must select a 
controller on the main graphic display (or text view) by using the left button to click on the 
controller’s image (or name in text view). 

Function Purpose Described 

Communications Access the window used to specify PC port and 
communication parameters to be used by the Multi-Comm 
software.  These parameters will override (but not 
change) the communication settings in your operating 
system for the selected port. 

7.2 

Logging 
[Stop Logging] 

Access the window used to specify the time interval at 
which PV and SP for all controllers should be written to a 
log file, name the file, and turn on logging.  When logging 
is active, this menu item becomes Stop Logging. 

14 

Start Find Controllers 
[Stop Find 
Controllers] 

Start the process used by the Multi-Comm software to poll 
each possible address on the network to see if there is a 
controller at that address.  When this process is active, 
this menu item becomes Stop Find Controllers.  The 
alternative to using this automatic process to enable the 
Multi-Comm computer to recognize controllers is to 
recognize controllers one at a time using the Controller 
menu Add function. 

7.4.2 

Get Software Version* Display the version of the firmware on the selected 
controller. 

--- 

 

Ramp/Soak Menu  

Function Purpose Described 

New Access the window used to begin the process of 
configuring a new ramp and soak recipe to be executed 
under the direction of Multi-Comm. 

12.2.1 

Edit Access the window used to select an existing recipe (on 
any accessible drive) for edit. 

12.2.2 

Run Access the window used to select an existing recipe to 
run on one or more controllers. 

12.3.1 

Hold Access the window used to hold (pause) execution of an 
active (running) recipe on one or more controllers.  While 
a controller is in hold, its setpoint will not be changed. 

12.3.2 

Resume Access the window used to resume (continue) execution 
of a “held” recipe in one or more controllers. 

12.3.3 

Stop Access the window used to stop (terminate) the execution 
of an active or “held” recipe in one or more controllers. 

12.3.4 
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Help Menu 

Function Purpose Described 

About Multi-Comm Access Multi-Comm version information.  If you phone for 
technical support, be ready to supply this number. 

-- 
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6. Installing the Multi-Comm Software 
 and Logging In 

6.1 Installing the Software 
The Multi-Comm software is available on CD or as a download from our Web site. 

To install the software: 

1. Open Windows Explorer. 

2. Create a directory for Multi-Comm.  Multi-Comm will run from this directory. 

3. Put the Multi-Comm CD in the drive. 

4. Copy the Multi-Comm files from the CD to the directory you created in step 2. 

6.2 Starting the Software 
To start Multi-Comm: 

1. In Windows Explorer open the directory to which you copied the Multi-Comm 
files. 

2. Double-click on the name of the file “Multicom.exe”.  The Multi-Comm application 
will open.  
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6.3 Logging In to Multi-Comm Using the Default Account 
When you start the Multi-Comm application, the Operator Login Window will be 
displayed.  

 

By default, newly installed Multi-Comm software will be set up to recognize one login 
account.  This is user “MULTI”.  The password is “COMM”.   

To log in: 

1. Start the Multi-Comm application. 

2. Select File > Login.  The Operator Login window will be displayed.  

3. Click on the User Id text entry box and type in MULTI.  Multi-Comm user names 
and passwords are case-sensitive.  This means that capitalization matters.  To 
the software “MULTI”, “multi”, and “Multi” are all different names.  

4. Tab to the Password entry box or click on it.  Type in COMM. 

 

5. Click on OK.  The Multi-Comm window will open.  Because the software was 
newly installed, the main display will be blank.  In the future, once communication 
has been established with controllers, and the controller identities saved as a 
Multi-Comm system file, logging in will result in the display of the controllers in 
the most recently used .MCS file.  
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6.4 Changing the Password for the Default Account 
The default account, MULTI, has permission to do everything, including create and 
delete other user accounts.  Therefore, it is a good idea to immediately change the 
password for the MULTI account from COMM to something unique to your 
installation.  Remember the new password.  If you forget it before you create another 
account with “Super User” permissions, you will not be able to add operator accounts 
without reinstalling the software.    

The MULTI account cannot be deleted, nor can its permissions be changed. 

To change the password: 

1. Select Edit > Password.  The window used to change the password will open.   

 

2. Type the old password COMM in the box provided. 

3. Type the new password in the box provided. 

4. Click on OK.  The new password will be saved. 
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6.5 Setting Up Operator Accounts 
At most sites, operators will not need permission to use all Multi-Comm functions, 
particularly the ability to create and delete other users’ accounts.  Therefore, it is a 
good idea for the Multi-Comm system administrator (the person who knows the 
password to the MULTI account) to create login accounts for operators.   

6.5.1 Permissions Available 

The Multi-Comm system supports several permission classes.  To see these classes, 
take a look at the definition of the MULTI account.     

To see the permissions available to a user account: 

1. Select Edit > Operators.  The Operator Setup window will open.  

 

2. MULTI is already selected because it is the only login account.  After you add 
operator user IDs, those will also appear on this list.  Click on Edit.  After the 
display of a message reminding you that only the MULTI password can be 
changed, the Operator window will be displayed.   

 

This window shows the definition of the Multi account.  All the Access Privileges 
boxes are checked, indicating that the user MULTI can do everything.  The 
permissions assigned to MULTI cannot be changed.   
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The access privilege categories grant the following permissions. 

Change Setpoint Change the setpoint using the Change Setpoint 
window, change the controller mode, and run 
ramp/soak recipes under the direction of Multi-Comm 
or under the direction of the controller. 

View/Change Parameters Use the Multi-Comm parameter window to view and 
change the parameters stored in the controllers’ non-
volatile memory. 

Controller Configuration Add and delete controllers from the Multi-Comm 
system. 

Super User Add and delete user accounts (operator login IDs). 

6.5.2 Procedure 

To add an operator login account: 

1. While logged in as MULTI, select Edit > Operators.  The Operator Setup window 
will open.  

 

2. Click on New.  The Operator window used to define a new login account will be 
displayed.  

 

3. Enter the new User ID (0 to 10 letters and/or numbers).   

4. Enter a password (optional, but recommended).   
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5. Click on the check box for each set of access privileges you want the user to 
have.  “Super User” does not automatically include all the other privileges. 

6. If you change your mind and want to clear a checked box, click on it again to 
“erase” the check. 

7. When you are satisfied with the user definition, click on OK .  The window will be 
closed and the user definition will be saved in a .DAT file in the directory where 
the Multi-Comm software was installed.   

6.6 Editing an Operator Account 
To edit an operator login account, use Edit > Operators to access the Operator 
Setup window, select the operator, and then change the password, and view and 
change privileges.  You must be logged in as MULTI or another user with Super User 
privileges.  

6.7 Deleting an Operator Account 
To delete an operator login account, use Edit > Operators to access the Operator 
Setup window, select the operator, and then click on Delete.  You must be logged in 
as MULTI or another user with Super User privileges.   

6.8 Logging Out of the Multi-Comm Application 
To log out but leave the Multi-Comm application open, use File > Logout.  

To log out and close the Multi-Comm application, use File > Exit. 
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7. Establishing Communication with 
Controllers 

7.1 Introduction  
Once you have connected the controllers and the computer to the network, installed 
the Multi-Comm software, and changed the password on the MULTI login account, 
you are ready to establish communication between the Multi-Comm computer and 
the controllers on the network. 

You must do the following tasks. 

 Use the default starting MODBUS address (which is 1), or assign a starting 
MODBUS address to each controller; see 3.3. 

 Use the Communications option on the Multi-Comm Options menu to 
specify the COM port to be used by the Multi-Com software.  If you choose 
not to use the automatic “find controllers” feature described in 7.4.2 to set 
up your network, then you must also specify the baud rate to be used by the 
Multi-Comm software.14  Configuration of communication parameters is 
described in 7.3. 

 Make the Multi-Comm system aware of all devices on the network as 
described in 7.4.  This can be done using the automatic “find controllers” 
operation, in which the Multi-Comm system seeks and finds the controllers 
using the default baud rate.  Alternatively, you can add controllers to the 
network one at a time.  If you use this manual method, then the software will 
poll at the baud rate specified in the Multi-Comm Communications Setup 
window. 

 Save the set up as an .MCS file as described in 7.7. 

                                                      

14 If you do use the “find controllers” function, the Multi-Comm software will automatically use 9600 baud. 
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7.2 Configuring Communication Parameters and Assigning 
Network Addresses in Controllers 

7.2.1 Communication Parameters 

The Multi-Comm software is designed to recognize 2C and 4C devices using the 2C 
and 4C default communication parameter settings: 8 data bits, no parity, 1 stop bit.       

 The network baud rate will be 9600 if you do use the automatic “find controllers” 
function.  

 The network baud rate will be determined by the rate you configure for the Multi-
Comm software if you do not use the automatic “find controller’s function”.  
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7.2.2 Network Addresses 

All standard 2C and 4C boards leave the factory set to use the MODBUS starting 
address stored on its EEPROM.  The default starting address is 1.   

A 2C controller board always uses the MODBUS starting address stored on its 
EEPROM.  You can use an optional display board and the      menu to assign a 
different starting address to the board; see 28.1.2.  DIP switches on a 4C board can 
also be used to assign a different MODBUS starting address for each controller; see 
3.3.3.  (A MODBUS host can also be used to change the starting address stored on 
the 2C or 4C EEPROM; see Using the MODBUS Protocol with 2C and 4C 
Controllers.) 

If you will have fewer than 254 controllers on the network and plan to use the Multi-
Comm function of automatically detecting devices on the network, use the lowest 
address numbers first.  The software will begin polling with address 1 and proceed up 
to 254 unless you stop the polling process.  You can save time getting your network 
up and running if you stop the process once you know the Multi-Comm system has 
found the controller with the highest address number you have assigned. 

Assign the addresses and go on to the next subsection. 
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7.3 Configuring Communication Parameters for Multi-Comm 
System 

Your goal is to select the COM port to be used by the Multi-Comm software.  For 
information about using the computer’s operating system tools to configure this port, 
see 3.4.4.4. 

 If you do not plan to use the automatic “find controllers” option, then you can also 
specify a baud rate other than 9600 (the default) for the network.   

 If you do use the automatic “find controllers” feature, then the software will use 
9600 baud, regardless of the baud rate specified using the Communications 
Setup window shown below. 

The other communication parameters must match the 2C/4C default controller 
settings: 8 data bits, no parity, 1 stop bit, which are also the Multi-Comm defaults.        

To configure the Multi-Comm communication settings: 

1. Launch the Multi-Comm application as described in 6.2 and log in as MULTI. 

2. Select Options > Communication.  The Communications Setup window will 
open.   

 

3. Use the Connector dropdown list to pick the port to be used to communicate with 
the controllers.  Select the port you set up as described in 3.4.4.4.   

4. If you do not plan to use the automatic “find controllers” option, use the Baud 
Rate dropdown list to set the baud rate at which you want the network to operate, 
usually 9600.   

5. If the Multi-Comm communication settings were changed from the defaults, use 
the Data Format dropdown list to set n,8,1.    

6. If necessary, change the Polling Frequency from the default value.  The Polling 
Frequency is the minimum number of milliseconds in the interval between the 
Multi-Comm system receiving a reply from one controller and the system trying to 
communicate with the next controller.    

7. If necessary, change the Timeout from the default value.  The Timeout is the 
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number of milliseconds the Multi-Comm system will wait to receive a reply from a 
controller before giving up and moving on to the next controller.   

8. When the settings are correct, click on OK to save the settings and close the 
window. 

7.4 Recognizing Controllers with the Multi-Comm Software 

7.4.1 Introduction 

After you have assigned a unique starting address to each controller and set the 
Multi-Comm computer to use the desired COM port, you are ready to enable the 
Multi-Comm software to recognize the controllers.      

7.4.2 Automatically Using the Find Controllers Option  

The Multi-Comm “find controllers” option polls each address, beginning at 1 and 
continuing until it has polled address 254, unless you stop the process using the 
Options menu.  During the “find controllers” process, the Multi-Comm software polls 
every address at 9600 baud  

To use the automatic function: 

1. Make sure all the controllers are powered up. 

2. While you are logged in as MULTI (or another user with Controller Configuration 
Privileges) select Options > Start Find Controllers.  The process will begin.  

3. You will be able to monitor the progress of the operation.  A message in the 
status bar (lower right corner of the main Multi-Comm window), will be displayed: 
“Checking for a controller at IDn”. 15 

4. As each controller is found, a virtual faceplate for each zone in the controller will 
appear in the main Multi-Comm window.  By default the name of the controller 
will be the same as its address number.  You can give each controller a different 
name later (see 4.6). 

5. When you see that the controller with the highest address number you assigned 
has been recognized (appears on the main display), you can stop the process 
using Options >Stop Find Controllers.   

6. After the find controller function has been completed or has been stopped as 
described in Step 6, the Multi-Comm software will begin normal operation at 
9600 baud, polling the controllers and displaying their PV and SP values.   

 

                                                      

15 If the Multi-Comm status bar is not visible, use the View menu’s Status Bar item to display the status 
bar. 
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If any controllers were not recognized: 

a) they were not powered up during the “find controllers” operation,  
 
or 

b) their communication settings were not set to the defaults or to 9600 baud, 8 data 
bits, no parity, 1 stop bit. 
 
or 

c) the network has not been wired correctly. 

Begin by checking (a), then (b).  If neither is the problem, check (c).  Once the 
problem has been fixed, add the unrecognized controllers manually as described in 
7.4.3.   

After adding the missing controllers, save the Multi-Comm Setup file as described in 
7.7.  

 

A “text only” view is available for operators who prefer to see the controller setpoints 
and process variables in list form.  To access the text only view, select View > 
Text. 
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To return to the graphic view, select View > Graphic.  When the instructions in this 
manual refer to the “main Multi-Comm window”, that means the graphic view. 
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7.4.3 Manually Using the Controller Menu 

When you use the automatic detection function, all controllers found are displayed.  
When you save the .MCS file, information about all the controllers will be saved. 

Depending on your application, you may want some operators to be able to see only 
a subset of the controllers on the network.  To do this, you must use the manual 
process described here to add the controllers you want Operator A to see, save the 
configuration to an .MCS file, then start again, adding controllers to create a new 
different .MCS file for the use of Operator B.       

This manual process can also be used to establish communications between the 
Multi-Comm computer and a controller that was added to the network after the 
automatic process was used. 

To add a controller manually: 

1. Make sure the controller is powered up. 

2. Make sure the Multi-Comm application is set to use the controller defaults for 
communication parameters: 8 data bits, no parity, 1 stop bit, 9600 baud. 

3. While you are logged in as MULTI (or another user with Controller Configuration 
Privileges) select Controller > Add.  The Add Controller window will be 
displayed.  

 

4. Type in the network ID assigned to the controller.  This must match the MODBUS 
starting address stored in the controller.  

5. Type in an optional name to be associated with this controller on Multi-Comm 
displays.  If no name is entered, the system will use the controller’s address as 
its name. 

6. Click on OK.  The Multi-Comm computer will poll for a controller at that address 
and the Add Controller window will close. 
 
If a controller is found at that address, it will appear in the main Multi-Comm 
window.  
 
If no controller is found at that address or a controller has already been 
recognized by the Multi-Comm software at that address, a message will be 
displayed. 

Repeat the process for other controllers as needed. 
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7.5 Deleting a Zone 
Any zone can be deleted from the Multi-Comm setup, regardless of whether the 
controller containing the zone was added using the automatic process or the manual 
method.    

To delete a zone: 

1. While you are logged in as MULTI (or another user with Controller Configuration 
Privileges) select the zone to be deleted by clicking on its faceplate image (left 
button) on the graphic display.  The border of the zone image will be highlighted. 

2. Select Controller > Delete.  The zone will be deleted without any confirmation 
message.  However, if you have already saved the setup to a .MCS file as 
described in 4.8, the controller will not be removed from the file until you save 
again. 
 
If you change your mind about deleting the zone, add it again using the manual 
method.  Alternatively, close the .MCS file without saving so that the file is not 
changed to reflect the deletion, and then reopen the file.  The zone will still be 
part of the setup, because you did not save the file after you deleted the zone. 

7.6 Naming Controllers  
By default, the Multi-Comm displays use a zone’s address as its name.  However, 
you can assign a more meaningful name to each zone.  This can be done during the 
manual addition process described in 4.4.3.  You can also assign a name (or change 
the assigned name) of any zone using the Controller > Configure menu function.  A 
name may contain up to twenty letters, numbers, spaces, and special characters.  

The Controller Configuration window can also be used to change the network ID of a 
zone.  If you do change the address in the controller’s memory using the Multi-Comm 
system, the system will not be able to communicate with the zone again until you use 
the procedure described in 4.4.3 to add the zone to the system using the device’s 
new ID.   

7.7 Saving the .MCS File 
It is very important that you save your Multi-Comm setup in a Multi-Comm Setup 
(.MCS) file.   The contents of the .MCS file determine what controllers appear on the 
main display.   

The ability to create, save, and open a variety of .MCS files enables you to create 
displays that do not include all the controllers on the network hosted by the PC.  For 
example, if Operator A is interested only in Controllers 1, 2, and 9, you can create an 
.MCS file that would cause the Multi-Comm display to show only those controllers 
when Operator A uses that file.  Operator B could use a different .MCS file to see a 
different custom display, one containing only Controllers 3, 4, 6, and 9, for example. 

If you do not save your setup to an .MCS file, then the next time you start the Multi-
Comm application you will have to repeat the recognition process.  (If you try to close 
the Multi-Comm software using File > Exit or double-clicking on the X at the top right 
of the main Multi-Comm window, you will be prompted to save.) 
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To save the setup to the .MCS file now open (named at the top of the main Multi-

Comm window), use File > Save (or the  button on the toolbar).  The configuration 
will be saved to the open file. 

To save the setup to an .MCS file with a new name, use File > Save As.  The 
operating system Save As window will open.  Use it to specify the destination 
directory and file name for the .MCS file.  The portion of the file name before the 
“.MCS” can have a maximum of eight characters. 

7.8 Closing an .MCS File 
To close an .MCS file, use File > Close.  Before the file is closed you will be 
prompted to save it if you have added any controllers or changed any controller 
names since the file was last saved.   

7.9 Creating a New .MCS File 

To create a new .MCS file, use File > New (or the  button on the toolbar).  The 
open .MCS file will be closed and the main display cleared.  You can now add 
controllers for a new Multi-Comm setup.   

7.10 Opening an Existing .MCS File 

To open a different .MCS file, use File > Open (or  button on the toolbar).  The 
operating system Open window will be displayed.  Use it to select the .MCS file to 
open.   
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8. Configuring Alarms 

8.1 Introduction   
The Multi-Comm system can read the alarm state of any 2C/4C device.  Therefore, if 
a 2C/4C device’s alarm parameters have been configured and the controller has 
detected an alarm condition, the A1 or A2 indicator on the zone’s “front panel” on the 
Multi-Comm main display will appear to be lit (red).  The process value on the Multi-
Comm graphic display will also change color from magenta (normal) to red (alarm).  
Controller alarm parameter values can be changed using the Multi-Comm software 
using the procedure described in Chapter 7.   

As a bonus, the Multi-Comm supports “local alarms”.  These two process alarms can 
be configured in Multi-Comm for each zone on the network.  If a zone’s PV exceeds 
(high alarm) or falls below (low alarm) the configured local alarm limit, the alarm 
indicators on the main display will “light” and the PV will change to red.  Local alarms 
are configured using the procedure described below. 

8.2 Procedure 
To configure local process alarms: 

1. While logged in as MULTI (or another user with Controller Configuration 
privileges), select the zone. 

2. With the zone selected, select Controller > Alarms.  The Local Alarms window 
will open.  

 

3. To enable local process alarm 1 (signaled using the controller image’s A1 
indicator on the main display), click on the box to the left of Process High.  
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4. To enable local process alarm 2 (signaled using the A2 indicator on the Multi-
Comm display), click on the box to the left of Process Low. 

5. Type in the alarm limit for each alarm. 

6. Click on OK to save the changes and close the window. 
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9. Viewing Process Values and 
 Changing Setpoint 

9.1 Introduction 
For your convenience, the Multi-Comm system provides several ways to view 
process variable and setpoint as described in this chapter. 

Any operator whose login account is configured with the appropriate privilege can 
use the Multi-Comm system to change a controller’s setpoint as described in this 
chapter.  (Instructions for changing the setpoint using ramp and soak recipes are in 
12.3.) 

A 4C device can use the single step Ramp to Setpoint function at times other than at 
startup.  The Multi-Comm system provides a method to start the timer on the ramp to 
setpoint as described in this chapter.  
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9.2 Viewing PV and SP in the Main Window 
In the main window the Multi-Comm system always displays process value and 
setpoint for every zone in every controller in the .MCS file.  The refresh rate is 
dependent on baud rate, the number of controllers on the network, and the 
configured polling frequency and timeout (see 7.3).     
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9.3 Viewing PV and SP in a Graph 
The Multi-Comm system allows operators to display a trend graph showing any 
zone’s SP and PV in real time.      

To view the real-time trend graph: 

1. While logged in as MULTI (or another user with Controller Configuration 
privileges), select the zone by clicking on its faceplate image in the main graphic 
display.  The border of the zone image will be highlighted. 

2. Select Controller > Graph.  The trend graph will be displayed.   

Initially the graph will not show any trend tracings.  However, as soon as the selected 
zone is polled by the Multi-Comm system, trend tracings will begin to be drawn.  As 
long as the Graph Window remains open, the trend tracings will be updated.  

 

To close the Graph Window, double-click on the X in the top right corner. 
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9.4 Changing the Setpoint Using the Setpoint Dialog Box 
Any operator whose login account is configured with the appropriate privilege can 
use the Multi-Comm system to change a zone’s setpoint.   

To change a controller’s setpoint: 

1. Access the window used to change the setpoint by: 

 right-clicking on the zone’s faceplate image in the main display, 
 
or 

 left-clicking on the zone’s faceplate image to select it, then selecting 
Controller > Setpoint. 

Either of these actions will open the Setpoint window.   

 

2. Enter the new setpoint. 

3. If you want the setpoint to be written to the controller’s non-volatile memory when 
you click on Send, click on the box in front of “Permanent”.  The box will be 
checked.  (Clicking on the box again clears it.)  If the controller’s power is cycled 
after you click on Send, the new SP will be used again when power is restored, 
because the new SP will have been stored in the controller’s non-volatile 
memory. 
 
or 
 
If you want the setpoint to be written to temporary (volatile RAM) memory when 
you click on Send, do not click on the “Permanent” box.  If the controller’s power 
is cycled, the new SP will be lost. 

4. Click on Send.  The new setpoint will be sent to the controller the next time the 
Multi-Comm computer communicates with the controller.16   

                                                      

16 As with any RS-485 host, the Multi-Comm computer communicates with one device at a time.  To see 
which controller the Multi-Comm application is currently communicating with, check the message at the 
left of the status bar (at the bottom of the Multi-Comm main window).  If the status bar is not visible, use 
the View menu’s Status Bar item to display the status bar. 
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9.5 Configuring and Invoking the Single-Step Ramp Function 
The Multi-Comm system provides a method to configure the single-step ramp time.  
The software also provides a means to invoke this single-step Ramp to Setpoint 
function (in those controllers that can use the function) at times other than at startup.   

To configure the timer for the single step Ramp to Setpoint function: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select the controller by clicking on it in the main graphic display.    

2. To see the present values of all parameters stored in the controller’s non-volatile 
memory, select Controller > Parameters.  The parameter window for that 
controller will open.  By default, the Input tab will be on top. 

3. Click on the Recipe tab.  The existing recipe-related parameter values will be 
displayed.   

 

4. To enable Single-Step Ramp, select this Recipe Option.  The Ramp Time entry 
box will become enabled. 

5. Enter the ramp time (in minutes) to be used to achieve the current setpoint when 
either of two conditions occurs:  power to the controller is cycled or the Multi-
Comm system is used to gradually ramp to the current setpoint. 

6. Click on OK.  The value will be sent to the controller and the window will close. 
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To invoke the single step ramp function: 

1. Select the zone by clicking on its faceplate image in the main graphic display.  
The border of the zone image will be highlighted.    

2. Select Controller > Start Recipe.17  The function will be invoked.  (If the Recipe 
Option is set to “Disabled”, a confirmation message will be displayed before the 
PV is ramped to the setpoint; the default one minute will be used.)   

 

                                                      

17 If the Recipe Option is set to “Multi-Step Ramp”, then the Controller menu Start Recipe function will 
begin execution of the ramp and soak recipe stored in the controller’s recipe parameters as described in 
Chapter 12.4.  
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10. Changing Controller Mode 
and Using Autotune 

10.1 Introduction 
The Multi-Comm system provides operators with an easy, reliable way of changing a 
zone’s mode without using the optional display board.  This ability to change mode 
includes placing the zone in Autotune.  Before putting a controller in Autotune, be 
sure to read Chapter 28.  Autotune will not work correctly unless you prepare the 
process and the controller as described in that chapter.        

10.2 Procedure 
To change a controller’s mode: 

1. While logged in as MULTI (or another operator with View/Change Parameters 
privileges), select the zone by clicking on its faceplate image in the main graphic 
display.  The border of the zone image will be highlighted. 

2. Select Controller > Standby (or Manual or Tune).  (If you attempt to put the 
zone into Autotune mode, a confirmation message will be displayed.  Before 
using Autotune, you should read Chapter 28 and comply with the Autotune 
guidelines provided in that chapter.  After you acknowledge the confirmation 
message, the Autotune command will be sent to the controller.) 

3. The image of the zone’s virtual faceplate on the main display will match the 
controller’s optional display in the new mode.  For example, in Standby mode the 
PV value will alternate with the message “    ” . 

4. To take the zone out of the current mode, select the zone again.   

5. Open the Controller menu.  You will see the zone’s current special mode 
checked.  For example, if the zone is in Standby, then the menu will show  
Standby.  Click on the checked mode to take the zone out of that mode. 
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11. Viewing and Changing Controller 
Configuration Parameters 

11.1 Introduction 
The Multi-Comm system permits any operator with View/Change Parameter 
privileges to access parameter values stored in each controller’s non-volatile 
memory.     

11.2 Accessing Configuration Parameter Displays 
To access the parameter displays: 

1. Log in as MULTI (or another user with View/Change Parameter privileges).   

2. Use one of the following two methods to access the displays: 

 select the zone by clicking on its faceplate image in the main graphic display, 
then using Controller > Parameters, 
 
or 

 double-click on any zone image in the main graphic display. 

Either method will open the window showing the current value of the zone’s 
accessible parameters. 

The window will contain a set of tabbed “layers”.  Click on a tab to select the 
group of parameters to be viewed. 
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11.3 Using Configuration Parameter Displays 
Be aware that not all displayed parameters apply to the selected zone, or to the 
current configuration.  In some cases the value of an unused parameter is gray, and 
no input is accepted.  For example, on the input tab shown earlier in this chapter, the 
Low Scale and High Scale parameters do not apply when a thermocouple input is 
used.  Therefore, the Low Scale and High Scale values are gray.  They do not apply 
to the current configuration and cannot be changed. 

Sometimes it is possible to type a value in the Multi-Comm window, but the value will 
not be accepted by the controller.  The value will not be accepted if the controller 
hardware does not support use of the parameter.  You will be informed by a Multi-
Comm message that the controller will not accept the input. 

The displayed values are currently stored in the controller.  If you change a value in a 
parameter window, the change does not take effect until the next scan cycle after you 
click on the Apply button.   
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12. Configuring and Running 
Ramp and Soak Recipes 

12.1 Introduction  
Use the Multi-Comm Ramp and Soak function to configure any number of recipes 
consisting of any number of ramp and soak steps.  These recipes are stored on the 
Multi-Comm computer.  Under the direction of Multi-Comm, any controller on the 
network can execute your choice of recipe, regardless of the values stored in the 
controller’s recipe parameters.  Instructions for configuring these recipes are in 12.2.  
Instructions for running these recipes are in 12.3. 

The Multi-Comm displays also provide a quick way to configure and run recipes that 
use the controller’s own recipe parameters.  Instructions for configuring these recipes 
are in 12.4.  Instructions for running these recipes are in 12.5. 
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12.2 Configuring Multi-Comm Recipes 

12.2.1 Creating a New Recipe 

To create a new recipe to be run on any zone under the direction of the Multi-
Comm system:  

1. While logged on as MULTI (or another user with View/Change Parameter 
privileges), select Ramp/Soak > New. The Recipe Editor window will be 
displayed.     

 

You will use the Ramp Time, Soak Level, and Soak Time boxes to configure 
each step, then use the Append Step button to add the step to the end of the 
recipe in the large white box.  (Steps can also be inserted, edited, and deleted as 
described below.)   

2. Enter a recipe name.  This name will be used on the list of recipes on the list of 
active recipes and the list of “held” recipes.  (This will not be the name of the 
recipe file unless you use the same name when you do Save As.) 

3. Select a Units option. 

4. Use the Termination State dropdown list to specify what you want to happen 
when execution of the recipe has been completed.  (If you stop execution of a 
recipe before completion, the setpoint will remain at the value it has when you 
stop execution.)  

5. Use the Repeats box to enter the number of times you want the recipe to execute 
each time it is run.  If you want the recipe to run once, leave the Repeats value at 
the default, zero.  If you want the recipe to cycle continuously once started, check 
the “Continuous” box.  
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6. Enter a Holdback value of at least 1, or disable holdback.18  

7. Enter the Ramp Time, Soak Level (setpoint), and Soak Time for a recipe step in 
the boxes provided.19 

8. Click on Append Step.  The step will be added below the steps already in the 
recipe box.  The Ramp Time, Soak Level, and Soak Time boxes will be cleared 
in preparation for entering your next step. 

9. Repeat Steps 7 and 8 as many times as necessary. 

 

10. Save the .RCP file  for the first time using Save As.  A window will open in which 
you can specify the filename and directory.  You must replace “Untitled“ in the 
window with a meaningful file name ending with the .RCP extension.  This will be 
the name you select when you run the recipe. 

11. To delete a step from the recipe as shown in the white box, click on the step to 
select it.  The values of the selected step will be displayed in the Ramp Time, 
Soak Level, and Soak Time boxes.  Click on Delete Step.  The step will be 
removed from the recipe.    

12. To edit a step, select it.  Its values will be displayed in the Ramp Time, Soak 
Level, and Soak Time boxes.  Make your changes, then click on Edit Step.  The 
new values will replace those in the selected step. 

                                                      

18 If you are concerned that your process might not be responsive enough to reach the soak levels in the 
specified ramp times, use the holdback feature.  If holdback is enabled, then the system will not allow the 
setpoint to become more than n engineering units away from the process value, where n is the Holdback 
value.  The system will “hold back” the SP until the PV has had a chance to catch up.  This has the effect 
of “stopping the clock” on the SP ramp time until the PV is within n units of the SP. 

The specified holdback value n will also be applied to the soak level.  If the temperature falls more than n 
units from the soak level, then the clock is stopped on the soak time until the PV is again within n units of 
the SP specified for the soak level.  

19 Because of the effect of the holdback value, these ramp and soak times should be considered 
minimums if holdback is enabled. 
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13. To insert a step, select the step it should precede.  The values of the selected 
step will be displayed in the Ramp Time, Soak Level, and Soak Time boxes.  
Enter the values for the step to be inserted, then click on Insert Step.  The new 
step will be inserted before the step selected.  

14. To save the recipe without closing the Recipe Editor window, click on Save.  The 
file will be saved to the file specified in Step 10, overwriting the old contents of 
the file. 

15. When the recipe displayed in the white box meets with your approval, click on 
Save and Close.  The recipe will be saved to the .RCP file and the editor will 
close. 

While you are learning to use the Recipe Editor, it is a good idea to use the 
Ramp/Soak > Edit function described below to take a second look at your recipe 
before running it. 

12.2.2 Editing an Existing Recipe 

The same Recipe Editor functions are used to edit an existing recipe.  Use 
Ramp/Soak > Edit to open the window used to select the .RCP file to be edited.  
Once you have selected a file, the Recipe Editor will open.  The steps in the existing 
file will be displayed in the white box.  The previous selections for engineering units, 
holdback, etc. will be filled in.  Add, delete, edit, and insert steps as needed, then use 
Save to overwrite the old recipe file you selected, or Save As to create a new file. 
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12.3 Running Multi-Comm Recipes 

12.3.1 Starting to Run a Recipe 

To run a Multi-Comm Ramp/Soak recipe: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select Ramp/Soak > Run.  The Open Recipe window will open.      

 

2. Select the .RCP file to be run and click on OK.  The Run Recipe Controller 
Selection window will open.  

 

3. This window lists the name and network address of every zone not currently 
executing a recipe under the direction of the Multi-Comm system.  Select one or 
more zones.  (You can hold down the Shift key to select multiple zones that are 
together on the list, or hold down the Control key to select multiple zones that are 
scattered on the list.) 

4. Click on OK.  The Run Recipe Controller Selection window will close, and the 
Multi-Comm system will begin running the recipe on the selected zone(s).  As the 
recipe runs the displayed setpoint and process value will change in response to 
SP changes sent by the Multi-Comm computer to the controller. 
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12.3.2 Holding (Pausing) Recipe Execution 

To hold execution of a Multi-Comm recipe: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select Ramp/Soak > Hold.  The Recipe Control window will open.    

 

2. The window lists all the recipes being run under the direction of Multi-Comm.   
A recipe may appear on the list in the left pane more than once.  This means that 
you started to run the recipe on different zones (or sets of zones) at different 
times.  Each of these occurrences of a recipe on the list is referred to as an 
“instance” of the recipe.   
 
To see on which zone(s) you are currently executing an instance of a recipe, 
click on the name of the recipe.  The zones running the selected instance of the 
recipe that are not already on hold will be listed in the right pane.20   

3. Select the instance of the recipe to be held.    

4. Select the zones to be held.  (You can hold down the Shift key to select multiple 
zones that are together on the list, or hold down the Control key to select multiple 
zones that are scattered on the list.) 

5. Click on Hold.  Execution of the selected instance of the Multi-Comm recipe will 
be paused for the selected zones, and the window will close.  On the Multi-
Comm main display, the SP of the “held” zones will remain unchanged while the 
recipe is held.  

Execution of the selected instance of the recipe will be held for the selected zones 
until you resume execution as described in 12.3.3, or stop (terminate) execution as 
described in 12.3.4. 

                                                      

20 If all controllers on which you are running the selected recipe instance are already held, then no 
controllers will be listed in the right pane. 
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12.3.3 Resuming Recipe Execution 

To resume execution of a “held” recipe: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select Ramp/Soak > Resume.  The Recipe Control window will open.  

 

2. The window lists all the recipes being run under the direction of Multi-Comm.   
A recipe may appear on the list in the left pane more than once.  This means that 
you started to run the recipe on different zones (or sets of zones) at different 
times.  Each of these occurrences of a recipe on the list is referred to as an 
“instance” of the recipe.   
 
To see on which controllers you have held an instance of a recipe, click on the 
name of the recipe.  The zones on hold for the selected instance of the recipe will 
be listed in the right pane.21  Execution of the selected recipe instance may have 
been held on the zones in this group at different times.   

3. Select the instance of the recipe to be resumed.   

4. Select one or more zones to be resumed.  (You can hold down the Shift key to 
select multiple zones that are together on the list, or hold down the Control key to 
select multiple zones that are scattered on the list.) 

5. Click on Resume.  Execution of the selected instance of the recipe will resume 
on the selected zones at the point in the recipe where it was held for each zone.  
Execution of the recipe can resume at different steps in the recipe in different 
zones.  (Although you started to run the recipe instance in all the zones at the 
same time, you may have held execution at different times.)  On an optional 
display board, the PV of the selected zones will again alternate with the display 
of “   ”, indicating that a Multi-Comm recipe is active using those controllers. 

                                                      

21 If the Multi-Comm system is not holding execution of the recipe instance for any zones, then no zones 
will be listed in the right pane. 
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12.3.4 Stopping Recipe Execution 

To stop execution of a Multi-Comm recipe: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select Ramp/Soak > Stop.  The Recipe Control window will open.    

 

2. The window lists all the recipes being run under the direction of Multi-Comm 
(both active and held).  A recipe may appear on the list in the left pane more than 
once.  This means that you started to run the recipe on different zones (or sets of 
zones) at different times.  Each of these occurrences of a recipe on the list is 
referred to as an “instance” of the recipe.   
 
To see on which zone(s) you are currently running an instance of a recipe, click 
on the name of the recipe. 

3. Select the instance of the recipe to be stopped.  

4. Select one or more zones.  (You can hold down the Shift key to select multiple 
zones that are together on the list, or hold down the Control key to select multiple 
zones that are scattered on the list.) 

5. Click on Stop.  Running of the selected instance of the Multi-Comm recipe using 
the selected zones will end.  The setpoint for each selected controller will remain 
where the setpoint was when the recipe was stopped, not at the value 
determined by the Termination State configured for the recipe.   
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12.4 Configuring Controller Ramp and Soak Parameters 
To configure a recipe using the controller’s recipe parameters: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select the zone by clicking on its faceplate image in the main graphic 
display.   

2. To display the present values of all parameters stored in the controller’s non-
volatile memory for the highlighted zone, select Controller > Parameters.  The 
parameter window for that zone will open.  By default, the Input tab will be on top. 

 

3. Click on the Recipe tab.  The existing recipe-related parameter values will be 
displayed.22   

                                                      

22 If you have selected a 2C, these values will all be zeroes because the 2C does not contain a 
ramp/soak menu. Although you cannot run controller-based recipes on a 2C board, you can configure 
Multi-Comm recipes as described in 12.2.and then run these recipes (stored on the Multi-Comm host) on 
a 2C.  Recipes described in Chapter 12 are stored in the Multi-Comm host and do not use ramp/soak 
parameter values stored in the controller database. 
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4. To enable Multi-Step Ramp, select the Recipe Option.  The Multi-Step Ramp 
panel, Holdback Band, Termination State, and Repeats entry boxes will become 
enabled.  The Power Fail Resume and Continuous Repeat options will also 
become enabled.  The values in the Multi-Step Ramp panel represent the values 
stored in the controller’s recipe parameters.  (The units of measure match those 
selected for the display units parameter.) 

5. Use the Termination State dropdown list to specify what you want to happen to 
the zone when execution of the recipe has been completed.  

6. Use the Repeats box to enter the number of times you want the recipe to execute 
each time it is run.  If you want the recipe to run once, leave the Repeats value at 
the default, zero.  If you want the recipe to cycle continuously after it has been 
started, click on the box to the left of “Continuous”.  The box will be checked, 
indicating that the option has been selected.   

7. Enter a Holdback value of at least 1, or disable holdback.23  

                                                      

23 If you are concerned that your process might not be responsive enough to reach the soak levels in the 
specified ramp times, use the holdback feature.  If holdback is enabled, then the system will not allow the 
setpoint to become more than n engineering units away from the process value, where n is the Holdback 
value.  The system will “hold back” the SP until the PV has had a chance to catch up.  This has the effect 
of “stopping the clock” on the SP ramp time until the PV is within n units of the SP.  

The specified holdback value n will also be applied to the soak level.  If the temperature falls more than n 
units from the soak level, then the clock is stopped on the soak time until the PV is again within n units of 
the SP specified for the soak level.  
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8. To edit a step, click on it to select it, and then click on Edit Step.    

9. Enter the Ramp Time, Soak Level (setpoint), and Soak Time for a recipe step in 
the boxes provided.24 

10. Repeat Steps 8 and 9 until the recipe meets the needs of your application. 

11. If you want to save this recipe to an .RS  file on a drive accessible to the Multi-
Comm computer, use the Save As button.  A window will open in which you can 
specify the filename and directory.  You must replace “Untitled“ in the window 
with a meaningful file name ending with the .RS extension.  (If you make further 
changes and want to save to the same file, use the Save button.)  When you 
click on OK, the ramp time, soak level, and soak time values will be saved in the 
file.  They will not be sent to the controller. 

12. When you are ready to write the recipe values to the controller, click on Apply, or 
OK.  The values will be written to the controller during the next scan cycle.  If you 
use Apply, the parameters window will stay open.  If you use OK, the window 
will close.  

To open a previously saved controller recipe .RS file (not a Multi-Comm .RCP recipe 
file), use the Open button on the Recipe parameter tab and select the file.  The ramp 
time, soak level, and soak time values in the file will be displayed on the Recipe tab.  
The values will not be sent to the controller until you click on Apply or OK.  

 

                                                      

24 Because of the effect of the holdback value, these ramp and soak times should be considered 
minimums if holdback is enabled. 
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12.5 Running Controller Ramp and Soak Cycles 
To run a multi-step ramp and soak recipe based on the values stored in the 
controller: 

1. Select the zone by clicking on its faceplate image in the main graphic display.  
The border of the zone image will be highlighted.  

2. Select Controller > Start Recipe.  The function will be invoked.  Note that if the 
Recipe Option is set to “Single-Step Ramp” or “Disabled”, then the multi-step 
ramp function is not available.  In these cases, using Controller > Start Recipe 
will invoke the single-step ramp function.  (If the Recipe Option is set to 
“Disabled”, the Multi-Comm software will display a confirmation message before 
executing a single-step ramp based on the one minute default ramp time.) 

When a zone is executing a ramp/soak step based on values stored in the 
controller’s parameters, the PV will alternate with “  ” on an optional display board. 
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13. Storing and Loading Controller 
Configurations 

13.1 Introduction  
All the configuration parameter values stored in non-volatile memory in a controller 
can be saved to the PC and loaded to the same or different controllers.  Backing up a 
unique controller configuration on a PC or removable medium is always prudent.  If a 
controller is damaged later and must be replaced, the custom configuration can be 
loaded quickly to a spare controller, minimizing down time. 

If the controller is configured to support more than one zone, you can save and load 
configuration for one zone or all zones in the controller simultaneously.  

In large installations where many zones use the same (or almost the same) 
configuration, its easy to configure one zone using the Multi-Comm display, save the 
parameter set to the PC, then load the same parameter set to many other zones in 
2C and 4C devices on the network.  (If you load the same configuration into more 
than one controller, remember to give each controller a unique starting MODBUS 
address; see 3.3.3.) 

The ability to store and load a controller configuration also enables you to reuse 
tuning parameter values that have proved to be best for certain process conditions.  If 
the responsiveness of your process is altered at times, you may find it desirable to 
save sets of tuning parameters to be used under different circumstances. 

For example, if you autotune the controller for optimum control of the temperature of 
an engraving cylinder while one size is in use, save the parameter set before 
installing a larger or smaller cylinder.  The different size cylinder may heat at a 
different rate, requiring different tuning parameters to be used for optimum control.  
Save the new tuning as a parameter set with a different name.  When the day comes 
that you have to reinstall the first cylinder, reload the parameter set, including the 
tuning parameters that were optimized for that cylinder. 
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13.2 Storing Configuration 
To save a controller’s configuration on the Multi-Comm computer: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select the zone by clicking on it in the main graphic display.   

2. To display the present values of all parameters stored in the controller’s non-
volatile memory for the selected zone, select Controller > Parameters.  The 
parameter window for that zone will open.  By default, the Input tab will be on top.  

 

3. Click on the Parameter Set tab.  It contains the buttons used to save and load 
parameter sets.   
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4. To save the parameter set for the currently selected zone in a .PRF file, click on 
Save As.  The Save Parameter Set window will open.  Use it to enter a filename 
(with a .PRF file extension) and to specify a destination directory.   (To save the 
parameter set to a file with the same name as the controller, click on Save.  The 
file will be saved in the same directory where the Multi-Comm software was 
installed.)   
 
– or – 
 
To save the parameter set for all zones in the currently selected controller to an 
.EMC file, click Save All As (to specify the name of the .EMC file) or Save All (to 
save to the currently open file).  

5. As the save progresses, a status window will be displayed.  When the status 
window closes, the save operation is complete.  You can click on OK to close the 
parameter window. 

 



2C and 4C Controller Installation, Configuration, and Operation Guide 

13-4  Athena Controls, Inc. 900M231U00A 

13.3 Loading Configuration 
To load a configuration from the Multi-Comm computer to a controller: 

1. While logged in as MULTI (or another user with View/Change Parameter 
privileges), select the zone by clicking on its faceplate image in the main graphic 
display.   

2. To display the present values of all parameters stored in the controller’s non-
volatile memory for the selected zone, select Controller > Parameters.  The 
parameter window for that zone will open.  By default, the Input tab will be on top. 

 

3. Click on the Parameter Set tab.  It contains the buttons used to save and load 
parameter sets.   
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4. To load a parameter set to the selected zone, click on Load.   
 
– or – 
 
To load a parameter set to all the zones in the selected controller, click on Load 
All. 
 
Either way, the Open Parameter Set window will open.  

5. Select the name of the .PRF file to be loaded to the zone (or the .EMC file to be 
loaded to the controller) and click on OK.  The parameter values stored in the file 
will be written to the controller.  

6. As the load progresses, status windows will be displayed.  When no more status 
windows are displayed, the load has completed successfully.  If the Multi-Comm 
system could not write all the parameter values in the .PRF or .EMC file to the 
controller, messages containing the parameter numbers will be displayed.  
Usually a parameter value cannot be written to the controller because the 
hardware does not support the feature that uses the parameter.  If the 
parameters apply to your application, configure the parameters individually. 
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14. Logging PV and SP Values 

14.1 Introduction 
The Multi-Comm application supports optional logging of SP and PV values for all 
controllers at configurable intervals.  Logs are saved in ASCII text files with comma-
separated-value format.  These files can be viewed, printed, and manipulated with 
other applications, such as word processing and spreadsheet software.  

14.2 Turning On the Logging Function 
To turn on the logging function: 

1. While logged in as MULTI (or another user with Controller Configuration 
privileges), Select Options > Logging.  The Logging window will be displayed.   

 

2. Enter the name of the log file to be used.  Keep the .log file extension.  (Unless 
you use the Browse button to specify a different location, the log file will be in the 
same directory in which the Multi-Comm software was installed.) 

3. Enter the frequency (in seconds) with which the SP and PV values should be 
logged.  Remember that log files will grow rapidly at frequent logging rates.  Be 
sure there is enough room on the drive containing the log files. 

4. Click on Enable.  If this file name has not been used before for a log, the logging 
will begin and the Logging window will close. 
 
If a log file already exists with that name in the Multi-Comm directory, a 
confirmation message will be displayed.  
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5. To append new data to the old file, click on Yes.  To overwrite the old file, 
click on No.  This will result in the old data being lost. 

14.3 Viewing and Printing Log Files 
The log files are ASCII text file with comma-separated values.  To view and print the 
files, use any text editor (such as WordPad) that will retain the line breaks. 

14.4 Turning Off the Logging Function 
To turn off the logging function: 

1. While logged in as MULTI (or another user with Controller Configuration 
privileges), open the Options menu.  When logging is enabled, the Options menu 
will include the item Stop Logging. 

2. Select Options > Stop Logging.  Logging will be disabled. 
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Section C – Display Board User Interface 
 

This section contains information about: 

 the display and LEDs – see page 15-1 

 keypad use – see page 16-1 
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15. Display Board Overview 

15.1 Introduction 
An optional display board with switches (pushbuttons) can be connected to the 2C or 
4C board with a ribbon cable.  (Several display boards are available. See 2.4 for 
display board part numbers.)  The display board can be used to:      

 select a zone 

 view the process value and setpoint for the selected zone 

 change the setpoint 

 view and change configuration parameter values 

Instructions for using the keypad are in Chapter 16. 

You can also use a personal computer to do all these tasks.  See 1.3.3 for more 
information. 

Each display board has a bright two-line LED display that is easy to read over wide 
viewing angles.  During normal operations the process value of the selected zone is 
always on display.  The setpoint can also be displayed at all times.  If you prefer, the 
setpoint can be “blanked”, that is, it can be turned off after a configurable time period.  
Pressing any key displays the setpoint again.   

The display board is also equipped with zone indication and output indication LEDs. 
For information about LEDs, see 15.5. 

15.2 Keypad 
The keypad consists of five keys: four for zone configuration and operation and one 
for zone selection. 25 

For convenience, this manual refers to the four zone configuration/operation keys 
using the symbols and names shown in the list below.  These are the symbols used 
on the optional overlays for the display boards.  (With the exception of zone 
selection, these are also the symbols used on the faceplates of panel-mounted 
Series C controllers.)  

The hardware switch (button) used for each of these functions varies, depending on 
the display board type you purchased.  See 16.1 for the switches (pushbuttons) used 
for the functions described below. 

                                                      

25 If your controller board contains software earlier than version 1.27, then the menu access key is used 
to select the zone.  Pressing the menu access key for about one second steps to the next zone.  The 
software version loaded on a controller is displayed when the board is powered up; see 1.10. 
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 menu access – Used to access the menu system; within the menu system 
it is used to move from menu to menu. 

 up and  down – Used to change numeric values and to scroll through 
lists of configuration choices. 

 mode/enter – Used to access the displays used to change the mode or 
security access level, as well as to write values to the controller’s database and 
step through items within a configuration menu 

For more information about using these keys, see Chapter 16. 

15.3 Control Mode Displays  
What is displayed when the controller is in one of the control modes described in 1.6 
depends on the mode and whether the controller detects any problems with the input 
or with its own operation.  The table below summarizes the various combinations of 
numeric values and abbreviations displayed when the controller is operating. 

What’s Displayed Example 

Top Line Top Line 

 
 
 

Circumstance Lower Line Lower Line 

process value    . normal mode, no problems 
detected 

setpoint (see Note 1 below)    . 

process value alternating with           standby mode 

setpoint (see Note 1 below)    .  

process value    . manual mode 

output 1 fixed output percent value 

alternating with      o r   

output 2 fixed output percent value 

alternating with      

(Use the  key to toggle between 

     and     . )  

    

process value alternating with           Autotune mode 

setpoint value (see Note 1 below)    .  

process value alternating with    
followed by the ramp or soak segment 
number 

  .  recipe running under the 
direction of the controller, 
using ramp/soak parameter 
values (See Note 2 below)  

setpoint (ramps as the recipe is executed) 
(see Note 1 below) 

   . 

process value alternating with          ramp/soak recipe on hold 

setpoint value (held at value it had when 
recipe was put on hold) (see Note 1 below) 

   . 
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What’s Displayed Example 

Top Line Top Line 

 
 
 

Circumstance Lower Line Lower Line 

     displayed     
controller detects an open 
sensor, or the input is out of 
the supported sensor range setpoint value (see Note 1 below)    . 

     displayed     controller detects a reversed 
sensor, or the input is out of 
the supported sensor range  setpoint value (see Note 1 below)    . 

    displayed    controller detects a problem 
with its own operation 

numeric code displayed; see 32.3.2 for the 
codes 

    

Note 1:  The controller can be configured to limit the length of time the setpoint is 
displayed.  If the setpoint display blanking parameter is set to a value other than 
OFF, the setpoint will be displayed for only the configured number of seconds.  At the 
end of that time period, the setpoint display will become blank and remain blank until 
the operator presses any key.  The setpoint will again be displayed for the configured 
number of seconds (see 20.2.4 or 20.3.3). 

Note 2:  If a MODBUS master or Multi-Comm host is running a recipe based on 
values stored in the host (as opposed to a recipe based on ramp/soak parameter 
values stored in the controller’s database), the display will show only the PV and SV 
values.  No other message will alternate with either value. 
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15.4 Configuration Displays 

15.4.1 Introduction 

When the  (menu access) key has been used to display a menu, you can 
configure the controller.   

It is recommended that you put the controller in standby mode as described in 16.3 
before going into configuration to change parameter values.  Putting the controller in 
standby will ensure that the outputs are off.   

During configuration the top line of the display contains a menu name.  The second 
line of the display contains a parameter name, alternating with the current value.  For 
example, when the input menu input type parameter is accessed the display will 
show 

                        alternating                    

                         with                         

15.4.2 Menus Available 

To access the menus containing the configuration parameters, press the  key 
until a text string is displayed on the top line of the display (approximately three 
seconds).  The table below lists all the menus available. 

Which of these menus is displayed depends on the access level set for the controller 
(as described in Chapter 30).  When a controller is first powered up the menus are 
displayed in the sequence in which they are listed in the table.  However, if you exit 
configuration, then access the menus again, you will re-enter the cycle where you left 
it.   

For example, if the      (output) menu   .   (output 2 type) parameter is on 
display when you exit configuration (or are timed out), then when you next access the 
menus, the      menu   .   parameter will the first one displayed. 

To see all the parameters in each of the menus, go to the referenced chapter of this 
manual. 
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Displayed 
Abbreviation 

Menu 
Name 

Access 
Levels 

Described 
In 

    input      (configuration) and  

     (factory) 

19 

     display      (configuration) and  

     (factory) 

20 

     output      (configuration) and  

     (factory) 

21 

     control      (user) and  

     (configuration)  
a n d 

      (factory) 

22 

    alarm      (configuration) and  

     (factory) 

23 

     Autotune damping      (user) and  

     (configuration) and  

     (factory) 

24 

    ramp/soak (4C only)      (user) and  

     (configuration) and  

     (factory) 

25 

     supervisor      (configuration) and 

     (factory) 

26 

    calibration      (factory) only 27 

     option      (configuration) and  

     (factory) 

See Note 1 

Note 1: The 2C and 4C boards automatically detect installed option cards.  
Controllers containing software before version 1.27 contain an      (option) 
menu; however, the values entered with this menu are ignored by the controller. 
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15.5 LEDs 

15.5.1 Introduction 

Each optional display board includes LEDs that indicate: 

 which zone has been selected 

 which of the standard outputs are on 

 whether a process alarm has been detected 

 whether a communication link is active 

The LEDs used for these purposes vary, depending on the display board used. 

15.5.2 4-Inch Square Display Board (p/n 785A406U01) 

15.5.2.1 Zone Indication 

The zone indication LEDs on the 4-inch square display board are LED1 (for Zone 1) 
through LED4 (for Zone 4). The location of the zone indication LEDs on the 4-inch 
square display is shown below. 
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15.5.2.2 Output State Indication 

The on/off state of each standard hardware output is indicated by LED5 (hardware 
output 1) through LED10 (hardware output 6). The location of the output indication 
LEDs on the 4-inch square display board is shown below.  

 

15.5.2.3 Alarm LED 

If the controller has detected a process alarm for any zone (not only the currently 
selected zone), LED15 lights.  (It remains lit until the alarm is cleared.)  The location 
of this alarm LED on the 4-inch square display board is shown below.  
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15.5.2.4 Communication LED 

If a communication link with the controller is active, LED16 is lit.  The location of this 
comm LED on the 4-inch square display board is shown below.  

 

15.5.3 Horizontal Display Board (p/n 785A378U01) 

15.5.3.1 Zone Indication 

The zone indication LEDs on the horizontal display board are D17 and D18. The 
location of the zone indication LEDs on the horizontal display is shown below. 
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The meaning of the on/off combinations is shown below. 

 
Zone 

 
D17 

 
D18 

As 
Displayed 

1 on off 

 

2 off on 

 

3 on on 

 

4 off off 

 

 

15.5.3.2 Output State Indication 

LEDs D3 through D6 indicate the on/off state of the associated hardware output.  D3 
is lit when hardware output 1 is on; D4 is lit when hardware output 2 is on, etc. 

The locations of the output indication LEDs on the horizontal display board is shown 
below.  
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15.5.3.3 Alarm LED 

If the controller has detected a process alarm for any zone (not only the currently 
selected zone), LED D1 lights.  (It remains lit until the alarm is cleared.)  The location 
of this alarm LED on the on the horizontal display board is shown below.  

 

15.5.3.4 Communication LED 

If a communication link with the controller is active, LED D2 is lit.  The location of this 
comm LED on the horizontal display board is shown below.  
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15.5.4 Vertical Display Board (p/n 785A399U01) 

15.5.4.1 Zone Indication 

The zone indication LEDs on the vertical display board are LED1 (for Zone 1) through 
LED4 (for Zone 4). The location of the zone indication LEDs on the vertical display is 
shown below.  

 

15.5.4.2 Output State Indication 

LED6, LED5, LED11, LED12, LED9, and LED10 indicate the on/off state of the 
associated hardware output.  The LED6 (closest to the top of the board) represents 
hardware output 1, LED5 (below LED6) represents hardware output 2, LED11 (below 
LED5) represents hardware output 3, etc.  

The location of the output indication LEDs on the vertical display board is shown 
below.  
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15.5.4.3 Alarm LED 

If the controller has detected a process alarm for any zone (not only the currently 
selected zone), LED8 lights.  (It remains lit until the alarm is cleared.)  The location of 
this alarm LED on the on the vertical display board is shown below.  
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15.5.4.4 Communication LED 

If a communication link with the controller is active, LED7 is lit.  The location of this 
comm LED on the vertical display board is shown below.  

 

15.5.5 ¼ DIN Square Display Board (p/n 785A415U01)  

15.5.5.1 Zone Indication 

The zone indication LEDs on the ¼ DIN display board are LED1 through LED4.  The 
locations of the zone indication LEDs on the ¼ DIN square display are shown below. 

 

15.5.5.2 Output State Indication 

LED7, LED8, LED9, LED10, LED11, and LED12 indicate the on/off state of the 
associated hardware output.  The LED7 (closest to the top of the board) represents 
hardware output 1, LED8 (below LED7) represents hardware output 2, LED9 (below 
LED8) represents hardware output 3, etc. 

The locations of the output indication LEDs on the ¼ DIN square display board are 
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shown below.  

 

15.5.5.3 Alarm LED 

If the controller has detected a process alarm for any zone (not only the currently 
selected zone), LED5 lights.  (It remains lit until the alarm is cleared.)  The location of 
this alarm LED on the on the ¼ DIN square display is shown below.  

 

15.5.5.4 Communication LED 

If a communication link with the controller is active, LED6 is lit.  The location of this 
comm LED on the ¼ DIN square display board is shown below.  
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16. Display Board Keypad Use 

16.1 Key Functions 
The optional display board has five keys: four for zone configuration and operation 
and one for zone selection.  The functions of the keys are described in the table 
below.  The number of the switch used for each key depends on the type of display 
board for which the controller was set up at the factory (or using a MODBUS host).  
The switch used for each configuration/operation key (and for zone selection) is also 
shown in the table. 

The rest of this subsection contains instructions for changing the setpoint, viewing 
and changing the controller’s mode, changing values in the controller’s database, etc. 
using these keys. 

 

For convenience, this manual refers to the 
zone configuration/operation keys using the 
symbols and names in the table below.  These 
are the symbols used on the optional overlays 
for the display boards.  The overlay for the ¼ 
DIN display board is shown at left.  (With the 
exception of zone selection, these are also the 
symbols used as labels on other Series C 
controllers, such as the 16C).  
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Symbol 
Used 

for the 
Key in 
This 

Manual 

 
 
 
 

Name 

 
 
 

4-inch 
Square 

785A406 

 
 
 

Hori- 
zontal

785A378 

 
 
 

Verti- 
cal 

785A399 

 
 
 
 

¼ DIN

785A415 

 
 
 
 

Function 

 

menu 
access 

SW5 SW5 SW1 SW1 Accessing the configuration 
menus, and accessing the 
security access code – Pressing 
and holding this key for 
approximately three seconds 
accesses the configuration menus 
for the selected zone.   

When a menu name is on display, 
key is used to step through available 
menus. 

When the controller is in manual 
mode, key is used to toggle between 
the display of the output 1 percent 
and the output 2 percent. 

When the normal operating display 
(PV and SV) is on display, pressing 
and holding this key for 
approximately ten seconds shows 
the current security access level.  
The level can then be changed. 

 
up SW6 SW6 SW2 SW2 Increasing the value on display or 

cycling up through a list of 
choices – Pressing and releasing 
this key increases the numerical 
value on the operator display or 
configuration display one unit.  
Pressing and holding it increases 
the value more rapidly. 

When a string of characters 
representing a configuration 
parameter choice or a mode choice 
is on display, pressing this key 
displays the previous choice on the 
list. 

 
down SW7 SW7 SW5 SW3 Decreasing the value on display 

or cycling down through a list of 
choices – Pressing and releasing 
this key decreases the numerical 
value on the operator display or 
configuration display one unit.  
Pressing and holding it decreases 
the value more rapidly. 

When a string of characters 
representing a configuration 
parameter choice or a mode choice 
is on display, pressing this key 
displays the next choice on the list. 
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Symbol 
Used 

for the 
Key in 
This 

Manual 

 
 
 
 

Name 

 
 
 

4-inch 
Square 

785A406 

 
 
 

Hori- 
zontal

785A378 

 
 
 

Verti- 
cal 

785A399 

 
 
 
 

¼ DIN

785A415 

 
 
 
 

Function 

 

mode/enter SW8 SW8 SW3 SW4 Viewing the mode or selecting the 
currently displayed configuration 
choice or value – While the 
controller is in use (controlling a 
process loop), this key is used to 
view the current operational mode.  

When a configuration menu has 
been accessed, this key is used to 
step through the parameters within a 
menu, and to write the currently 
displayed choice or value to the 
controller’s database. 

 

zone 
selection 

SW2 SW2 SW7 SW5 Selecting the zone for which 
information will be displayed.26 

 

                                                      

26 If your controller board contains software earlier than version 1.27, then the menu access key is used 
to select the zone.  Pressing the menu access key for more than one second (but less than three 
seconds) steps to the next zone.  The software version loaded on a controller is displayed when the 
board is powered up; see 1.10. 
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16.2 Displaying and Changing the Setpoint 
The setpoint can be changed only when the controller is in normal (automatic) mode 
or standby mode.  (If the PV is alternating with      (standby), you can change 
the setpoint, but the change will not take effect until you put the controller back into 
normal mode.)  

To view the current setpoint for the selected zone, if it is not on display 
because setpoint display blanking is enabled: 

Press any key briefly.  The setpoint will be displayed on the lower line. 

To change the setpoint: 

Use the  and  keys to change the displayed value. 

See 1.7 for the possible sources of the setpoint being displayed by the controller (the 
“active setpoint”). 

See 19.6.2 (temperature input) or 19.7.3 (linear input) for information about the 
  .   and   .   parameters used to configure the range of setpoints that can 
be entered using an optional display board. 

16.3 Putting Controller in Standby Mode 
To put a zone in standby mode: 

1. Select the zone. 

2. Press the  key until      is displayed on the top line (after approximately 
three seconds) and the current mode on the lower line.  For example, if the 

controller is in normal (automatic) mode, pressing the  key for approximately 
three seconds will display: 

    

   

3. Press the  or  key to cycle through the modes until      is on the lower 
line.  The display will show: 

    

    

4. Briefly press the  key again.  The display will show      alternating with the 
process value on the top line, and the setpoint displayed steadily on the lower line.  
For example, if the PV is 105 and the SV is 110 you will see: 

                     alternating                   

                           with                       
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16.4 Returning Zone to Normal Operation 
To return a zone to normal operation. 

1. Select the zone. 

2. Press the  key until      is displayed on the top line and the current mode’s 
abbreviation is on the lower line.  For example, if the controller is in standby the 
display will show: 

    

    

3. Press the  or  key to cycle through the modes until     is on the lower 
line.  The display will show: 

    

   

4. Briefly press the  key again.  The display will show the process value on the top 
line and the setpoint on the lower line.  For example, if the PV is 105 and the SV is 
110 you will see: 

    

   

16.5 Putting Controller into Manual Mode and Changing the 
Output Values 

To put a zone in manual mode: 

1. Select the zone. 

2. Press the  key until      is displayed on the top line and the current mode on 
the lower line.  For example, if the controller is in normal (automatic) mode, pressing 

the  key for approximately three seconds will display: 

    

   

3. Press the  or  key to cycle through the modes until     (fixed output 
percentage) is on the lower line.  The display will show: 

    

   

4. Briefly press the  key again.  The display will show the process variable on the top 
line.  On the lower line      (percent 1) will alternate with the current fixed output 
percent.  When you switch the zone to manual, the most recent output percentages 
used in normal (auto) mode will continue to be used.  This provides “bumpless” 
transfer.   
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For example, if the PV is 105 and output 1 was most recently at 50% in normal mode, 
you would see: 

                     alternating                   

                        with                        

5. Use the  and  keys to change the manual output 1 value displayed to the 
desired percentage. 

6. To write the output 1 percentage to the controller’s database, briefly press the   
key.  The controller will begin to use the specified fixed output percentage.  (The 
transition from automatic PID to the manual percentage will be “bumpless”.)  The 
lower line display will change to     , alternating with the current value for output 
2. 

7. Use the  and  keys to change the manual output 2 value displayed to the 
desired percentage. 

8. To write the output 2 percentage to the controller’s database, briefly press the   
key.  The controller will begin to use the specified fixed output percentage. 

9. The zone will remain in manual mode until you press and hold the  key to display 
     and    , and then change to one of the other modes as described above 
and below. 
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16.6 Changing the Zone Count 
To change the quantity of active zones: 

1. With any zone selected, access configuration mode by pressing and holding the 

 key until a string of letters is displayed on the top line (approximately three 
seconds).  The letters displayed are an abbreviated name of a menu. 

2. Press the  key repeatedly to until the      (Supervisor) is on the top line 
of the display. 

3. Briefly press the  key once to display the first parameter in the menu (or the 
parameter most recently accessed in the last configuration session).  The 
abbreviated name of the parameter will be on the lower line, alternating with the 
current value for the parameter stored in the controller’s database. 

4. Press the  key until the top line of the display shows      (Zone Count). 
The current quantity of active zones will be displayed on the lower line. 

5. To change the current count, press the  and  keys. 

6. When the desired count is on display, press the  key once.  The displayed 
choice or value will be written to the controller’s database.  The next parameter in 
the menu (or the first parameter if you were at the end of the menu) will be 
displayed. 

7. To implement the new zone count, cycle the power to the controller. 

16.7 Starting, Pausing, and Terminating Recipe Execution 
To start execution of the single-setpoint ramp27 or a multi-step recipe:  

1. Select the zone. 

2. Press the  key until      is displayed on the top line and the current mode 
on the lower line. For example, if the controller is in normal (automatic) mode, 

pressing the  key for approximately three seconds will display: 

    

   

3. Press the  or  key to cycle through the modes.  If a single-setpoint ramp 
or multi-step recipe has been configured as described in Chapter 25,   .  
(ramp/soak) will be one of the mode choices on the lower line.  The display will 
show: 

    

  . 

                                                      

27 If single-setpoint ramp is enabled, then the ramp will be executed automatically at startup; see 25.1. 
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4. Briefly press the  key again.   

 If the zone is configured to execute a single-setpoint ramp, the display 
will show    on the top line, alternating with the process variable.   

 If the zone is configured to execute a multi-step ramp, the display will 
show   .   (ramp/soak ramp 1) on the top line, alternating with the 
process value.   

In either case, the lower line will display the setpoint, which has been 
changed by the controller to match the process value. For example, if the PV 
is 105, you would see: 

  .                   alternating                   

                            with                       

As the single-setpoint ramp or multi-step segment 1 ramp time passes, the 
setpoint will be ramped toward the target value.   

 In the case of a single-setpoint ramp, this is the normal setpoint. 

 In the case of a multi-step recipe, this will be soak level 1 value.  

What happens when the target setpoint is reached depends on several factors.28 

 In the case of a single-setpoint ramp, the display will change to the normal 
operating display with the PV on the top line and the SV on the lower line, unless 
the termination state parameter was used to specify that the zone should be 
placed in standby when the ramp up to setpoint has been completed.29  

 In the case of a multi-step recipe, the top line of the display will change to 
  .   (ramp/soak soak 1).  The recipe will continue to execute, maintaining 
the setpoint at soak level 1 for the duration of soak time 1.  The recipe will then 
begin to execute the next segment, and the display will change to   .  , 
alternating with the process variable on the top line, and the setpoint on the lower 
line. 

To pause a recipe or single-setpoint ramp during its execution: 

1. Select the zone. 

2. Press the  key until      is displayed on the top line.  The lower line will 
show  
  .  (ramp/soak hold). 

3. Press the  key once to go into recipe hold mode.  The top line of the display 
will show      alternating with the process value, while the lower line 

                                                      

28 Whether the process value actually matches the setpoint when the ramp time has elapsed depends on 
how you have configured your recipe.  If you have not used the holdback feature and have not configured 
the ramp time realistically for your process, the PV may not match the SV when the ramp time has 
elapsed.  Read Section 25, then enable holdback or fix your ramp time so that the PV has time to catch 
up to the SV. 

29 This is also what happens if a single-setpoint ramp is executed automatically at startup. 
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displays the setpoint.  The setpoint will remain at this level until you take the 
recipe out of hold. 

To resume execution of a held recipe: 

1. Select the zone. 

2. Press the  key until      is displayed on the top line.  The lower line will show 
    (fixed output percentage). 

3. Use the  or  key to display  .    (ramp/soak run/resume). 

4. Press the  key once to resume execution of the recipe.  The top line of the display 
will again show the current ramp or soak segment number, alternating with the 
process value, while the lower line displays the setpoint.   

To terminate execution of the recipe: 

1. Select the zone. 

2. Press the  key until      is displayed on the top line.  If the recipe is active, 
the lower line will show   .   (ramp/soak hold). 

3. Instead of pressing the  key to select ramp/soak hold, use the  or  key to 
display     (normal) or     (manual mode). 

4. Press the  key once to terminate execution of the recipe.   

 If you selected normal mode, the top line of the display will show the process 
variable.  The lower line will show the setpoint.  This setpoint will be at whatever 
value the recipe had reached while executing.  This is different from what 
happens if a recipe completes execution normally.  In that case, the setpoint 
value will be determined by the termination state configured using the ramp/soak 
menu as described in 25.4.2.   

 If you selected manual mode, the top line of the display will show the process 
variable.  The lower line will show      alternating with the current fixed 
output percentage. 

16.8 Clearing Latched Alarms 
To clear all latched alarms: 

1. Select the zone. 

2. Briefly press the  key once.  All alarms currently latched will be unlatched if 
the alarm condition has been cleared. 
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16.9 Working in Configuration Mode 

16.9.1 Entering and Exiting Configuration Mode 

We recommend that you put the zone into standby mode before entering the menu 
system. 

To enter configuration mode: 

1. Select the zone. 

2. Access the configuration menus by pressing and holding the  key until a 
string of letters is displayed on the top line (approximately three seconds).  The 
letters displayed are an abbreviated name of a menu.   

When a controller is first powered up, the menus are displayed in the sequence 
shown in 15.4.2, beginning with the     (input) menu.  However, once you leave 
the menu system (or are timed out), the controller “remembers” where you were.  

When you next press and hold the  key, the controller will display the menu that 

was on display when you left the menu system.  Pressing the  key will display the 
parameter accessed most recently. 

To exit configuration mode: 

Return to the normal operating display by pressing and holding the  key until the 
process variable is displayed on the top line and the setpoint on the lower line. 

16.9.2 Procedure for Viewing and Changing a Configuration 
Parameter Value 

To view a parameter’s current value: 

1. Select the zone. 

2. Access configuration mode by pressing and holding the  key until a string of 
letters is displayed on the top line (approximately three seconds).  The letters 
displayed are an abbreviated name of a menu. 

3. Press the  key repeatedly to step through the available menus. 

4. Once the name of the menu of interest is on the top line of the display, briefly press 

the  key once to display the first parameter in the menu (or the parameter most 
recently accessed in the last configuration session).  The abbreviated name of the 
parameter will be on the lower line, alternating with the current value for the 
parameter stored in the controller’s database. 

5. To step through the parameters in the displayed menu, press the  key repeatedly. 

6. When the parameter of interest is on display, stop pressing the  key.  The 
abbreviated parameter name will alternate with the value or choice currently stored in 
the controller’s database. 

7. To change the current choice or numeric value, use the  and  keys. 
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8. When the desired choice or numeric value is on display, press the  key once.  
The displayed choice or value will be written to the controller’s database.  The next 
parameter in the menu (or the first parameter if you were at the end of the menu) will 
be displayed. 

At this point you can: 

 use the  and  keys to change the value of the newly displayed parameter, or 

 if you like the current value of the parameter on display, you can press the  key to 
leave the displayed value unchanged and go on through the parameters in the 
menu), or 

 press the  key once to go to the next menu, then use the  key to step through 
the parameters in that menu, or 

 press the  key repeatedly to display menus later in the cycle, or 

 press and hold the  key until the normal operating display returns to view.  

If you do not press any key, eventually you will be timed out of the menu system.  The 
controller will revert to the operational display that was in view before you entered the 
menu system. 

16.9.3 Configuration Example 

Suppose that once the controller is in operation you want to turn off setpoint blanking and 
change the alarm 2 setpoint. 

1. Select the zone. 

2. Press and hold the  key (approximately three seconds) until      is displayed 
on the top line and the current mode on the lower line. 

3. Press the  or  key until      is displayed.   

4. Press the  key again.  The display will show      alternating with the process 
value on the top line.  The setpoint will be displayed on the lower line. 

5. Press and hold the  key until the abbreviated name of a menu is displayed on the 
top line of the display.   

 If no one has used the menu system since the controller was powered up, the 
    (input) menu will be displayed first.   

 If someone has already accessed the menu system since startup, the menu 
displayed will be the last one used. 

6. To turn off setpoint blanking, press the  key until the      (display) menu 
name is on the top line. 

7. Press the  key until the      (setpoint blanking) parameter is displayed on the 
lower line.  The display of      will alternate with the display of the current value.  
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(When setpoint blanking is on, a numeric value represents the number of seconds 
that the setpoint will be displayed after a key press.  When the time elapses, the 
setpoint display will become blank.) 

8. Press the  key until     is displayed for     . 

9. To write this new setting to the controller’s database, press the  key once.  The 
new setting will be saved and    .  (decimal position) will be displayed on the 
lower line.  (The blanking parameter is the last in the display menu, so the controller 
goes to the top of the menu and shows you the first display parameter, decimal 
position.)  

10. Because you do not plan to change any other display parameters at the present time, 

press the  key to go to the next menu      (output).   

11. Because you do not plan to change any output parameters during this configuration 

session, press the  key again.  The name of the next menu in the cycle      
(control) will be displayed. 

12. You do not need to change any control parameters right now, so press the  key 
again.  The top line will show     (alarm). 

13. Because the alarm 2 setpoint that you want to change is on the alarm menu, press 

the  key to display the first parameter in the alarm menu.  This is   .   (alarm 
1 alarm action). 

14. Press the  key repeatedly until you see the parameter that you want to change: 
  .   (alarm 2 setpoint).  The current value will alternate with the   .   label. 

15. Use the  and  keys to change the alarm 2 setpoint to your new value. 

16. Press the  key once to save the change.  Because the   .   parameter is at 
the end of the menu, the first parameter in the alarm menu will be displayed again. 

17. The two changes you wanted to make have been accomplished, so you can press 

and hold the  key to return to the normal operating display.   

If you do not press and hold the  key, after a brief interval the controller will 
automatically go back to the normal operating display (PV and SV). 

If you do not press the  key after you change a parameter value, and you are 
subsequently timed out of the menu system, the change will not be saved to the 
controller’s database. 
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Section D – Configuration Parameters 
This section contains information about: 

 configuring the controller for PID control – see page 17-1 

 configuration parameters in general – see page 18-1 

 input parameters – see page 19-1 

 display parameters – see page 20-1 

 output parameters – see page 21-1 

 control parameters – see page 22-1 

 alarm parameters – see page 23-1 

 Autotune damping parameter – see page 24-1 

 ramp/soak recipe parameters – see page 25-1 

 supervisor parameters – see page 26-1 

 calibration function – see page 27-1 

 tuning the controller for PID control – see page 28-1 

 changing the security access level – see page 30-1 

 calibrating the controller – see page 31-1 

 error messages and codes – see page 32-1 
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17. Configuring the Controller – Quick Setup 
Instructions for PID Control 

17.1 Introduction 
The instructions in this chapter assume that: 

 the controller is already mounted and wired correctly 

 the controller is new, still set to its factory settings, including access level 

 the correct sensor type was specified for each zone when the controller was 
ordered 30), so that the input jumpers and input type parameter values were set 
appropriately at the factory. 

Before following the instructions in this chapter, read the precautions at the front of 
this manual.   

                                                      

30 To determine the input types specified when the controller in hand was ordered, check the model 
number on the serial tag.  The meaning of each character in the model number is in 2.2. 
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17.2 Quick Instructions 
The instructions below guide you through the minimum tasks needed to configure a 
single zone in the controller for PID control.  Unless you change the value of a 
configuration parameter, the controller will use the defaults and the input type 
settings configured at the factory.  The parameters modified using the instructions 
below are only a few of the parameters available to customize the controller’s 
operation for your application.   

These instructions assume that a display board is connected to the controller.  

Repeat the procedure for each zone. 

If you want to learn about all the parameters available, read Chapters 19 through 26.  
Chapters 19 through 26 also contain the default values for all configuration 
parameters in every menu. 

1. Put the zone in standby mode. 

a) Apply power.  

b) After self-check display stops, press and hold the  (mode/enter) key31 
(approximately three seconds) until      is displayed on the top line and 
the current mode on the lower line. 

c) Press the  or  key until      is displayed.   

d) Press the  key again.   The display will show      alternating with the 
process value on the top line.  The setpoint will be displayed on the lower 
line. 

2. Specify the input type, unless the factory setting will be used.32 

a) Press and hold the  (menu access) key until     is displayed on the 
top line (approximately three seconds).  (If the name of a menu other than 

input is displayed, repeatedly press the  key until you see    .33) 

b) When     is displayed, press the  key once to make      appear 
on the lower line.  The choice that is currently stored in the controller’s 
database for this parameter will alternate with the display of     . 

                                                      

31 To see which switch (pushbutton) on the display board is used for each function, see 16.1. 

32 The input type is set at the factory to match the input type specified when the controller was ordered.  If 
you change the input type from the factory setting, you may also have to change the input jumper 
settings.  See 3.2.2 for details. 

33 If you do not see     when you access the menus (or do not see      first in the input menu), 
someone has accessed the menu system since the controller was powered up.  At power up the menus 
are displayed in the sequence shown on page 18-5.  However, once you enter and leave the menu 
system, the controller “remembers” where you left.  When you next access the menus, the menu 
parameter that was displayed when you left (or were timed out) will again be displayed.  Repeatedly 

pressing the  key will cycle through the menus.  Repeatedly pressing the  key while a menu name 
is on display will cycle through the parameters within the menu. 
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c) Use the  or  key to step through the list of choices until the desired 
input type is on display.   

d) Press  to write the choice to the controller’s database.  The next 
parameter in the menu (    ) will be displayed.  Most applications use 
the default bias value (zero). 

3. Specify the output type for output 1. 

a) While still in the menu system, press the  key until      (output) is 
displayed on the top line.  

b) Once at the output menu, press  to display the output 1 type parameter 
  .   on the lower line. 

c )  The output type currently assigned to output 1 will alternate with the display of 
  .  .  If the output has been changed from the default    , use the  
or  key to display    . 

d) To write     to the controller’s database, press the  key once.  The next 
parameter,   .   (output 1 action) will be displayed. 

4. Specify the output 1 action,     (direct) or    (reverse), for output 1.  Generally, 
heating applications are reverse-acting and cooling applications are direct-acting. 

a) When the   .   parameter is on display, use the  or  keys to display 
the action for your application. 

b) Press the  key once to write the action choice to the database.  The next 
parameter,    .   (output 1 cycle time) will be displayed. 

5. Specify the output 1 cycle time. 

a) When the   .   parameter is on display, use the  and  keys to 
display the appropriate time for your application.  Generally, for digital outputs, 
valid cycle times range from 15 to 120 seconds.  

b) Press the  key to write the cycle time value to the controller’s database and 
display the next parameter   .   (output 1 low limit).  Most applications use 
the default value. 

c) Press the  key to accept the output 1 low limit default and display the next 
parameter   .   (output 1 high limit).  Most applications use the default value. 

6. Specify the output type for output 2. 
 
Important:  If only one output is PID, change output 2 from the default    , to one 
of the other choices:   .   (on/off),     (alarm), or    . 

a) Press the  key to display the   .   (output 2 type) parameter, alternating 
with its current setting. 

b) The default for output 2 is PID.  If PID is not right for your application, use the 
 or  arrow key to display the desired output type. 
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c) Press the  key to make this selection.  What parameter you see next depends 
on the output 2 type you selected.  

 If you use PID or on/off control for output 2, you will see   .   (output 2 
action).  Go on to step 7 below. 

 If you set output 2 to off, you will again see the   .   (output 1 type) 
parameter.  Go to step 9. 

 If you plan to use output 2 for alarm annunciation, you will see   .   
(output 2 alarm action).  Read 21.5 and configure the output alarm 
parameters before returning to step 9 in this chapter.  

7. Specify the output 2 action for PID or on/off control. 

a) When the   .   parameter is on display, use the  or  keys to display 
the action for your application. 

b) Press the  key once to write the action choice to the database.  What 
parameter you see next depends on the choice you make for the output 2 type. 

 If output 2 is PID, the next parameter,   .   (output 2 cycle time) will be 
displayed.  Go to step 8. 

 If output 2 is on/off, configuration of output 2 has been completed, and 
  .   will again be displayed.  Go to step 9.  

8. Specify the output 2 cycle time for PID control. 

a) When the   .   parameter is on display, use the  and  keys to 
display the appropriate time for your application (see step 5a above). 

b) Press the  key to write the value to the controller’s database and display the 
next parameter   .   (output 2 low limit).  Most applications use the default 
value. 

9. Make your choice of Autotune damping setting.  Use this parameter to specify how 
aggressively the controller will perform Autotune.   

a) Press the  key repeatedly until      is displayed on the top line. 

b) Display the current setting for the Autotune damping parameter by pressing the 

 key.  The parameter abbreviation      will alternate with the current 
setting,    (low),   , (normal) or    (high). 

c) Use the  or  key to display the appropriate setting for your application. 

 Low provides fastest recovery, but with the possibility of overshoot.  

 High provides little or no overshoot, but with slower recovery.  

 Normal is a compromise between fast recovery and overshoot. 

10. Autotune the zone while the setpoint is at least 1% of the sensor span above or 
below the process value.  This will set the tuning parameters: proportional band, 
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derivative action (rate) and integral action (auto reset).  (More detailed instructions for 
Autotuning are in 29.2.) 

a) Press and hold the  key (approximately three seconds) until the top line of 
the display shows      alternating with the process value and the lower line 
displays the setpoint. 

b) Use the  and  keys to change the setpoint to a value that will be used by 
your application. 

c) Press and hold the  key until the top line displays      and the lower line 
displays     . 

d) Use the  or  key to step through the modes until      is displayed. 

e) Press the  key to start the autotuning operation.  The display will flash 
    . 

f) Do not press any keys while the Autotune is in progress, unless you want to stop 
the autotuning by putting the controller into standby or manual mode.  When the 
controller has completed autotuning successfully, the flashing      will 
disappear.  The display will revert to the normal mode operating display, with the 
process value on the top line and the setpoint on the lower line. 
 
If the Autotune was unsuccessful, the top line will briefly display    plus a two-
digit error code, then go back to flashing     .  Refer to Chapter 28 for the 
Autotune error codes.  Fix the problem and try tuning again.  

Once Autotune has been completed successfully, and the PV and SV are on display, 
the controller is controlling the process. 

Monitor the process.  If unacceptable overshoot occurs, change the Autotune 
damping setting to high and repeat the Autotune.  If the process response is 
sluggish, change the damping setting to low and repeat the Autotune.  

Repeat these instructions for the every active zone. 

Once setup is complete, we recommend changing the security access level to the 
most restrictive level suitable for your application.  See Chapter 30 for details. 
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18. General Information About 
Configuration Parameters 

18.1 Information in This Chapter 
This chapter contains general information about the configuration parameters used 
by the 2C and 4C controllers.  Chapters 19 through 26 contain information about 
functional groups of parameters.  Each chapter describes the parameters in a single 
configuration menu.   

If you have used 2C and 4C controllers before, and plan to use PID control (the 
default), then these chapters probably contain more information than you need.  Go 
back to the previous chapter.  It contains instructions for doing the minimum to get a 
controller up and running using PID control (and most of the other configuration 
defaults). 

However, if you are a new user of 2C and 4C controllers, or plan to use an option you 
have not used before, then refer to this chapter, as well as Chapters 19 through 26, 
for the information you need. 

This chapter contains descriptions of only those parameters that can be 
changed using an optional display board. Additional settings and status values 
are available to a MODBUS host. For information about those parameters, see Using 
the MODBUS Protocol with 2C and 4C Controllers. 
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18.2 How to Use Chapters 19 through 26 
You do not have to read the all of Chapters 19 through 26.  You can skip any 
chapters marked “optional” that do not apply to your control strategy.  You can also 
skip some parts of some of the required chapters.  The path you take as you read will 
be determined by your control strategy.   

For example, in Chapter 19 everyone needs to know about the information in 19.1, 
19.2, 19.3, 19.4, and 19.5, so there are no stop signs to interrupt your reading.  
However, when you get to the end of 19.5 you will see:  

 

What’s next after you have specified the input type? 
 
If you chose an RTD or thermocouple input type, go to 19.6. 
If you chose a linear input type go to 19.7. 

 

This means that you should look at either 19.6 or 19.7, but you do not have to read 
both.   

If a parameter applies to both temperature and linear input types, the parameter 
description will be repeated in 19.6 and 19.7.   
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18.3 Information Provided About Each Parameter 

18.3.1 Summary 

Each menu consists of a functional group of parameters.  For each parameter the 
following information is provided: 

 parameter name 

 name as displayed – This is the parameter name as it is displayed on an 
optional display board.  

 when displayed – This paragraph indicates whether the parameter applies 
to all control strategies (“always”) or only under certain circumstances (which 
are identified).   

 choices or range – If you must make a selection from a list, all the choices 
are listed in the sequence in which they appear (on an optional display 
board) if you scroll through the list using the  key.  If you must specify a 
numerical value, then the range of valid values is defined.  For some 
parameters the range is reduced if a linear input is used.  See 18.3.2 for 
details.  

 default value – The default value is shown for each configuration parameter.  
The configuration parameters can be returned to their default values using 
the procedure in 26.5.34 

 description – The purpose of the parameter and any special information you 
need to know to use this parameter is provided.   

 effect on other parameters – For some parameters, additional information 
is included.  If applicable, this paragraph tells how the value selected for a 
parameter affects other parameters.   

18.3.2 Effect of Linear Input on Numerical Ranges 

If the controller uses a linear input and the      (display) menu    .  
(decimal position) parameter is not set to 0 (zero), the number of decimal places 
specified is always imposed on the parameter’s value.  This has the effect of 
reducing the range of valid values for many parameters when a linear input is used.  
The parameters affected are denoted by a cross-reference to this subsection. 

For example, suppose the range of valid values for a parameter is –1999 to 9999.   

 If a linear input is used and the decimal position is 1, then the range for the 
parameter is reduced to –199.9 to 999.9.  

 If a linear input is used and the decimal position is 2, then the range is –19.99 to 
99.99.  

                                                      

34  The defaults in all controllers can be returned to the defaults using the Supervisor menu or a 
MODBUS write function. On a 4C the DIP switches and also be used to reset parameters to the defaults 
(see 3.3.2).   
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 If a linear input is used and the decimal position is 3 (the maximum for linear 
inputs), then the range is –1.999 to 9.999.  

In contrast, when a thermocouple or RTD input is used, the decimal position specified 
using the    .  parameter in the      (display) menu is a maximum.  This 
means that the controller applies the specified number of decimal places only if doing 
so does not limit the value of the parameter.  For example, suppose the range of 
valid values for a parameter is –1999 to 9999.   

 If an RTD or thermocouple input is used and the decimal position is 1, then the 
range for the parameter is still –1999 to 9999.  If you configure a value of 1000, 
no decimal places will be displayed, despite the Decimal Position setting of 1. 

 If an RTD or thermocouple input is used and the decimal position is 2 (the 
maximum for temperature inputs), then the range for the parameter is still –1999 
to 9999.  If you configure a value of 1000, no decimal places will be displayed, 
despite the decimal position setting of 2. 

18.3.3 Changing Between Input Categories May Change Decimal 
Setting 

If you change between input categories (RTD, T/C, or linear), the decimal position 
used by the controller may change. (For information about configuration of input type, 
see 19.5.) 

When you change the input setting to a type in a different category, the controller will 
revert to the last decimal position setting used for the newly selected category (or to 
the default    .  value if the category has not been used since the last time the 
controller was configured to use default values). 
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18.4 Menu and Parameter Display Sequence 
The menus and parameters are displayed in the sequence shown below.  When the 
controller is powered up, the menu sequence starts with the     (input) menu.  
Within the menus, the parameters are displayed in the sequence shown below.   
However, not all parameters apply to every control strategy.  

If a parameter does not apply to a particular control strategy, then that parameter will 
not be displayed.  For example, if you specify that the output 2 type is    , then 
the other parameters used to configure output 2 will not be displayed. 

When you have gone into the menu system and then exited the menus, the controller 
“remembers” where you were.  The next time someone accesses the menu system, 

the controller will display the menu from which you left.  When the  (mode/enter) 
key is pressed, the parameter displayed will not be the first one in the menu.  Instead, 
the last parameter accessed during the most recent configuration session (since 
power up) will be displayed.  For example, if you exited the menu system (or were 
timed out) when the      (display) menu’s      parameter was on display, 
then the next time the menu system is accessed, the      menu      
parameter will be the first parameter displayed. 

Displayed 
Abbreviation 
(menu name) 

 
 

Parameters 

 
Access 
Levels 

 
Described

In 

   

( input) 
    

    

   . 

   . 

  .  

  .  

 .   

     (configuration) 
and  

     (factory) 

19 

    

( d i s p l a y )  
   . 

 .   

    

    

     (configuration) 
and  

     (factory) 

20 

    

( o u t p u t )  
  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

     (configuration) 
and  

     (factory) 

21 
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Displayed 
Abbreviation 
(menu name) 

 
 

Parameters 

 
Access 
Levels 

 
Described

In 

    

( c o n t r o l )  
  . 

   . 

  . 

   . 

   

   

   

    

   

     (user) a n d   

     (configuration) 
and

     (factory)  

22 

   

( a l a r m )  
  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

  .  

     (configuration) 
and  

     (factory) 

23 

    

(Autotune 
damping) 

          (user) and  

     (configuration) 
and  

     (factory) 

24 

   

(ramp/soak’ 
4C only) 

 .   

 .   

   . 

   . 

   . 

  .  

   

   

   

   

   

 

 

 

   

   

   

   

   

     (user) and  

     (configuration) 
and  

     (factory) 

25 
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Displayed 
Abbreviation 
(menu name) 

 
 

Parameters 

 
Access 
Levels 

 
Described

In 

    

(supervisor) 
  .  

  .  

 .  . 

  .  

  .  

  .  

    

     (configuration) 
and 

     (factory) 

26 

   

(calibration) 
    

    

     (factory) only 27 

    

(serial) 
 

     

     

     

      

     (configuration) 
and  

     (factory) 

28 
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18.5 Using Factory Settings 
Chapters 19 through 26 include the default value for every parameter.  Except in the 
case of input type, this is the factory setting.  (New controllers are configured at the 
factory for the input types specified when the controller was ordered.)   

If you want to use the default for a particular parameter, you do not have to take any 
action.  

For example, suppose you want to use the defaults for the setpoint low limit and the 
setpoint high limit in the input menu.  Also, you know that the defaults for every 
parameter in the display menu are OK for your application.   

In this case, when you work your way through the input menu and get to the setpoint 

limits, you can press the  (mode/enter) key as each setpoint limit parameter is 
displayed to accept the current value and move on to the input filter parameter.   

After using the  and  keys to specify an input filter value, you press the  
key to write the new value to the database.  The first parameter in the input menu 
(    ) will again be displayed.   

You press the  key to display the abbreviated name of the next menu.  It is 
     (display).  If you know you are satisfied with the defaults for all the display 

menu parameters, you do not have to press the  key to cycle through the display 
parameters.   

You can immediately press the  (menu access) key again to move on to the 
     (output) menu. 
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19. Input Parameters – Required 

19.1 Introduction 
If you plan to use a thermocouple or RTD input and a unit of measure other than 
Fahrenheit (the default), the first step is changing the unit of measure to Celsius or 
Kelvin.   

Otherwise, the first step when configuring a controller is configuring input parameter 
values using the     (input) menu if you want to use a type other than the one you 
specified for the zone when you ordered the controller.   

The input type for each zone is set at the factory to match the input type(s) you 
ordered.  

During input configuration you specify the bias (if any) to be applied to the input, 
scaling the input (linear types only), specifying the setpoint range, and setting an 
input filter value (if any).  

This menu is available only when the security access level is set to 
    (configuration) or     (factory).35 

19.2 Factory Calibration Is Appropriate for the Input Type You 
Ordered 

You do not have to calibrate every new controller.  New controllers are calibrated 
at the factory for the type of input(s) you specified when ordering the controller.  In 
the context of ordering the controller, “type” refers to these choices:   

 thermocouple 

 RTD 

 decimal RTD 

 millivolt linear 

 volt linear 

 current linear input 

                                                      

35 The access level in all new 2C and 4C boards is set to     at the factory.  If you cannot see the 
input menu, the access level has been changed to a more restrictive level.  Instructions for changing the 
access level are in Section 30. 
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19.3 Input Jumper Settings Must Match Input Type 
Depending on the type of input, you might have to change jumper settings.  In 2C 
and 4C devices, the input jumpers must be set according to the type of input.  For 
more information about jumper settings, see 3.2.2.  

The input jumpers are set at the factory to match the type of input specified 
when the controller was ordered.36  If you plan to use the controller with an 
input that does not match the factory settings, you must set the input jumpers 
correctly before any configuration parameters are configured. 

19.4 Input Menu Parameter List  

The    (input) menu is shown in the table below.  Descriptions of the individual 
parameters are later in the subsection. 

Item Parameter Name When Displayed 

     Input Type always 

     Input Bias always 

   .  Linear Input Scaling Low Limit 

   .  Linear Input Scaling High Limit 

only for linear input types 
(millivolt, voltage, or milliamp) 

  .   Setpoint Low Limit always 

  .   Setpoint High Limit always 

 .    Input Filter always 

 

                                                      

36 To determine the type of input for which the controller in hand was calibrated (and for which the input 
jumpers were set) at the factory, check the model number on the serial tag.  The meaning of each 
character in the model number is in 2.2. 
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The process of configuring the input parameters is diagramed below. 
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19.5 Specifying the Input Type 

19.5.1 Parameter Used 

After changing the unit of measure for temperature inputs, the next step when 
configuring a controller is always specifying the input type using the     (input) 
menu if different from the input type specified when the controller board was ordered.  
The input type is set at the factory to match the calibration type specified when the 
controller was ordered.37  However, the input type can be changed using the      
parameter described below.  If you change the input type from the factory setting, you 
may also have to change the input jumper settings.  See 3.2.2 for details. 

Parameter Name: Input Type 

Name as Displayed:     

When Displayed: always 

Choices:    type J thermocouple 
    type E thermocouple 
   type C thermocouple 
   type B thermocouple 
     1 to 5 V linear 
     0 to 10 V linear 
     0 to 5 V linear 
     0 to 1 V linear 
  .   10 to 50 mV linear 
 .    0 to 100 mV linear 
 .    0 to 50 mV linear 
 .    0 to 10 mV linear 
 .    4 to 20 mA linear 
 .    0 to 20 mA linear 
  .   100 ohm compressed RTD with decimal support 
 (notice  the decimal point in the parameter choice) 
     100 ohm platinum RTD (no decimal point) 
     Platinel II thermocouple 

   type T thermocouple 
   type S thermocouple 
   type R thermocouple 
    nickel-nickel-molybdenum thermocouple 
   type n thermocouple 

    type K thermocouple 

Default: J thermocouple when configuration parameters are set to their 
defaults using a MODBUS host, the 4C DIP switches (see 
3.3.2), or the Supervisor menu (see 26.5).  At the factory, the 
input type of a new controller is configured to match the input 
type specified when you ordered the controller board.  See Note 
1 below. 

                                                      

37 To determine the inputs ordered for the controller in hand, check the model number on its serial tag.  
The significance of each character in the model number is in 2.2. 
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Description: The type of input the controller algorithm will expect. The type of 
input specified affects how the controller processes the input 
signal and calculates the output needed to achieve the setpoint.  
For example, the controller will linearize a thermocouple input.  
This operation is not needed if the input type is already linear.   

Effect on Other 
Parameters: 

 
 

 
 
 
 
 

If you select an RTD or thermocouple input, then scaling limits 
used by linear input types do not apply.  The Linear Input 
Scaling Low Limit (   . ) and Linear Input Scaling High Limit 

(   . ) parameters will not be displayed in the input menu. 

If you select   .  (100 ohm compressed RTD with decimal 
support), the Decimal Position parameter will not be displayed in 
the display menu.  A compressed RTD input always uses one 
decimal position. 

When you change the input type, parameters expressed in 
engineering units will be recalculated or set to the defaults. 

Also, the decimal position may change when you change the 
input type; see 18.3.3. 

Note 1:  The input type is configured at the factory.  The type configured depends on 
the input types ordered.  To determine the inputs ordered for the controller in hand, 
check the model number on its serial tag.  The significance of each character in the 
model number is in 2.2. 
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19.5.2 Procedure for Viewing the Currently Selected Input Type 

To view the input type currently set for the controller: 

1. Access the configuration menus by pressing the  (menu access) key until a 
string of letters is displayed on the top line (approximately three seconds).    

2. If a menu name other than     is displayed, press the  key until     is 
displayed on the top line.   

3. If a parameter name other than      is displayed on the lower line, press the 

 (mode/enter) key repeatedly to step until the      parameter is 
displayed.  The display of the parameter will alternate with the currently 
configured choice for this parameter.  For example, in an out-of-the box 
controller,      will alternate with the display of   (for J thermocouple). 

19.5.3 Procedure for Changing the Input Selection 

To change the input type selection: 

1. Press the  key or  key to cycle through the input type choices until the 
input type you want is displayed on the lower line.   

2. Press the  key once to write the configuration change to the controller’s 
EEPROM and display the next parameter (bias) in the input menu. 

 

What’s next after you have specified the input type? 
 
If you chose an RTD or thermocouple input type, go to 19.6. 
If you chose a linear input type go to 19.7. 
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19.6 Configuring Input Parameters for RTD and Thermocouple  
          Input Types 

19.6.1 Applying a Bias to the Temperature Input 

When using an RTD or thermocouple input, you can specify the bias (if any) to be 
applied to the input.     Applying bias allows you to compensate for any difference 
between sensor reading and the point to be measured.  The displayed process 
variable and setpoint will be offset by the value entered here.  (You can leave the 
input bias set to the default zero when setting up the controller.  If the need for bias 
becomes evident later, you can adjust the configured value.) 

Parameter Name: Input Bias 

Name as Displayed:     

When Displayed: always 

Range: –1000 to 1000 F 
–556 to 556 C and K 

Default: 0 

Description: Applying bias allows you to compensate for any difference (plus 
or minus) between sensor reading and the location to be 
measured.  The displayed process variable and setpoint will be 
offset by the value entered here.   

Effect on Other 
Parameters: 

No effect on other configuration parameters.  However, the bias 
will be applied to the displayed PV and the active setpoint. 
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19.6.2 Specifying the Setpoint Range When a Temperature Input is 
Used 

Configure the setpoint range, that is, the range of setpoint values the operator can 
enter using an optional display board.  This range will also apply to recipe setpoints, 
that is, to soak levels specified using the ramp/soak parameters.  

The Setpoint Low Limit and the Setpoint High Limit must not be set to the same 
value.   

Parameter Name: Setpoint Low Limit 

Name as Displayed:   .  

When Displayed: always 

Range: sensor low limit to sensor high limit 

Default: –328  (See Note 1 below.) 

Description: This is the lowest value that can be entered by the operator as a 
setpoint (before bias is applied).  This limit is also applies to 
ramp/soak recipe soak levels. 

 

Parameter Name: Setpoint High Limit 

Name as Displayed:   .  

When Displayed: always 

Range sensor low limit to sensor high limit 

Default: 1400  (See Note 1 below.) 

Description: This is the highest value that can be entered by the operator as 
a setpoint (before bias is applied).  This limit is also applies to 
ramp/soak recipe soak levels. 

Note 1:  The default value depends on the input type.  The default value shown 
applies when the input type is a J thermocouple.   

19.6.3 Applying an Input Filter When a Temperature Input is Used 

You can configure the controller to average the input over a period of 0.1 to 10 
seconds before it uses the input value in the control algorithm calculations.  

Parameter Name: Input Filter  

Name as Displayed:     

When Displayed: always 

Range: 0.1 to 10.0 seconds 

Default: 0.5 

Description: Used to specify the time period over which the controller will 
average the input before using the input in the control algorithm. 
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If you are using an RTD or thermocouple input type, you have 
finished configuration of input parameters.   The remainder of this 
chapter does not apply to your application.  
 
Go to Chapter 20 – Display Parameters. 
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19.7 Configuring Input Parameters for Linear Inputs 

19.7.1 Applying a Bias to the Linear Input 

When using a linear input, you can specify the bias (if any) to be applied to the input.     
Applying bias allows you to compensate for any difference between sensor reading 
and the point to be measured.  The displayed process variable and setpoint will be 
offset by the value entered here.  

Parameter Name: Input Bias 

Name as Displayed:     

When Displayed: always 

Range: –1000 to 1000 (See Note 1 below.) 

Default: 0 

Description: Applying bias allows you to compensate for any difference (plus 
or minus) between sensor reading and the location to be 
measured.  The displayed process variable and setpoint will be 
offset by the value entered here.   

Effect on Other 
Parameters: 

No effect on other configuration parameters.  However, the bias 
will be applied to the displayed PV and the active setpoint. 

Note 1:  The range is reduced if a linear input is used and the value of the      
(display) menu    .  (decimal position) parameter is not 0 (zero).  See 18.3.2 for 
more information about the effect of a linear input on numerical ranges. 
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19.7.2 Scaling the Linear Input 

When a linear input is used, the controller will scale the input based on the range you 
specify.  That means that you enter the PV to be represented by the input when the 
input signal is at its lowest level, and the PV to be represented by the input at its 
highest level.  The controller divides that range into equal segments to interpret a 
particular input signal.  

For example, suppose you use a 4 to 20 mA input to represent a PV that ranges from 
0 to 170 F.  You can configure the Linear Input Scaling Low Limit as 0 and the 
Linear Input Scaling High Limit as 170 F.  The controller will then be able to 
calculate that a one mA change in the linear input means that the PV has changed 
10 F.  A 0.1 mA change in the input represents a 1 F change in the PV. 

The Linear Input Scaling Low Limit and the Linear Input Scaling High Limit must not 
be set to the same value.   

Parameter Name: Linear Input Scaling Low Limit  

Name as Displayed:    . 

When Displayed: only when a linear input type has been selected 

Range: –1999 to 9999 (See Note 1 below.) 

Default: –1999 

Description: Used to specify the PV represented by the lowest possible linear 
input signal. 

Effect on Other 
Parameters: 

Limits the valid values for the control menu’s deadband and 
hysteresis parameters applied to on/off outputs, as well as for 
other parameters.  Determines the value displayed for the 
calibration menu’s      (calibration low) parameter.  

 

Parameter Name: Linear Input Scaling High Limit 

Name as Displayed:    . 

When Displayed: only when a linear input type has been selected 

Range: –1999 to 9999  (See Note 1 below.) 

Default: 9999 

Description: Used to specify the PV represented by the highest possible 
linear input signal. 

Effect on Other 
Parameters: 

Limits the valid values for the control menu’s deadband and 
hysteresis parameters applied to on/off outputs, as well as for 
other parameters.  Determines the value displayed for the 
calibration menu’s      (calibration high parameter). 

Note 1:  The range is reduced if a linear input is used and the value of the      
(display) menu    .  (decimal position) parameter is not 0 (zero).  See 18.3.2 for 
more information about the effect of a linear input on numerical ranges. 
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19.7.3 Specifying the Setpoint Range When a Linear Input Is Used 

The setpoint range, that is, the range of setpoint values the operator can enter using 
an optional display board.  This range will also apply to recipe setpoints, that is, to 
soak levels specified using the ramp/soak parameters.  

The Setpoint Low Limit and the Setpoint High Limit must not be set to the same 
value.   

Parameter Name:  Setpoint Low Limit 

Name as Displayed:   .  

When Displayed: always 

Range: limited by the scaling defined for the input using the    .  
and    .  parameters in the     (input) menu 

Default: depends on input type 

Description: This is the lowest value that can be entered as a setpoint (before 
bias is applied). 

 

Parameter Name: Setpoint High Limit 

Name as Displayed:   .  

When Displayed: always 

Range limited by the scaling defined for the input using the    .  

and    .  parameters in the     (input) menu 

Default: depends on input type 

Description: This is the highest value that can be entered as a setpoint 
(before bias is applied). 

 

19.7.4 Applying an Input Filter When a Linear Input is Used 

You can configure the controller to average the input over a period of 0.1 to 10 
seconds before it uses the input value in the control algorithm calculations.  

Parameter Name: Input Filter  

Name as Displayed:     

When Displayed: always 

Range: 0.1 to 10.0 seconds 

Default: 0.5 

Description: Used to specify the time period over which the controller will 
average the input before using the input in the control algorithm. 
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20. Display Parameters – Required  

20.1 Introduction 

The      (display) menu is shown in the table below.  Descriptions of the 
individual parameters are later in the subsection.   

This menu is available only when the security access level is set to 
    (configuration) or      (factory).38 

Item Parameter Name When Displayed 

   .  Decimal Position39 always 

 .    Display Filter always 

     Unit of Measure40 for RTD and thermocouple inputs only 

     Setpoint Display Blanking always 

 

The process of configuring the display parameters is shown on the following page. 

                                                      

38 The access level in all new controller boards is set to      at the factory.  If you cannot see the 
display menu, the access level has been changed to a more restrictive level.  Instructions for changing 
the access level are in Section 30. 

39 Even though not all controllers are connected to an optional display board, you must configure the 
appropriate decimal position parameter (or accept the default) because the controller uses this parameter 
value to determine how many decimal places to store for the PV and SP values. 

40 The controller uses this unit of measure internally and for external communication. 
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Which display parameters apply to your application?  
 
If you chose an RTD or thermocouple input type, go to 20.2. 
If you chose a linear input type go to 20.3. 
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20.2 Configuring Display Parameters for RTD and  
          Thermocouple Input Types  

20.2.1 Choosing the Decimal Position When a Temperature Input Is 
Used 

The decimal point location applies to all controllers, even if no optional display board 
is used.  Even if the controller has no display, you must configure the decimal 
position parameter (or accept the default) because the controller uses this parameter 
value to determine how many decimal places to store for the PV and SV values.  

The only exception is when the input type is   .  (100 ohm compressed RTD with 

decimal support).  In this case, the decimal position is always 1, and the    .  
parameter is not displayed. 

The decimal position may change when you change the input type; see 18.3.3. 

Parameter Name: Decimal Position 

Name as Displayed:    . 

When Displayed: always (unless the input type is   . ) 

Choices: 0 and 1 

Default: 0 

Description: In the case of a controller using a temperature input, this 
parameter is used to choose the maximum quantity of digits to 
the right of the decimal point on the display, and in the PV and 
SV values used in the controller’s calculations.  No decimal 
position will be displayed if necessary to accommodate the four-
character display. 

20.2.2 Specifying the Display Filter When a Temperature Input Is 
Used 

Unlike the input filter, the value entered for the display filter has no effect on control.  
The input filter slows the rate at which the displayed PV is changed.  The display filter 
is generally used when at least one decimal place is displayed.  

Parameter Name: Display Filter 

Name as Displayed:  .   

When Displayed: always 

Range: 0.1 to 10.0 seconds (See Note 1 below.) 

Default: 0.1 

Description: Used to specify the minimum time period between changes of 
the displayed PV value.   

Note 1:  The range of valid values for this parameter always includes tenths values, 
regardless of the    .  (decimal position) setting. 
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20.2.3 Choosing the Unit of Measure When a Temperature Input Is 
Used 

The unit of measure applies to all controllers.  The unit of measure specified here is 
used by the controller for internal operations and external communication. 

Parameter Name: Unit of Measure 

Name as Displayed:     

When Displayed: only when an RTD or thermocouple input type has been 
selected 

Choices:   Fahrenheit 
  Celsius 

    Kelvin 

Default: Fahrenheit  

Description: Used to choose the unit of measure used by the controller as it 
interprets the input and performs output calculations. 

 

20.2.4 Blanking the Display of the Setpoint When a Temperature 
Input Is  
                 Used 

If you do not want the setpoint to be displayed all the time (while the controller is 
operating normally), then use the Setpoint Display Blanking parameter to specify the 
length of time the setpoint should be displayed before being hidden (“blanked”).  The 
setpoint display will remain blank until any key is pressed.  Pressing any key will 
cause the controller to display the setpoint again.  The setpoint will remain on display 
until the period specified here has elapsed.  

Parameter Name: Setpoint Display Blanking 

Name as Displayed:     

When Displayed: always 

Range:     off 
10 to 9999 seconds 

Default: off 

Description: Used to specify the number of seconds the setpoint should be 
displayed before the display of the setpoint goes blank. 

 

 

If you are using an RTD or thermocouple input type, you have 
finished configuration of display parameters.  The remainder of 
this chapter does not apply to your application.  
 
Go to Chapter 21 – Output Parameters. 
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20.3 Configuring Display Parameters for Linear Input Types 

20.3.1 Choosing the Decimal Position When a Linear Input Is Used 

The decimal point location applies to all 2C and 4C controllers.  You must configure 
the decimal position parameter (or accept the default) because the controller uses 
this parameter value to determine how many decimal places to store for the PV and 
SV values.    

The decimal position may change when you change the input type; see 18.3.3. 

Parameter Name: Decimal Position 

Name as Displayed:    . 

When Displayed: always 

Choices: 0, 1, 2, 3 

Default: 0 

Description: In the case of a controller using a linear input, this parameter is 
used to choose the quantity of digits always displayed to the 
right of the decimal point on the display, and in the PV and SV 
values used in the controller’s calculations.  If the controller uses 
a linear input and the    .  parameter is not set to 0 (zero), 
the number of decimal places specified is always imposed on 
the parameter’s value.  This has the effect of reducing the range 
of valid values for many parameters when a linear input is used.  
See 18.3.2 for information about this effect of a linear input on 
parameter ranges when a non-zero decimal position is used. 

 

20.3.2 Specifying the Display Filter When a Linear Input Is Used 

Unlike the input filter, the value entered for the display filter has no effect on control.  
The input filter slows the rate at which the displayed PV is changed.  The display filter 
is generally used when at least one decimal place is displayed.  

Parameter Name: Display Filter 

Name as Displayed:  .   

When Displayed: always 

Range: 0.1 to 10.0 seconds (See Note 1 below.) 

Default: 0.1 

Description: Used to specify the minimum time period between changes of 
the displayed PV value.   

Note 1:  The range of valid values for this parameter always includes tenths values, 
regardless of the    .  (decimal position) setting. 
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20.3.3 Blanking the Display of the Setpoint When a Linear Input Is 
Used 

If you do not want the setpoint to be displayed all the time (while the controller is 
operating normally), then use the Setpoint Display Blanking parameter to specify the 
length of time the setpoint should be displayed before being hidden (“blanked”).  The 
setpoint display will remain blank until any key is pressed.  Pressing any key will 
cause the controller to display the setpoint again.  The setpoint will remain on display 
until the period specified here has elapsed.  

Parameter Name: Setpoint Display Blanking 

Name as Displayed:     

When Displayed: always 

Range:     off 
10 to 9999 seconds 

Default: off 

Description: Used to specify the number of seconds the setpoint should be 
displayed before the display of the setpoint goes blank. 
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21. Output Parameters – Required 

21.1 Introduction 
The 2C controller uses two standard hardware outputs per zone.  The 4C controller 
uses one or two standard hardware outputs per zone.  One or more logical output is 
mapped to each of these hardware outputs.  (See 2.6 for information about the 
standard hardware outputs associated with the logical outputs configured here.) 

The way that these standard hardware outputs are used is determined by the way 
you configure logical output(s) associated with each hardware output. 

Logical outputs are configured using the parameters in the      (output) menu 
(shown in the table below).   

The output menu is available only when the security access level is set to 
    (configuration) or      (factory).41 

Item Parameter Name When Displayed 

  .   Output 1 Type always 

  .   Output 1 Action only if Output 1 Type is On/Off or PID 

  .   Output 1 Cycle Time 

  .   Output 1 Low Limit  

  .   Output 1 High Limit 

only if Output 1 Type is PID 

  .   Output 1 Alarm Action 

  .   Output 1 Alarm Operation  

  .   Output 1 Alarm Delay 

  .   Output 1 Alarm Inhibit  

  .   Output 1 Alarm Setpoint 

only if Output 1 Type is Alarm 

  .   Output 2 Type always  

  .   Output 2 Action only if Output 2 Type is On/Off or PID 

  .   Output 2 Cycle Time only if Output 2 Type is PID 

                                                      

41 The access level in all new 2C and 4C boards is set to      at the factory.  If you cannot see the 
output menu, the access level has been changed to a more restrictive level.  Instructions for changing the 
access level are in Section 30. 
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Item Parameter Name When Displayed 

  .   Output 2 Low Limit  

  .   Output 2 High Limit 

  .   Output 2 Alarm Action 

  .   Output 2 Alarm Operation  

  .   Output 2 Alarm Delay 

  .   Output 2 Alarm Inhibit  

  .   Output 2 Alarm Setpoint 

only if Output 2 Type is Alarm 

The process of configuring the output parameters is shown below. 
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21.2 Specifying the Output Type 
The first step in configuring use of the standard outputs is specifying the output type 
(function).   

Parameter Name: Output 1 Type and Output 2 Type42 

Name as Displayed:   .   a n d    .  

When Displayed: always 

Choices:      disabled 
     alarm  
     On/Off 
     PID 

Default: PID 

Description: Used to choose the function of each standard output. 

Effect on Other 
Parameters: 

The choice made here for output 1 or output 2 determines what 
other parameters are displayed in the output menu for output 1 
or output 2. 

The output type selected also affects the parameters displayed 
in the control menu. 

If an output is disabled or used for alarm annunciation, then that 
output’s failsafe output percentage parameter will not be 
displayed in the supervisor menu. 

 

 

 

What’s next after specifying the output type?  
 
If you chose OFF for Output 1, specify the type for Output 2. 
 
If you chose on/off for an output, go to 21.3. 
If you chose PID control for an output, go to 21.4 
If you chose alarm for an output, go to 21.5. 

 

                                                      

42 All the output 1 parameters applicable to the type selected are displayed before the Output 2 type 
parameter is displayed. 
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21.3 Choosing the Output Action for On/Off Control 
When the output type is set to on/off, only one other output parameter must be 
configured: output action.   

When an output is used for on/off control, it can be either direct or reverse acting.   

 When the on/off output action is configured for reverse action (heating 
applications), the controller will apply 100% output if the process temperature is 
below the setpoint and 0% if the PV is at the SV.   

 When the on/off output action is configured for direct action (cooling 
applications), the controller will apply 100% output if the process temperature is 
above the setpoint and 0% if the PV is at the SV. 

Parameter Name: Output 1 Action and Output 2 Action 

Name as Displayed:   .   and   .  

When Displayed: if output type is on/off or PID  

Choices:     direct 

   reverse 

Default: output 1: reverse 
output 2: direct 

Description: Used to specify whether the output will be direct-acting or 
reverse-acting. 

 

 

If you are using an on/off output, you have finished configuration 
of that output’s parameters.  The remainder of this chapter does 
not apply to on/off outputs.   
 
If only one output has been configured, go back to 21.2 to specify 
the type for the other output. 
 
If both outputs have been configured, go to Chapter 22 – Control 
Parameters.  
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21.4 Configuring Output Parameters for PID Control 

21.4.1 Choosing the Output Action for PID Control 

When an output is used for PID control, it can be either direct or reverse acting.   

 When the PID output action is configured for reverse action (heating 
applications), the proportional band is initially applied below the setpoint.   

 When the PID output action is configured for direct action (cooling applications), 
the proportional band is initially applied above the setpoint. 

Parameter Name: Output 1 Action and Output 2 Action 

Name as Displayed:   .   and   .  

When Displayed: if output type is on/off or PID  

Choices:     direct 

   reverse 

Default: output 1: reverse 
output 2: direct 

Description: Used to specify whether the output will be direct-acting or 
reverse-acting. 

 

21.4.2 Specifying the Cycle Time for PID Control 

When an output is used for PID control, you must specify a cycle time that is 
appropriate for your application.  The cycle time enables you to use a digital output to 
achieve PID control.  

For example, suppose the cycle time is set to 10 seconds and the control algorithm 
calculates that the output percentage should be 50%.  A normally open relay 
connected to the digital output of the controller will be closed for 5 seconds and open 
for 5 seconds in each ten second cycle.  If the output percentage changes to 70%, 
the relay will be closed for 7 seconds and open for 3 seconds in each ten second 
cycle.  

Parameter Name: Output 1 Cycle Time 1 and Output 2 Cycle Time 

Name as Displayed:   .   a n d    .  

When Displayed: if output type is PID 

Range: 1 to 120 seconds 

Default: 5 seconds 

Description: Used to specify the period of time in which the output completes 
an on-off cycle. 

 



Configuration Parameters– Output  

900M231U00A  Athena Controls, Inc. 21-7 

21.4.3 Specify the PID Output Range 

If the controlled field device should never be fully off and/or fully on, you can limit the 
range of the output when PID is used.  The range defined here affects both: 

 the control algorithm’s output when the controller is in normal (automatic) mode, 
and 

 the fixed output percentage the operator can enter when the controller is in 
manual mode. 

For example, suppose the lowest input the controlled device should receive is 30% of 
a discrete output’s cycle time, and the maximum input the controlled device should 
receive is 70% of the discrete output’s cycle time.  In this case you set the   .   

= 30 and the   .   = 70. 

The lowest percentage of the cycle time the digital output would be on is 30% of the 
cycle time, and the highest percentage of the cycle time the output is on is 70%.  If 
the cycle time configured with the   .   parameter is 10 seconds, then the output 
is never on for less than 3 seconds (30% of 10 seconds), even if the process variable 
requires no correction.  The output is never on for more than 7 seconds (70% of 10 
seconds). 

The limits apply to both normal (automatic) mode and manual mode.  In our example, 
the operator can never turn off the field device using the controller while the output 
limits are set to 30 and 70, regardless of whether the controller is in auto or manual 
mode. 

The lower and upper output limits should not be set to the same value. 

Parameter Name: Output 1 Low Limit and Output 2 Low Limit 

Name as Displayed:   .   a n d    .  

When Displayed: if output type is PID 

Range: 0 to 100 percent 

Default: 0 

Description: Used to specify the lowest percentage used for the output in 
both manual and normal (automatic) modes. 

Effect on Other 
Parameters: 

No effect on other configuration parameters.  However, it limits 
the allowable range for the fixed output percent in manual mode. 
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Parameter Name: Output 1 High Limit and Output 2 High Limit 

Name as Displayed:   .  a n d    .  

When Displayed: if output type is PID 

Range: 0 to 100 percent 

Default: 100 

Description: Used to specify the highest percentage used for the output in 
both manual and normal (automatic) modes. 

Effect on Other 
Parameters: 

No effect on other configuration parameters.  However, it limits 
the allowable range for the fixed output percent in manual mode. 

 

21.5 Configuring Output Parameters for Alarm Annunciation  

21.5.1 Choosing the Alarm Action 

The first step in configuring an output to be used for alarm annunciation is to choose 
the alarm action.  The choices are:  

     (off) – The alarm output will not be used. 

     (normal) – The output will go to the alarm state when the process 
value triggers the alarm and go out of the alarm state when the alarm 
condition has been cleared. 

     (latching) – Once the output goes to the alarm state, the output will  

remain in the alarm state until the operator presses the  key, even if the 
alarm condition has been cleared before the operator presses the key. 

 

Parameter Name: Output 1 Alarm Action and Output 2 Alarm Action 

Name as Displayed:   .   and   .  

When Displayed: if output type is alarm 

Choices:     off 
    normal 

    latching 

Default: off 

Description: Used to choose the function of the alarm output. 

Effect on Other 
Parameters: 

If off is chosen, then no other output alarm parameters are 
displayed. 
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21.5.2 Choosing the Alarm Operation 

The second step in configuring an output to be used for alarm annunciation is to 
choose the alarm operation.  The choices are: 

 process alarm – Activated when the process variable reaches the alarm value 
(alarm setpoint parameter value), independent of the PV’s relationship to the 
process setpoint.  A high process alarm activates at and above the alarm 
setpoint.  A low process alarm activates at and below the alarm setpoint.  For 
example, if you want an alarm to alert the operator when the PV goes up to 200, 
then configure the alarm as a high process alarm, and specify the alarm setpoint 
as 200. 

 deviation alarm – Activated when the process variable deviates from the 
process setpoint by the amount specified using the alarm value (alarm setpoint 
parameter value).  A high deviation alarm activates when the PV is above the 
process setpoint by the amount specified using the alarm value.  A low deviation 
alarm activates when the PV is below the process setpoint by the amount 
specified using the alarm value.  For example, if you want an alarm to alert the 
operator when the PV is 50 below the setpoint, then configure the alarm as a low 
deviation alarm, and specify the alarm value (using the alarm setpoint parameter) 
as 50. 

 inverse band alarm – Activated when the process value is within a specified 
band centered around the setpoint.  For example, if you want the alarm to alert 
the operator when the PV is 10 units (or less) above or below the process 
setpoint, then configure the alarm as an inverse band alarm, and specify 10 for 
the alarm setpoint parameter value. 

 normal band alarm – Activated when the process value is outside a specified 
band centered around the setpoint.  For example, if you want the alarm to alert 
the operator when the PV is 10 units (or more) above or below the process 
setpoint, then configure the alarm as a normal band alarm, and specify 10 for the 
alarm setpoint parameter value. 

Parameter Name: Output 1 Alarm Operation and Output 2 Alarm Operation 

Name as Displayed:   .   and   .  

When Displayed: if output type is alarm 

Choices:    .  low process alarm 
   .  high process alarm 
  .   inverse band 
   .  normal band 
  .   low deviation alarm 

  .   high deviation alarm 

Default: output 1: process low 
output 2: process high 

Description: Used to choose the alarm operation. 

Effect on Other 
Parameters: 

Determines how the value of the   .   or   .   (alarm 
setpoint) parameter is used. 
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21.5.3 Specifying the Alarm Delay – Optional 

If you specify an alarm delay, then when the controller detects an alarm condition, the 
alarm output will not be activated until the alarm delay time has passed.  Use the 
alarm delay to reduce nuisance alarms for transient conditions that are corrected 
without any operator action.   

Parameter Name: Output 1 Alarm Delay and Output 2 Alarm Delay  

Name as Displayed:   .   and   .  

When Displayed: if output type is alarm 

Range: 0 to 9999 seconds 

Default: 0 

Description: Used to specify the number of seconds the controller should wait 
before signaling an alarm condition. 

 

21.5.4 Inhibiting the Alarm– Optional 

You can configure an inhibit time for the alarm.  If you specify an alarm inhibit time, 
the controller will not activate the alarm output following power up until the alarm 
inhibit time has elapsed.  This is particularly useful for preventing activation of low 
alarms during startup (before the process has had time to reach operating 
temperature). 

Parameter Name: Output 1 Alarm Inhibit and Output 2 Alarm Inhibit 

Name as Displayed:   .   and   .  

When Displayed: if output type is alarm 

Range: 0 to 9999 seconds 

Default: 0 

Description: Used to specify the number of seconds the controller should wait 
after power up before signaling an alarm condition. 
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21.5.5 Specifying the Alarm Value (Setpoint) 

How the alarm setpoint value is used depends on the type of alarm. 

 process alarm – activated when process value reaches the value specified 
with the output alarm setpoint parameter 

 deviation alarm – activated when process value differs from the process 
setpoint by the value specified with the output alarm setpoint parameter 

 inverse band alarm – activated when the PV is inside a band centered 
around the setpoint; the width of the band on either side of the setpoint is 
specified with the output alarm setpoint parameter 

 normal band alarm – activated when the PV is outside a band centered 
around the setpoint; the width of the band on either side of the setpoint is 
specified with the output alarm setpoint parameter 

Parameter Name: Output 1 Alarm Setpoint and Output 2 Alarm Setpoint  
(See Note 2 below) 

Name as Displayed:   .   and   .  

When Displayed: if output type is alarm 

Range: RTD and thermocouple input types: sensor low limit to sensor 
high limit 
linear input types: limited by the scaling defined for the input 
using the    .  and    .  parameters in the     
(input) menu (See Note 1 below.) 

Default: process alarm: 77 
deviation, inverse band, normal band: 1728 

Description: Used to specify the alarm setpoint (process alarm), the alarm 
limit (deviation alarm), or the width of the alarm band on either 
side of the setpoint (inverse and normal band alarms) 

Note 1:  The range is reduced when a linear input is used and the value of the 
     (display) menu    .  (decimal position) parameter is not 0 (zero).  See 
18.3.2 for more information about the effect of a linear input on numerical ranges. 
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22. Control Parameters – Required If Outputs 
Are Used for Control 

22.1 Introduction 
The 2C and 4C boards all support both PID and on/off control.  Zones outputs can be 
configured for two different types of control.  For information about the types of 
applications that are suitable for each type of control, see 1.6.  

The parameters used to customize the control operation are in the      (control) 
menu. This menu is available only when the security access level is set to 
    (configuration) or      (factory).43  

If both outputs are configured for use with alarms or turned off (using the output 1 
type and output 2 type parameters), then the      (control) menu will not be 
displayed. 

                                                      

43 The access level in all new 2C and 4C boards is set to     at the factory.  If you cannot see the 
control menu, the access level has been changed to a more restrictive level.  Instructions for changing 
the access level are in Section 30. 
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Item Parameter Name When Displayed 

  .  Deadband for Output 1 only if output 1 type is on/off 

   .  Hysteresis for Output 1 only if output 1 type is on/off 

  .  Deadband for Output 2 only if output 2 type is on/off 

   .  Hysteresis for Output 2 only if output 2 type is on/off 

    Proportional Band 1 only if output 1 type is PID 

    Proportional Band 2 only if output 2 type is PID, and output 1 and 
output 2 are not both set to the same action 
(see Note 1) 

    Derivative (Rate) Action  only if output 1 or output 2 type is PID (see 
Note 2) 

     Offset (Manual Reset)  only if output 1 or output 2 type is PID (see 
Notes 2 and 3) 

    Integral Action (Auto Reset) only if output 1 or output 2 type is PID, and 

the value of      = 0 (see Notes 2 and 
3) 

Note 1:  If output 1 and output 2 are both set to PID direct action, or if both outputs 
are set to PID reverse action, then the controller applies the same proportional band 
to both outputs.  The   .  parameter is not needed, so it is not displayed when 
you step through the control menu. 
Note 2:  If both outputs are PID, then the values specified for    ,     , and 
    are applied to both outputs. 
Note 3:  The controller uses either a manual reset value or an integral action value, 
not both. 
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The process of configuring the control parameters is shown below. 

 

 

 

Which control parameters apply to your application?  
 
If you chose on/off for an output in Chapter 7, then go to 22.2. 
If you chose PID control for an output in Chapter 7, go to 22.3. 
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22.2 Configuring Control Parameters for On/Off Control 

22.2.1 Introduction 

On/off control has two states, fully off and fully on.  To prevent rapid cycling, the 
controllers allow you to configure a deadband and a hysteresis value as described in 
1.6.3.  

22.2.2 Specifying the Deadband for On/Off Control 

Parameter Name: Deadband for Output 1 and Deadband for Output 2  

Name as Displayed:   .  and   . 

When Displayed: if output type is on/off 

Range: RTD and thermocouple input types: negative sensor span to 
positive sensor span 
linear input types: –1999 to 9356 

Default: 1 

Description: If a deadband value is applied to an output, it has the effect of 
shifting the setpoint and the hysteresis for that output.  That is, 
the deadband for each output moves the “off” transition away 
from the setpoint, and pushes the “on” transition away by an 
equal amount. For a heating (reverse-acting) output, a positive 
deadband value moves the setpoint used by the controller below 
the displayed setpoint.  For a cooling (direct-acting) output, a 
positive deadband value moves the setpoint used by the 
controller above the setpoint displayed.  (A negative deadband 
value has the opposite effect.) For more information about the 
use of deadband, see 1.6.3.2. 
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22.2.3 Applying Hysteresis to On/Off Control 

Parameter Name: Hysteresis for Output 1 and Hysteresis for Output 2  

Name as Displayed:    .  and    . 

When Displayed: if input type is on/off 

Range: RTD and thermocouple input types: 0 to positive sensor span 
linear input types: 0 to 9356 

Default: 1 

Description: The hysteresis value represents a temperature value that the 
controller uses to move the “on” and “off” transitions away from 
the setpoint by an amount equal to half the configured hysteresis 
value. For more information about use of hysteresis, see 1.6.3.1. 

 

 

If you are configuring control parameters for an on/off output, you 
are finished configuring the control parameters that apply to that 
output.  The remainder of this chapter does not apply to on/off 
outputs.   
 
If both outputs will be used for control, but control parameters for 
only one output have been configured, configure the control 
parameters for the second output. 

 If you chose on/off for the second output, configure the 
deadband and hysteresis for the second output as 
described here in 22.2. 

 If you chose PID control for the other output, go to 22.3. 
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22.3 Configuring Control Parameters for PID Control 

22.3.1 Introduction  

When Proportional-Integral-Derivative (PID) control is used, the controller modulates 
output power by adjusting the output power percentage within a proportional band.  
Power is proportionally reduced as the process temperature gets closer to the 
setpoint temperature.  The integral action affects the output based on the duration of 
the process value’s variation from the setpoint, and the derivative action affects the 
output based on the rate of change of the process value.  

The values of the PID tuning parameters are automatically adjusted during the 
Autotune procedure (see 29.2).   

Unless you want to tune the controller manually as described in 29.3, do not alter the 
tuning parameters Proportional Band for Output 1, Proportional Band for Output 2, 
Derivative (Rate) Action, and Integral Action (Auto Reset).  If you enter a non-zero 
value for the manual offset, the controller will ignore it when you do Autotune.  The 
controller uses only one reset, either auto or manual.  

22.3.2 Specifying the Proportional Band for Manual Tuning of PID  
                 Control 

Parameter Name: Proportional Band for Output 1 and Proportional Band for 
Output 2  

Name as Displayed:   .  and   . 

When Displayed: if output 1 or output 2 type is PID; if both output 1 and output 2 
are direct acting or reverse acting, then only   .  is displayed 
and applied to both outputs. 

Range: RTD and thermocouple input types: 1 to sensor span 
linear input types: 1 to n, where n is the range between the 
values of the    .  and    .  parameters in the     
(input) menu.  (See Note 1 below.) 

Default: 100 

Description: Used to specify the width of the band above (direct-acting 
outputs) or below (reverse-acting outputs) the setpoint within 
which the controller will modulate the output as the process 
value approaches the setpoint. 

Note 1:  The range is reduced when a linear input is used and the value of the 
     (display) menu    .  (decimal position) parameter is not 0 (zero).  See 
18.3.2 for more information about the effect of a linear input on numerical ranges. 
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22.3.3 Specifying the Derivative (Rate) Action for Manual Tuning of 
PID  
                 Control 

Parameter Name: Derivative  

Name as Displayed:    

When Displayed: if output 1 or output 2 type is PID 

Range: 0.0 to 0.9, 1 to 2400 seconds (See Notes 1 and 2 below.) 

Default: 0.0 

Description: Used to specify the time period used by the derivative 
component of the control algorithm when analyzing load 
changes. 

Note 1:  The range is reduced when a linear input is used and the value of the 
     (display) menu    .  (decimal position) parameter is not 0 (zero).  See 
18.3.2 for more information about the effect of a linear input on numerical ranges. 

Note 2:  This parameter is a special case.  Even if the value of the      (display) 
menu    .  (decimal position) parameter is 2 or 3 (which is permitted when a 
linear input is used), the maximum number of decimal places applied to the PID 
derivative (rate) action is 1 (the tenths position). 

22.3.4 Specifying the Offset (Manual Reset) for Manual Tuning of 
PID  
                 Control 

Parameter Name: Offset (Manual Reset)  

Name as Displayed:     

When Displayed: if output 1 or output 2 type is PID 

Range: off, or –100 to 100 percent  (See Note 1 below.) 

Default: off 

Description: Used to specify a fixed amount that the proportional band will be 
offset up (positive) or down (negative).  The result is an increase 
or decrease of power applied at the setpoint to compensate for 
proportional control offset error.  
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22.3.5 Integral Action (Automatic Reset) Calculated Automatically  
                 During Autotune for PID Control  

This parameter is not used in manual tuning.  If you assign a non-zero value to the 
manual offset      parameter, then this parameter     will not be displayed. 

Parameter Name: Integral Action (Automatic Reset)  

Name as Displayed:    

When Displayed: if output 1 or output 2 type is PID 

Range: 0.0 to 0.9, 1 to 9600 seconds  (See Note 1 below.) 

Default: 0.0 

Description: Used by the Autotune operation to store the automatic reset 
value. 

Note 1:  This parameter is a special case.  Even if the value of the      (display) 
menu    .  (decimal position) parameter is 2 or 3 (which is permitted when a 
linear input is used), the maximum number of decimal places applied to the integral 
offset (automatic reset) action is 1 (the tenths position). 
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23. Alarm Parameters – Optional 

23.1 Introduction 
The 2C and 4C supports configuration of “logical alarms” that are mapped to 2C and 
4C hardware outputs in the default mappings for one- or two-active zone controllers 
(see 2.6).  The state of these logical alarms can be viewed on the Multi-Comm 
display for a 2C or 4C zone. (Each “faceplate” in Multi-Comm contains two “virtual 
LEDs” that are associated with the logical alarms. These LEDs appear to light when a 
specific condition exists.   

Alarm configuration is done using the     (alarm) menu.  This menu is available 
only when the security access level is set to     (configuration) or      
(factory).44  

These logical alarms can be configured to be the same types of alarms as the alarms 
configured via the output menu.  In addition, the logical alarms configured here can 
be used to signal that recipe events have occurred. (Recipe events are defined using 
parameters in the ramp/soak menu; see Chapter 25.) 

Item Parameter Name When Displayed 

  .   Alarm 1 Action always 

  .   Alarm 1 Operation  if alarm 1 action is not off or event 

  .   Alarm 1 Delay if alarm 1 action is not off or event 

  .   Alarm 1 Inhibit  if alarm 1 action is not off or event 

  .   Alarm 1 Setpoint if alarm 1 action is not off or event 

  .   Alarm 2 Action always 

  .   Alarm 2 Operation  if alarm 2 action is not off or event 

  .   Alarm 2 Delay if alarm 2 action is not off or event 

  .   Alarm 2 Inhibit  if alarm 2 action is not off or event 

  .   Alarm 2 Setpoint if alarm 2 action is not off or event 

 

                                                      

44 The access level in all new 2C and 4C boards is set to      at the factory.  If you cannot see the 
alarm menu, the access level has been changed to a more restrictive level.  Instructions for changing the 
access level are in Section 30. 
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The process of configuring the alarm parameters is shown below. 
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23.2 Configuring Alarm Parameters 

23.2.1 Choosing the Alarm Action 

The first step in configuring an alarm is to choose the alarm action.  The choices are:  

     (off) – The alarm will not be used. 

     (normal) – The alarm will be on when the process value triggers the 
alarm and be turned off when the alarm condition has been cleared. 

     (latching) – Once the alarm is on, it will remain in the alarm state until 

the operator presses the  key, even if the alarm condition has cleared 
before the operator presses the key. 

      (event) – This special use of an alarm indicates that the controller 
has reached a particular point in a ramp/soak recipe.  Setting the alarm 
action to “event” reserves the alarm for use by a ramp/soak recipe.  
However, the specific recipe event(s) that will trigger the alarm are 
configured using the     (ramp/soak) menu as described in 25.4. 

 

Parameter Name: Alarm 1 Action and Alarm 2 Action45 

Name as Displayed:   .   and   .  

When Displayed: always 

Choices:     off 
    normal 
    latching 
    recipe event 

Default: off 

Description: Used to choose the function of the alarm. 

Effect on Other 
Parameters: 

If event is chosen, then no other alarm parameters are 
displayed, and the ramp event and soak event parameters as 
described in 25.4.are available for configuration. 

 

                                                      

45 All the alarm 1 parameters are displayed before the alarm 2 action parameter is displayed. 
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23.2.2 Choosing the Alarm Operation 

Unless the alarm will be used to signal ramp/soak recipe event, the second step in 
configuring an alarm is to choose the alarm operation.  The choices are: 

 process alarm – Activated when the process variable reaches the alarm value 
(alarm setpoint parameter value), independent of the PV’s relationship to the 
process setpoint.  A high process alarm activates at and above the alarm 
setpoint.  A low process alarm activates at and below the alarm setpoint.  For 
example, if you want an alarm to alert the operator when the PV goes up to 200, 
then configure the alarm as a high process alarm, and specify the alarm setpoint 
as 200. 

 deviation alarm – Activated when the process variable deviates from the 
process setpoint by the amount specified using the alarm value (alarm setpoint 
parameter value).  A high deviation alarm activates when the PV is above the 
process setpoint by the amount specified using the alarm value.  A low deviation 
alarm activates when the PV is below the process setpoint by the amount 
specified using the alarm value.  For example, if you want an alarm to alert the 
operator when the PV is 50 below the setpoint, then configure the alarm as a low 
deviation alarm, and specify the alarm value (using the alarm setpoint parameter) 
as 50. 

 inverse band alarm – Activated when the process value is within a specified 
band centered around the setpoint.  For example, if you want the alarm to alert 
the operator when the PV is 10 units (or less) above or below the process 
setpoint, then configure the alarm as an inverse band alarm, and specify 10 for 
the alarm setpoint parameter value. 

 normal band alarm – Activated when the process value is outside a specified 
band centered around the setpoint.  For example, if you want the alarm to alert 
the operator when the PV is 10 units (or more) above or below the process 
setpoint, then configure the alarm as a normal band alarm, and specify 10 for the 
alarm setpoint parameter value. 

Parameter Name: Alarm 1 Operation and Alarm 2 Operation 

Name as Displayed:   .   and   .  

When Displayed: if alarm action is not event 

Choices:    .  low process alarm 
   .  high process alarm 
  .   inverse band 
   .  normal band 
  .   low deviation alarm 

  .   high deviation alarm 

Default: alarm 1:  process high 
alarm 2:  process low 

Description: Used to choose the alarm operation. 

Effect on Other 
Parameters: 

Determines how the value of the   .   or   .   (alarm 
setpoint) parameter is used. 



Configuration Parameters – Alarm 

900M231U00A  Athena Controls, Inc. 23-5 

23.2.3 Specifying the Alarm Delay – Optional 

Unless the alarm will be used to signal ramp/soak recipe event, you can configure an 
alarm delay.  If you specify an alarm delay, then when the controller detects an alarm 
condition, the alarm will not be activated until the alarm delay time has passed.  Use 
the alarm delay to reduce nuisance alarms for transient conditions that are corrected 
without any operator action.   

Parameter Name: Alarm 1 Delay and Alarm 2 Delay  

Name as Displayed:   .   and   .  

When Displayed: if alarm action is not event 

Range: 0 to 9999 seconds 

Default: 0 

Description: Used to specify the number of seconds the controller should wait 
before signaling an alarm condition. 

 

23.2.4 Inhibiting the Alarm– Optional 

Unless the alarm will be used to signal a ramp/soak event, you can configure an 
inhibit time for the alarm.  If you specify an alarm inhibit time, the controller will not 
activate the alarm following power up until the alarm inhibit time has elapsed.  This is 
particularly useful for preventing activation of low alarms during startup (before the 
process has had time to reach operating temperature). 

Parameter Name: Alarm 1 Inhibit and Alarm 2 Alarm Inhibit  

Name as Displayed:   .   and   .  

When Displayed: if alarm action is not event 

Range: 0 to 9999 seconds 

Default: 0 

Description: Used to specify the number of seconds the controller should wait 
after power up before signaling an alarm condition. 
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23.2.5 Specifying the Alarm Value (Setpoint) 

How the alarm setpoint value is used depends on the type of alarm. 

 process alarm – activated when process value reaches the value specified 
with the alarm setpoint parameter 

 deviation alarm – activated when process value differs from the process 
setpoint by the value specified with the alarm setpoint parameter 

 inverse band alarm – activated when the PV is inside a band centered 
around the setpoint; the width of the band above and below the setpoint is 
specified with the alarm setpoint parameter  

 normal band alarm – activated when the PV is outside a band centered 
around the setpoint; the width of the band above and below the setpoint is 
specified with the alarm setpoint parameter 

 

Parameter Name: Alarm 1 Setpoint and Alarm 2 Setpoint 

Name as Displayed:   .   and   .  

When Displayed: if alarm action is not event 

Range: RTD and thermocouple input types:  sensor low limit to sensor 
high limit   
linear input types:  limited by the scaling defined for the input 
using the    .  and    .  parameters in the     
(input) menu (See Note 1 below.) 

Default: process alarm: 77 
deviation, inverse band, normal band: 1728 

Description: Used to specify the alarm setpoint (process alarm), the alarm 
limit (deviation alarm), or the width of the alarm band (inverse 
and normal band alarms) 

Note 1:  The range is reduced when a linear input is used and the value of the 
     (display) menu    .  (decimal position) parameter is not 0 (zero).  See 
18.3.2 for more information about the effect of a linear input on numerical ranges. 
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24. Autotune Damping Parameter – 
Recommended 

24.1 Introduction 

The 2C and 4C controllers support Autotune for PID control.  The      (Autotune 
damping) menu contains a single parameter used to control how aggressively the 
controller performs its Autotuning operation.   

The choices are: 

 low – provides fastest recovery, but with the possibility of overshoot 

 high – provides little or no overshoot, but with slower recovery 

 normal – a compromise between fast recovery and overshoot 

This menu is available only if at least one output is set to PID control.  In addition, for 
this menu to be accessible, the security access level is set to     , (user), 
     (configuration) or      (factory).46  

24.2 Configuring the Autotune Damping Parameter 
Parameter Name: Autotune Damping 

Name as Displayed:     

When Displayed: The tune menu is displayed only if at least one output type is 
PID.  If the menu is displayed, then this parameter is displayed. 

Choices:    low 
   n o r m a l  

   high 

Default: normal 

Description: Used to choose how aggressively the controller performs 
Autotune. 

Effect on Other 
Parameters: 

Affects the automatic tuning implemented using the parameters 
in the control menu.  

 

                                                      

46 The access level in all new 2C and 4C boards is set to     at the factory.  If you cannot see the 
Autotune damping menu, the access level has been changed to a more restrictive level.  Instructions for 
changing the access level are in Section 30. 
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25. Ramp/Soak Recipe Parameters – 
Optional  

25.1 Introduction 
The 4C controller can be configured to execute ramp/soak recipes on demand.  A 
recipe consists of up to eight segments.47  For each segment you can configure a 
unique ramp time, soak level (setpoint), and soak time.  As the controller executes a 
segment, the controller gradually (over the period of the ramp time) changes the 
currently used setpoint up or down until the setpoint reaches the soak level.  During 
the duration of the soak time, the controller maintains the setpoint at the specified 
soak level.  When the soak time has elapsed, the controller executes the next 
segment of the recipe.   

If at least one alarm was configured in the alarm menu (not the output menu) for 
“events”, then you can activate and deactivate an alarm based on the recipe reaching 
particular events in its execution, such as the start of a numbered soak period. 

If your process is not responsive enough to achieve the setpoint within the ramp time 
(or maintain the soak level for the entire soak time), you can use the recipe 
“holdback” parameter to “stop the clock” on the ramp time (and soak time) if the 
setpoint differs too much from the process value.  

Execution of a recipe can be started, paused, resumed, and terminated using an 
optional display board (or a Multi-Comm or MODBUS host). 

Alternatively, a controller can be configured to execute a single gradual ramp to 
setpoint at startup or on demand.  

If both outputs are configured for use with alarms or turned off (using the output type 
parameters), then the ramp/soak menu will not be displayed.  However, if at least one 
output is available for control, then the     (ramp/soak) menu will be available if 
the  security access level is set to      (user),     (configuration) or 
    (factory).48  

                                                      

47 The eight-segment recipes configured here are based on configuration values stored in the controller’s 
on-board database.  You can also use a computer running Multi-Comm or a MODBUS host to run recipes 
based on values stored in the computer.  Those recipes in the computer can have more than eight 
segments and can run on either a 4C or 2C (which has no on-board ramp-soak capability). 

48 The access level in all new 4C boards is set to     at the factory.  If you cannot see the 
ramp/soak menu, the access level has been changed to a more restrictive level.  Instructions for 
changing the access level are in Section 30. 
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Item Parameter Name When Displayed 

 .    Recipe Option always (assuming the menu is displayed 
because an output is available for control) 

 . . .  Single-Setpoint Ramp Time if recipe option is single-setpoint ramp 

   .  Recipe Holdback always 

   .  Recipe Termination State always 

   .  Recipe Recycle Number if recipe option is eight-segment r/s recipe 

  .   Resume from Power Failure if recipe option is eight-segment r/s recipe 

    Ramp Time 1 if recipe option is eight-segment r/s recipe 

    Ramp Event 1 if recipe option is eight-segment r/s recipe 
and at least one alarm has been reserved 
for use by the ramp/soak function49 

    Soak Level 1 if recipe option is eight-segment r/s recipe 

    Soak Time 1 if recipe option is eight-segment r/s recipe 

    Soak Event 1 if recipe option is eight-segment r/s recipe 
and at least one alarm has been reserved 
for use by the ramp/soak function 







 
 
 

 

    Ramp Time 8 if recipe option is eight-segment r/s recipe 

    Ramp Event 8 if recipe option is eight-segment r/s recipe 
and at least one alarm has been reserved 
for use by the ramp/soak function 

    Soak Level 8 if recipe option is eight-segment r/s recipe 

    Soak Time 8 if recipe option is eight-segment r/s recipe 

    Soak Event 8 if recipe option is eight-segment r/s recipe 
and at least one alarm has been reserved 
for use by the ramp/soak function 

 

                                                      

49 Use the alarm 1 action and/or alarm 2 action in the alarm menu to reserve alarm(s) for use by the 
ramp/soak function. 



Configuration Parameters – Ramp/Soak Recipe 

900M231U00A  Athena Controls, Inc. 25-3 

The process of configuring the ramp/soak parameters is shown below. 
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25.2 Specifying the Recipe Option 
Parameter Name: Recipe Option  

Name as Displayed:  .   

When Displayed: if at least one output type is on/off or PID 

Choices:      disabled 
 . .   eight-segment ramp/soak recipe 

 .  .  single-setpoint ramp 

Default: disabled 

Description: Used to choose the ramp/soak function (if any) to be used. 

Effect on Other 
Parameters: 

The choice made here affects what other parameters are 
displayed in the ramp/soak menu. 

 

 

What’s next after specifying the recipe option? 
 
If you chose “disabled”, go to Chapter 26 to configure the 
Supervisor menu parameters. 
If you chose “single-setpoint ramp”, go to 25.3. 
If you chose “eight-segment ramp/soak recipe, go to 25.4. 
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25.3 Configuring Single-Setpoint Ramp Parameters 

25.3.1 Specifying the Ramp Time for a Single-Setpoint Ramp 

Parameter Name: Single-Setpoint Ramp Time   

Name as Displayed:     

When Displayed: if the recipe option is single-setpoint ramp 

Range: 1 to 9999 minutes 

Default: 1 

Description: Used to specify the time period over which the setpoint will be 
ramped at start up from the starting process value to the 
configured setpoint. 

25.3.2 Specifying the Optional Recipe Holdback for a Single 
Setpoint Ramp 

Parameter Name: Recipe Holdback  

Name as Displayed:    . 

When Displayed: always 

Range: thermocouple and RTD input types: 
off 
0.1 to 100 F 
0.1 to 55.6 C or K 

linear input types: 
off 
1 to 100 (See Note 1 below.) 

Default: 10 

Description: Used to specify the maximum number of units that the controller 
will allow the setpoint to differ from the process value before 
“stopping the clock” on the ramp time.  The controller will “hold 
back” the SV until the PV differs from the SV by no more than 
the holdback value.   

Effect on Other 
Parameters: 

When a holdback has been configured, the single-setpoint ramp 
time is used as a minimum ramp time. 

Note 1:  The range is reduced when a linear input is used and the value of the 
     (display) menu    .  (decimal position) parameter is not 0 (zero).  See 
18.3.2 for more information about the effect of a linear input on numerical ranges. 
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25.3.3 Specifying What Happens at the Conclusion of the Single-
Setpoint Ramp Time 

Parameter Name: Termination State  

Name as Displayed:    . 

When Displayed: always 

Choices:      normal mode using default setpoint (setpoint  
                          displayed on optional display board) 
     normal mode using last setpoint reached  

     put controller in standby mode 

Default: put controller in standby mode 

Description: Used to specify what happens at the conclusion of the ramp 
time.   

Effect on Other 
Parameters: 

No effect on other configuration parameters.  Does affect 
setpoint and controller mode of operation.  Applied only if the 
ramp is allowed to run to completion.  If the operator terminates 
the ramp up to setpoint by changing the controller mode, the 
setpoint used will be the setpoint in effect when the operator 
changed the mode. 

 

 

If you are using the single-setpoint ramp option, you are finished 
configuring the recipe parameters.  The remainder of this chapter 
does not apply to the single-setpoint ramp option. 
 
Go to Chapter 26 – Supervisor Parameters. 
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25.4 Configuring Multi-Step Ramp/Soak Parameters 

25.4.1 Introduction 

When the eight-segment ramp/soak recipe option has been selected, several 
parameters can be configured that apply to the entire recipe.  These include: 

 recipe holdback that prevents the setpoint from getting too far ahead of the 
process value 

 termination state that determines what happens when execution of the recipe has 
been completed 

 recipe recycle number used to specify the number of additional times the recipe 
should be executed once started; this can also be use to set the recipe for 
continuous execution 

 resume from power failure parameter that controls whether execution of a recipe 
is resumed after a power failure 

After these parameters that apply to the entire recipe have been configured, you 
configure up to eight individual segments.50  Each consists of a ramp time, a soak 
level (setpoint) and a soak time.  In addition, if at least one logical alarm has been 
reserved for recipe event annunciation, you can specify that an available alarm will 
go on or off when a ramp time or soak time starts. 

The following diagram shows the first few segments of a recipe and the configuration 
used to implement the segments. 

 

                                                      

50 To configure fewer than eight segments, leave the values of all parameters associated with the un-
needed segments set to OFF or zero. 
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25.4.2 Parameters That Apply to the Entire Multi-Step Ramp/Soak 
Recipe 

25.4.2.1 Specifying the Optional Recipe Holdback 

Parameter Name: Recipe Holdback  

Name as Displayed:    . 

When Displayed: always 

Range: thermocouple and RTD input types: 
off 
0.1 to 100 F 
0.1 to 55.6 C or K 

linear input types: 
off 
1 to 100 (See Note 1 below.) 

Default: 10 

Description: Used to specify the maximum number of units that the controller 
will allow the setpoint to differ from the process value before 
“stopping the clock” on the ramp time or soak time. The 
controller will “hold back” the SV until the PV differs from the SV 
by no more than the holdback value.   

Effect on Other 
Parameters: 

When a holdback has been configured, the ramp times and soak 
times are used as minimum times. 

Note 1:  The range is reduced when a linear input is used and the value of the 
     (display) menu    .  (decimal position) parameter is not 0 (zero).  See 
18.3.2 for more information about the effect of a linear input on numerical ranges. 

25.4.2.2 Specifying What Happens at the Conclusion of the Multi-Step 
Recipe Execution 

Parameter Name: Termination State  

Name as Displayed:    . 

When Displayed: always 

Choices:      normal mode using default setpoint (setpoint  
                          displayed on optional display board) 
     normal mode using last setpoint reached in the  
                          recipe 
     put controller in standby mode 

Default: put controller in standby mode 

Description: Used to specify what happens at the conclusion of the ramp 
time.   

Effect on Other 
Parameters: 

No effect on other configuration parameters.  Does affect 
setpoint and controller mode of operation.  Applied only if the 
recipe runs to completion.  If the operator terminates the recipe 
execution by changing the controller mode, the setpoint used will 
be the setpoint in effect when the operator changed the mode.  
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25.4.2.3 Specifying the Number of Additional Times the Multi-Step 
Recipe Will Repeat Once Started 

Parameter Name: Recipe Recycle Number  

Name as Displayed:    . 

When Displayed: if the recipe option is eight-segment r/s recipe 

Range: 0 to 99  
     continuous (after the recipe has been started by 
an operator; recipe execution does not start automatically at 
power up) 

Default: 0 

Description: Used to specify the number of additional times the recipe will be 
executed once started.  If set to zero, the recipe will execute 
once each time the operator starts it.  If set to 1, the recipe will 
execute twice.  If set to 2, the recipe will execute three times, 
etc. 

 

25.4.2.4 Specifying What Will Happen to the Multi-Step Recipe After a 
Power Failure 

Parameter Name: Resume from Power Failure  

Name as Displayed:   .  

When Displayed: if the recipe option is eight-segment r/s recipe 

Choices:     off 

   on 

Default: off 

Description: Used to indicate whether the recipe execution should resume 
after a power failure.  If this parameter is set to   , then when 
power is restored, execution of the recipe will resume at the 
point reached before the power failure.  If this parameter is set to 
   , execution of the recipe will not be resumed when power 
is restored.  If the operator runs the recipe later, execution will 
start with segment 1. 
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25.4.3 Configuring Individual Recipe Segments 

25.4.3.1 Specifying the Ramp Time for Each Step of a Multi-Step Recipe 

Parameter Name: Ramp Time 1, Ramp Time 2, etc. through Ramp Time 8  

Name as Displayed:    ,      through    

When Displayed: if the recipe option is eight-segment r/s recipe 

Range: 0 to 9999 minutes 

Default: 0 

Description: Used to specify the length of the ramp time for each segment.  
Each segment can use a unique ramp time. 

Effect on Other 
Parameters: 

No effect on other configuration parameters.  Does affect the 
setpoint used by the controller. 

25.4.3.2 Linking a Ramp Period to an Alarm 

Parameter Name: Ramp Event 1, Ramp Event 2 etc. through Ramp Event 8 

Name as Displayed:    ,      through    

When Displayed: if the recipe option is eight-segment r/s recipe, and at least one 
alarm is reserved for recipe events using the     (alarm) 
menu 

Choices:       disabled 
  .    alarm 1 on if alarm 1 is reserved for recipe use 
  .    alarm 1 off if alarm 1 is reserved for recipe use 
  .    alarm 2 on if alarm 2 is reserved for recipe use 

  .    alarm 2 off if alarm 2 is reserved for recipe use 

Default: disabled 

Description: Used to link the chosen alarm action with the start of the ramp 
time with the same segment number. 

25.4.3.3 Specifying the Setpoint for Each Soak in a Multi-Step Recipe 

Parameter Name: Soak Level 1, Soak Level 2 etc. through Soak Level 8   

Name as Displayed:    ,      through    

When Displayed: if the recipe option is eight-segment r/s recipe 

Range:    .  to    .  (setpoint low limit to setpoint high limit 
from input menu)  (See Note 1 below.) 

Default: 77 

Description: Used to specify the setpoint for the soak for each segment.  
Each segment can use a unique soak level.  

Effect on Other 
Parameters: 

No effect on other configuration parameters.  Does affect the 
setpoint used by the controller. 

Note 1:  The range is reduced if the value of the      (display) menu    .  
(decimal position) parameter is not 0 (zero).  See 18.3.2 for more information about 
the effect of a linear input on numerical ranges. 
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25.4.3.4 Specifying the Length of Each Soak in a Multi-Step Recipe 

Parameter Name: Soak Time 1, Soak Time 2 through Soak Time 8  

Name as Displayed:    ,      through    

When Displayed: if the recipe option is eight-segment r/s recipe 

Range: 0 to 9999 minutes 

Default: 0 

Description: Used to specify the length of the soak time for each segment.  
Each segment can use a unique soak time. 

25.4.3.5 Linking a Soak Period to an Alarm 

Parameter Name: Soak Event 1, Soak Event 2 etc. through Soak Event 8  

Name as Displayed:    ,      through      

When Displayed: if the recipe option is eight-segment r/s recipe, and at least one 
alarm is reserved for recipe use using the     (alarm) menu 

Choices:       disabled 
  .    alarm 1 on if alarm 1 is reserved for recipe use 

  .    alarm 1 off if alarm 1 is reserved for recipe use 

  .    alarm 2 on if alarm 2 is reserved for recipe use 

  .    alarm 2 off if alarm 2 is reserved for recipe use 

Default: disabled 

Description: Used to link the chosen alarm action with the start of the soak 
time with the same segment number. 
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26. Supervisor Parameters – Recommended 

26.1 Introduction 

You can use the      (supervisor) menu to specify the output percentages to be 
used if the controller detects a problem with the process input (failsafe values), and 
the length of the time period during which the input should change in response to 
output action if the input is working normally (loop break time). 

You can also use this menu to see the highest and lowest process value received by 
the controller since the controller was powered up.   

The supervisor menu can also be used to set the values of all the configuration 
parameters back to their factory defaults.  The calibration of the controller will not be 
affected when the defaults are set back to their factory defaults. 

The supervisor menu is available only when the security access level is set to 
     (configuration) or      (factory).51  

Item Parameter Name When Displayed 

  .   Output 1 Failsafe Output 
Percentage 

if output 1 type is PID or on/off 

  .   Output 2 Failsafe Output 
Percentage 

if output 2 type is PID or on/off 

 .  .  Loop Break Time always 

  .   Highest Reading always 

  .   Lowest Reading always 

  .   Load Default Parameter Values always 

     Zone Count always 

                                                      

51 The access level in all new 2C and 4C boards is set to      at the factory.  If you cannot see the 
supervisor menu, the access level has been changed to a more restrictive level.  Instructions for 
changing the access level are in Section 30. 
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26.2 Specifying What Happens When an Input Is Bad 
The failsafe output percentages are used when the controller detects a problem with 
the input: open sensor, reversed sensor, or loop break time exceeded.  You cannot 
rely on the controller using these output percentages if the controller’s internal 
circuitry fails. 

Parameter Name: Output 1 Failsafe Output Percentage and Output 2 Failsafe 
Output Percentage  

Name as Displayed:   .   and   .  

When Displayed: if output type is PID or on/off 

Range: 0 to 100%  (output high limits   .   and   .   are 
ignored when the controller is in the failsafe state) 

Default: 0 

Description: Used to specify the fixed output percentage the controller will 
use if it detects a problem with the input. 

 

26.3 Defining the Loop Break Time 
The loop break time parameter is used to specify the length of the time period during 
which the input should change in response to output action if the input is working 
normally.  The controller will use this loop break time as a criterion for going into 
failsafe state and sending the outputs to the failsafe output percentages.  

Parameter Name: Loop Break Time  

Name as Displayed:  .  . 

When Displayed: always 

Range:    , 4 to 9600 seconds 

Default: off 

Description: Used to specify the time period during which the input should 
change in response to output action if the input sensor is 
working correctly. 
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26.4 Viewing the Highest and Lowest Process Value Received  
          Since Last Reset 

The highest and lowest process values received since the last reset are read-only 
values.  To reset the values, press the  or  key. 

Parameter Name: Highest Reading and Lowest Reading  

Name as Displayed:   .   and   .  

When Displayed: always 

 

Range: 

RTD and thermocouple input types:  sensor low limit to sensor 
high limit 
linear input types:  limited by the scaling defined for the input 
using the    .  and    .  parameters in the     
(input) menu 

Default: highest reading: –3566 
lowest reading: 18030 

Description: Used to view read-only values that are the highest and lowest 
process values received by the controller since the values were 
reset. 

26.5 Resetting All Parameters to the Defaults 
Using this function returns all configuration parameter values to their defaults.  

Parameter Name: Load Default Parameter Values 

Name as Displayed:   .  

When Displayed: always 

 
 

 

    loads all the defaults 
   does not load the defaults 
Beware!  If you press the  or  key while      is on 
display, regardless of whether it is alternating with    or 
   , the default values will be written to all configuration 
parameters.  The display will show      on the top line and 
     o n  the lower line.  After a second, the display will 
change to          .  At this point, all the parameters 

have been set back to the defaults.  Press the  (mode/enter) 

or  (menu access) key to clear the           
display and to begin to reconfigure the controller. 

Default: n/a 

Description: Used to reset all configuration parameters to their default values. 

Effect on Other 
Parameters: 

Resets all configuration parameters to their default values. (The 
calibration of the controller will not be affected when the defaults 
are set back to their factory defaults.) 
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26.6 Specifying the Number of Active Zones 
Parameter Name: Zone Count 

Name as Displayed:     

When Displayed: always 

Range: 1 to 4 

Default: maximum 

Description: Used to specify the number of zones the controller board will 
monitor and control. 
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27. Calibration Function – Not Required for 
Configuration 

27.1 Introduction  

The     (calibration) menu does not contain configuration parameters.  Instead it 
is used to display the values for which a simulated input should be applied to the 
controller input terminals during calibration of the zero offset (    ) and the span 
adjustment (    ).  It is also used to initiate the calibration operation after the 
controller has been prepared as described in Chapter 31.   

Read Chapter 31 before trying to calibrate the controller.   

The calibration menu is available only when the security access level is set to 
     (factory).52 

27.2 Calibration Is Not Usually Required 
You do not have to calibrate every new controller.  New controllers are calibrated 
at the factory for the input type(s) you specified when ordering the controller.  In the 
context of ordering the controller, “type” refers to these choices:   

 thermocouple 

 RTD 

 decimal RTD 

 millivolt linear 

 volt linear 

 current linear 

27.3 Menu Items 
Parameter Name: Calibration Low 

Name as Displayed:     

When Displayed: always 

Description: 

 

 

Displays the temperature input value that should be simulated 
during low calibration.   

Beware!  Pressing the  or  key while this is on display 
will clear the controller’s existing zero offset and initiate the low 
calibration, even if you have not prepared the controller as 

                                                      

52 The access level in all new 2C and 4C boards is set to      at the factory.  Instructions for 
changing the access level are in Section 30. 
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described in Chapter 31.  If the controller has not been prepared 
correctly before you initiate calibration, the resulting calibration 
will be invalid. 

 

 

Parameter Name: Calibration High 

Name as Displayed:     

When Displayed: always 

Description: 

 

 

Displays the temperature input value that should be simulated 
during high calibration.   

Beware!  Pressing the  or  key while this is on display 
will clear the controller’s existing span adjustment and initiate the 
high calibration, even if you have not prepared the controller as 
described in Chapter 31. If the controller has not been prepared 
correctly before you initiate calibration, the resulting calibration 
will be invalid. 
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28. Configuring Serial Communications 
Parameters for MODBUS 

28.1.1 Introduction 

The      (serial) menu’s MODBUS communication parameters presented briefly 
below are described in more detail in Using the MODBUS Protocol with 2C and 4C 
Controllers.  We recommend that you consult that manual before setting up your 
MODBUS network and configuring these communication parameters.  

28.1.2 Assigning a Unique Controller Address When MODBUS is 
Used 

Parameter Name: Controller ID Number 

Name as Displayed:   .  

When Displayed: always 

Range: 1 to 247 

Default: 1 

Description: Used to assign a unique address to each controller on the 
MODBUS network.  Instead of using this address stored on the 
EEPROM, a 4C controller can use the address configured with 
DIP switches; see 3.3.2. 

28.1.3 Selecting the Baud Rate Applicable to MODBUS 
Communications 

Parameter Name: Baud Rate  

Name as Displayed:     

When Displayed: always 

Choices: 1200 
2400 
4800 
9600 
19,2 Kbaud 
38.4 Kbaud 
57.6 Kbaud 
115.2 Kbaud 

Default: 9600 

Description: Used to select the baud rate. 
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28.1.4 Selecting the Parity When MODBUS is Used 

Parameter Name: Parity 

Name as Displayed:    

When Displayed: if the card type is serial  

Choices:      none 
     odd 
     even 

Default: none 

Description: Regardless of the parity selected, a 2C or 4C board always uses 
1 start bit, 8 data bits, and 1 stop bit. 

 

28.1.5 Selecting the Sequence for 32-bit IEEE Registers 

Parameter Name: MODBUS IEEE Register Ordering 

Name as Displayed:     

When Displayed: always 

Choices:     MODBUS standard ordering: low register before high   

   non-standard ordering: high register before low 

Default: yes 

Description: Used to choose whether the two registers that make up a single 
32-bit IEEE floating point value are transmitted in standard 
MODBUS sequence (low before high), or not in standard 
sequence (high before low)  

 

 

You have finished configuring the communication parameters.   
 
If you are using PID control, go to Section 29 for tuning.   
 
If you are using on/off control, go to Section 30 for restricting 
access. 
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29. Tuning the Controller for PID Control 

29.1 Introduction 
When Proportional-Integral-Derivative (PID) control is used, the controller modulates 
output power by adjusting the output power percentage within a proportional band.  
Power is proportionally reduced as the process temperature gets closer to the 
setpoint temperature.  The integral action affects the output based on the duration of 
the process value’s variation from the setpoint, and the derivative action affects the 
output based on the rate of change of the process value.  If both standard outputs 
are used for PID control, then the same integral and derivative parameters apply to 
both outputs.  Proportional band is specified for each output individually, unless both 
outputs use the same action (direct or reverse).  

The proportional band, derivative action (rate), and integral action (auto reset) 
parameters are automatically adjusted by the Autotune operation described in 29.2.  

Autotune is best suited to temperature control applications.  Some other applications 
may respond well to Autotune.  However, some non-temperature control applications 
may require manual tuning, in which the proportional band, derivative action (rate), 
and integral term or manual reset are entered using the control menu as described in 
29.3. 
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29.2 Autotuning 

29.2.1 Introduction 

The procedure below is used to start Autotune using an optional display board.  You 
can also use a Multi-Comm host or a MODBUS master to change the mode, view 
and change parameter values, and to start Autotune.  

The Autotune operation overwrites any existing proportional band, integral, and 
derivative parameter values that were previously configured.  (When PID control is 
used, the manual reset value is ignored.) 

If more than one zone is set to use PID control, then this procedure must be repeated 
for each PID zone. 

29.2.2 Procedure 

To use the Autotune feature for temperature applications: 

1. Select the zone. 

2. Put the zone in standby mode by pressing the  (mode/enter) key until 
     is displayed on the top line (after approximately three seconds) and the 
current mode on the lower line.  (If      is never displayed, then both outputs 
for the zone are set to OFF in the output menu. You must dedicate at least one 
output to control before you can calibrate.)  
 
Press the  or  key to cycle through the modes until      is on the 

lower line.  Briefly press the  key again.  The display will show      
alternating with the process value on the top line, and the setpoint displayed 
steadily on the lower line. 

3. Configure the zone.  Quick instructions for setting up a zone to use PID control 
and many of the configuration default values are in Chapter 17.   

 For the Autotune feature to be available, at least one output type parameter must 
be set to PID (see 21.2).   

 For Autotune to work, the controller cannot be configured to ramp to the setpoint 
at startup as described in 25.2.  You do not have to disable the single-step ramp 
feature, but if it is enabled, set the      (single step ramp time) parameter to 
0 (zero). 

4. Select the appropriate Autotune damping setting (see 24.2), or leave it set to the 
default (normal). 

5. Enter the process setpoint using the  and  keys. 

6. If possible, wait for the process to become stable (no latent energy remaining).  
For heating or cooling applications, wait for the process to reach ambient 
temperature.  Unless the setpoint is at least 1% of supported sensor span above 
or below the initial process value, the Autotune will terminate with a 05 error code 
(see 29.2.3).   
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7. Start the Autotune operation. To initiate autotuning, press the  key until 
     is displayed on the top line and      on the lower line.  Use the  

or  key to display      on the lower line.  Press the  key again to start 
the Autotune operation. 

8. Unless you want to terminate the Autotune by putting the zone in standby or 
manual mode, do not press any keys during the Autotune operation.  While the 
controller does the Autotune,      will alternate with the process value on the 
top line.  (The lower line will continue to display the setpoint you entered in Step 
4.) 

9. When the controller has completed autotuning the zone successfully, the flashing 
     will disappear.  The display will revert to the normal mode operating display, 
with the process value on the top line and the setpoint on the lower line.  The 
controller will save the tuning parameter values in the proportional band, rate, and 
auto reset parameters.  (The new tuning values can be viewed in the      menu.)  
 
If the Autotune was unsuccessful, the top line will briefly display    plus a two-digit 
error code, and then go back to flashing     .  Refer to 29.2.3 for the Autotune 
error codes.  Fix the problem and try tuning again.  

10. Once Autotune has been completed successfully, and the PV and SV are on display, 
the controller is controlling the process. 
 
Monitor the process.  If unacceptable overshoot occurs, change the Autotune 
damping setting to high and repeat the Autotune.  If the process response is 
sluggish, change the damping setting to low and repeat the Autotune.  

Once setup is complete, we recommend changing the security access level to the 
most restrictive level suitable for your application.  See Chapter 30 for details. 
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29.2.3 Autotune Error Codes 

If an Autotune error occurs, the top line of the display will alternately show      
and an error code for three seconds before the autotuning terminates and the 
controller goes back into standby mode.  The error codes are in the table below. 

Error Code Description 

02 Neither output is configured for PID using the      or 

  .   (output type) parameter in the      (output 
menu). 

03 The process changes in the wrong direction.  The cause is 
usually reversed thermocouple leads or an incorrectly configured 

  .   or   .   (output action) parameter. 

05 There is not enough difference between initial PV and the 
setpoint.  For Autotune to work, the difference must be at least 
1% of supported sensor span.   

08 The startup curve (change in PV) was not acceptable to the 
Autotune algorithm.  This could be caused by a process upset 
that occurred during tuning.  Try Autotuning again when the 
process is stable.  If the error recurs, your process is not suitable 
for Autotuning.  Use manual tuning as described in 29.3. 

09 The Autotuning timed out because the process was 
unresponsive (or extremely slow).  Your process is not suitable 
for Autotuning.  Use manual tuning as described in 29.3, or 
configure the controller for on/off control). 
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29.3 Manual Tuning (Zeigler-Nichols PID Method) 

29.3.1 Introduction 

This tuning method may be used for non-temperature control processes or if the 
spread between initial process temperature and process operating temperature is 
small.  This manual tuning process requires that the PV be tracked over time.   

The procedure below is used to do manual tuning using an optional display board.  
You can use a Multi-Comm host or a MODBUS master to change the mode, and to 
view and change tuning parameter values.  

29.3.2 Procedure  

To perform manual tuning: 

1. Select the zone. 

2. For heat/cool control processes, disable any cooling device used or set the 
output type parameter (in the      (output) menu) for this direct-acting output 
to off.   (Usually, output 2 is used for cooling, so you would set   .   = 

   .)   

3. With the power off and the controller NOT in the Key Lockout security level, 
apply power and immediately put the controller in standby mode by pressing the 

 (mode/enter) key until      is displayed on the top line (after 
approximately three seconds) and the current mode on the lower line.  Press the 

 or  key to cycle through the modes until      is on the lower line.  

Briefly press the  key again.  The display will show      alternating with 
the process value on the top line, and the setpoint displayed steadily on the lower 
line. 

4. Enter the process setpoint using the  and  keys. 

5. Make sure the    (proportional band) is set to its maximum value, and that 
    (derivative / rate action),      (manual reset), and     (integral 
offset / auto reset) are all set to zero.  To access the menu system, press and 

hold the  (menu access) key until a menu name abbreviation is displayed on 

the top line.  Press the  key repeatedly until the      menu is reached.  

Step through the tuning parameters using the  key.  To change values, use 

the  and  keys, then press  to write the new value to the controller’s 
database.  

6. Put the controller in normal (automatic) mode by pressing the  key until      
is displayed on the top line (after approximately three seconds) and the current mode 
on the lower line.  Press the  or  key to cycle through the modes until     

is on the lower line.  Briefly press the  key again.  The display will show the 
process value on the top line and the setpoint on the lower line. 

7. While monitoring the recording device or plotting the displayed PV against time 
manually, decrease the proportional band value by repeatedly halving the value until 
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a small, sustained temperature oscillation is observed.  Measure the period in 
seconds of one cycle of oscillation (“T” on the diagram below).  

T

 

8. Divide the period of oscillation (T) by 8. The resulting number (quotient) is the correct 
    (derivative) time in seconds.   

9. Divide T by 2.  The resulting number (quotient) is the correct integral time in seconds.  

10. Multiply the proportional band value used in Step 6 (to obtain T) by 1.66 and enter 
this as the new proportional band value.  

Manual tuning of the heating output is complete.  If the second output will be used for 
PID cooling, set the cooling output type to PID.  (It was disabled in Step 1 of the 
manual tuning process.)  Enter the proportional band value calculated in Step 9 for 
the cooling output also.  If overcooling results, increase the cooling proportional 
bandwidth.  If too little cooling action results, decrease the cooling proportional band. 
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30. Changing the Security Access Level 

30.1 Introduction 
A 2C or 4C board can be configured to limit the functions and configuration menus 
that can be accessed using the keypad on an optional display board.  For example, 
the access level can be set to allow operators to change only the setpoint or the 
manual mode output percentage.  

A controller can be set to any of the access levels in the table below.  The sequence 
of levels in the table is from most restrictive to least restrictive.  New controller boards 
are shipped with the access level set to      (configuration), but resetting the 
parameters to their defaults sets the access level to     .   

The access level setting applies to all zones. After you have configured the controller 
for your application, set the access level to the most restrictive level appropriate for 
your site. 

Instructions for changing the access level are in 30.2. 

Displayed 
Abbreviation 

Access
Level 

 
Description 

   .  keypad 
lockout 

Highest security level; no access. 

While the access level is “keypad lockout”, no controller 
values can be changed, not even the setpoint. To escape, 

press the  key for approximately ten seconds, until 

   .  is displayed, then press . 

   setpoint only Setpoint or manual outputs can be adjusted; no access 
to mode or menus. 

When the access level is “setpoint only”, the keypad can be 
used to change the setpoint or the manual mode output 
percentage.  However, the operator will not be able to 
change the controller from normal (automatic) mode to 
manual, and vice versa.  

  .   setpoint plus 
mode 

Setpoint or manual outputs can be adjusted; mode can 
be changed; no access to menus. 

When the access level is “setpoint plus mode”, the keypad 
can be used to change the setpoint, manual mode output 
percentage, and control mode, including executing recipes, 
and switching from normal (automatic) to manual, and vice 
versa.  

     user All the “setpoint plus mode” functions, and limited 
access to menus.  

When the access level is “user”, the keypad can be used to 
do all the functions available in “setpoint plus mode”.  At the 
“user” level, the keypad can also be used to view and 
change the values on the control menu (tuning parameters), 
adjust the Autotune damping parameter, and view and 
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Displayed 
Abbreviation 

Access
Level 

 
Description 

change all the ramp/soak parameters. 

     configuration All the “user” functions, and access to all menus except 
calibration. 

When the access level is “configuration”, the keypad can be 
used to perform all controller functions and access all 
menus, except the calibration menu.   

     factory Access to everything. 

When the access level is “factory”, the keypad can be used 
to do all controller functions, including re-calibrating the 
controller. 

The controllers are calibrated at the factory for the input 
type(s) specified when the controller was ordered.  Unless 
you change the input type for a zone, usually a zone will 
never need re-calibration.  Do not leave the controller set 
to this access level after you have re-calibrated the 
controller. 
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30.2 Procedures 

30.2.1 To View the Access Level 

To view the access level when the PV and SV are displayed: 

1. Press and hold the  (menu access) key for approximately ten seconds.  (After the 
first three seconds a menu name will be displayed on the top line.  Ignore it and 

continue to press the  key.)  The display will show the access level label      
and the access level now in effect.  For example, if the controller is set to “user” level, 
the display will show: 

    

    

2. What you do next depends on whether the present access level is OK. 
 

If you do not want to change the access level, press the  (mode/enter) key once 
to go back to the PV and SV display. 
 
If you do want to change the access level, follow the instructions in 30.2.2. 

30.2.2 To Change the Access Level 

To change the access level when the current access level is on display: 

1. Use the  or  key to step through the list of access level choices. 

2. When the desired access level is on display, press the  key to write the new 
access level to the controller’s database and return to the PV and SV display. 
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31. Calibrating the Controller 

31.1 Introduction 
You do not have to calibrate every new controller.  New controllers are calibrated 
at the factory for the type of input(s) you specified when ordering the controller.  In 
the context of ordering the controller, “type” refers to these choices:   

 thermocouple 

 RTD 

 decimal RTD 

 millivolt linear 

 volt linear 

 current linear input 

If you change the input type (including changing linear input type), you must 
recalibrate. You might also have to change input jumper settings.  See 3.2 for details. 

   
WARNING 

All wiring should be done by an experienced technician and be installed 
in accordance with national and local electrical codes.  To avoid serious 
personal injury and damage to equipment, follow all warnings and 
cautions provided in the controller installation manuals. 

 

31.2 Determining the Simulated Input to be Used During Low 
and High Calibration 

31.2.1 Introduction  

When calibrating the controller, you will remove the output wiring.  You will remove 
the input wiring and substitute an appropriate simulated input to the controller’s input 
terminals. 

 When calibrating for an RTD input, you will apply an appropriate resistance value 
across the input terminals using a “decade box” or precision resistors as 
described in 31.2.2. 

 When calibrating for a thermocouple input, you will use a thermocouple simulator 
to provide input during calibration as described in 31.2.3. 

 When calibrating for a linear input, you will use a milliamp, millivolt, or voltage 
input device as described in 31.2.4. 



2C and 4C Controller Installation, Configuration, and Operation Guide 

31-2  Athena Controls, Inc. 900M231U00A 

31.2.2 Simulating RTD Input for Calibration 

When calibrating the controller for use with an RTD input, you will remove the output 
wiring.  You will remove the input wiring and substitute an appropriate resistance 
across the controller’s input terminals.   

For this purpose, good results can be achieved using a “decade box” type of 
calibrator or using precision resistors.  Use of an “active resistance” calibrator (that 
simulates resistance with its circuitry instead of actually providing the resistance) may 
not produce satisfactory results. 

Before calibrating the controller, you must determine the correct resistance to apply.  
Two resistance values are used, one for low calibration and one for high calibration.  
For RTD inputs, each of these resistances corresponds to a calibration low and 
calibration high temperature.  The calibration temperatures depend on the specific 
type of input.  The values can be read from the      (cal low) and      (cal 
high) parameters in the     (calibration) menu as described in Chapter 27.   

For example, if the     (input) menu      (type) parameter is set to     and 
the      (unit of measure) parameter in the      menu is set to   
(Fahrenheit), then the calibration low value displayed will be 32 and the calibration 
high value displayed will be 1414. 

The table below shows the resistance that represents the RTD calibration low and 
calibration high temperatures.  Use this table to determine what resistance to apply 
across the input terminals when performing the calibration procedure described in 
this chapter. 

Low Calibration High Calibration  
 
 

Input 

Resistance 
Setting  
in ohms 

Temperature 
Equivalent  

in F (C) [K] 

Resistance 
Setting  
in ohms 

Temperature Equivalent  
in F (C) [K] 

RTD 100 ohms 32 F (0 C) [273 K] 365 ohms 1408 F (765 C) [1038 K] 

RTD with 
decimal 
support 

100 ohms 32 F (0 C) [273 K] 221 ohms 617.5 F (325.3 C) [598.3 K] 

31.2.3 Simulating Thermocouple Input for Calibration 

When calibrating the controller for use with a thermocouple input, you will remove the 
output wiring.  You will remove the input wiring and substitute a simulated input 
provided by a thermocouple simulator.   

Before calibrating the controller, you must determine the correct temperature input 
values to simulate during calibration.  Two values are used, one for low calibration 
and one for high calibration.  The temperatures to be simulated depend on the 
specific type of input.  The values can be read from the      (cal low) and 
     (cal high) parameters in the     (calibration) menu as described in 
Chapter 27.   

For example, if the     (input) menu      (type) parameter is set to J 
thermocouple and the      (unit of measure) parameter in the      menu is 
set to   (Fahrenheit), then the calibration low value displayed will be 32 and the 
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calibration high value displayed will be 1258. 

Set the thermocouple simulator accordingly when performing the calibration 
procedure described in this chapter. 

31.2.4 Simulating Linear Input for Calibration 

When calibrating the controller for use with a linear input, you will remove the output 
wiring.  You will remove the input wiring and substitute a simulated input provided by 
a milliamp input device, millivolt input device, or voltage input device, depending on 
the type of input you plan to use for control.   

During calibration, you will simulate two process values: one for low calibration and 
one for high calibration.  In the case of linear inputs, these are usually the process 
values that are configured for the    .  (linear input scaling low limit) and 
   .  (linear input scaling high limit) parameters in the     (input) menu.  
These scaling values are the values displayed for the      (cal low) and      
(cal high) parameters in the     (calibration) menu as described in Chapter 27.   

Configure the input scaling parameters    .  and    .  before calibrating the 
controller.  During calibration, use the lowest input value for the calibration low value 
and the highest input value for the calibration high value.  For example, if you plan to 
use a 0 to 20 mA input for control, then apply 0 (zero) mA to the input terminals 
during low calibration and 20 mA to the input terminals during high calibration. 
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31.3 Preparing the Controller 
To prepare the zone for calibration: 

1. Select the zone. 

2. Make sure the access level is set to      (factory).  Instructions for viewing 
and changing the access level controller are in Chapter 30.   

3. Go to the     (input menu) and select the new input type as described in 19.5. 

Be sure to press the  (mode/enter) key when the new input type is on display, 
so that the change is written to the controller’s database.  

4. In the case of linear input types, also use the    .  and    .  (scaling 
low and scaling high) parameters (in the input menu) to specify the PV 
represented by the lowest possible linear input signal and the PV represented by 
the highest possible linear input signal. 

5. Remove power from the controller and disconnect all output wiring. 

6. Disconnect the input wiring. 

7. Attach an appropriate calibrator (or precision resistor representing the calibration 
low process value) to the input terminals.  (Refer to 31.2 to determine the type of 
device to be used to calibrate for the input type you have selected.) 

8. Power up the controller and put the zone in standby mode.  Allow the controller 
to warm up for fifteen minutes after you have attached the calibrator (or precision 
resistor for the low calibration). 

After the fifteen minute warm-up, you are ready to proceed with the calibration as 
described in 31.4. 
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31.4 Initiating the Calibration 
To calibrate the controller after it has been prepared as described in 31.3 
(including the fifteen minute warm-up period in standby mode): 

1. Select the zone. 

2. Go to the     (calibration) menu and display      (calibration low).  It will 
alternate with the process value for which you must apply a simulated input (see 
31.2). 

3. To initiate low calibration, when      is on display, press the  or  
key. 
 
To initiate low calibration using a MODBUS write function, follow the instructions 
in Using MODBUS Protocol with 2C and 4C Controllers.  (Special values must be 
written to the correct two MODBUS registers in the same write operation.) 

4. While the controller performs the calibration, the display will freeze with      
on the lower line.  When the low calibration has been completed, the lower line 
will display     .   (If the calibration is not successful,      (error 
calibration) will be displayed.  You probably did not supply the correct simulated 
input.  Fix the problem and try again.) 

5. After successfully doing the low cal operation, you are ready to continue with the 
high calibration procedure.   
 
If you are using a “decade box” calibrator, thermocouple calibrator, or linear input 
source, switch to the appropriate input for the “calibrate high” operation. 
 
If you are using precision resistors for RTD calibration, remove power from the 
controller, remove the low calibration resistor, and install the high calibration 
resistor across the input terminals, then power up the controller.  After powering 
up the controller, wait fifteen minutes before proceeding to the next step.  (This 
fifteen minute wait for warm-up is required only if the controller has been 
powered down to permit you to change a precision resistor at the input 
terminals.) 

6. Display     .  (If      is on display, press   (mode/enter) to display 
    .)       will alternate with the PV for which you must apply a 
simulated input (see 31.2). 

7. To initiate high calibration when      is on display, press the  or  
key. 
 
To initiate high calibration using a MODBUS write function, follow the instructions 
in Using MODBUS Protocol with 2C and 4C Controllers.  (Special values must be 
written to the correct two MODBUS registers in the same write operation.) 

8. While the controller performs the calibration, the display will freeze with      
on the lower line.  When the high calibration has been completed, the lower line 
will display     . (If the calibration is not successful,      (error 
calibration) will be displayed.  You probably did not supply the correct simulated 
input.  Fix the problem and try again.) 
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If both the low calibration and the high calibration were successful, you are ready to 
return the controller to service as described in 31.5. 

31.5 Returning the Controller to Service 
To return the zone to service: 

1. Remove power from the controller. 

2. Remove the precision resistor or calibrator from the inputs. 

3. Replace the input and output wiring. 

4. Power up the controller. 
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32. Error Messages and Codes 

32.1 Introduction 
Usually the controller displays the process variable on the top line and the setpoint 
on the lower line of the display.  When the controller is in a mode other than normal 
(automatic), the mode alternates with the PV.  However, when the controller detects 
a problem with the input signal or with its own operation, messages and codes are 
displayed to alert you to a condition that requires your immediate attention. 

32.2 Problem with Input Signal 

32.2.1 Introduction 

When the controller detects a problem with the input signal, a message is displayed 
on the top line in place of the process value.  For example, if the controller detects an 
open sensor when the setpoint is 250, the display would look like this: 

    

   

32.2.2 Input Error Messages 

The table below lists the error messages and codes displayed in place of the process 
value when a problem with the input is detected by the controller.  These error 
conditions can be read from all controllers by a MODBUS master or a Multi-Comm 
host.   

When the controller detects any of these sensor problems, the controller’s outputs 
will go to the percentage specified using the failsafe values (if any) configured using 
the      a n d       parameters in the      (supervisor) menu (see 
26.2). 

Display Error Condition Operator Action 

   i open sensor Check the sensor and wiring.  

This message will clear when the problem has 
been corrected. 

     reversed sensor Make sure the correct input type has been 
selected for the input type parameter.   

Check sensor polarity.   

This message will clear when the problem has 
been corrected. 

     loop break; the input value 
has not changed for the time 
period specified using the 
supervisor menu’s loop 
break time parameter. 

Check sensor and wiring.  

This message will not clear automatically when 
the problem has been corrected.  You must 
cycle the power to the controller to clear the 
message and to cause the controller to resume 
normal operation. 
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32.3 Problem with Controller 

32.3.1 Introduction 

If the controller detects a problem with its own operation, it displays     on the top 
line instead of the process value and displays a numerical code on the lower line 
instead of the setpoint.  For example, if the controller detects a checksum error, the 
display will show: 

   

    

32.3.2 Controller Error Codes 

The table below lists the error messages and codes displayed in place of the setpoint 
value when a self-diagnostic is failed by the controller.  These error conditions can be 
read from all controllers by a MODBUS master or a Multi-Comm host.   

The effect of the error condition on the controller’s outputs depends on the error, as 
described below. 

Display Error Condition Operator Action 

     RAM error 

This message is usually 
displayed only at startup, 
before any outputs are 
calculated. 

Press any key to clear the message. . 

 

     default parameter values 
were loaded automatically, 
because the controller found 
corrupted values stored on 
the EEPROM 

This message is usually 
displayed only at startup, 
before any outputs are 
calculated. 

Press any key to clear the message. 

Re-configure all configuration parameter 
values, including input type. . 

     default parameter values 
were loaded automatically 
because the 4C controller 
was powered up with all DIP 
switches set on53 

This message is usually 
displayed only at startup, 
before any outputs are 
calculated. 

Press any key to clear the message. 

Re-configure all configuration parameter 
values, including input type. . 

     EEPROM write failure 

This message is usually 
displayed only at startup, 
before any outputs are 
calculated. 

Press any key to clear the message. 

Try the write operation again.  If the 
message recurs and persists, the EEPROM 
may be worn out.  Call for service. (See Note 
1 below.) 

                                                      

53 The 2C board does not have these DIP switches. 
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Display Error Condition Operator Action 

     power fail resume feature 
cannot be used 

The EEPROM is worn out; no 
storage space is available for 
storage of recipe execution 
information.  Therefore, this 
message is displayed when 
power is restored after a 
power failure that occurred 
while a recipe was being 
executed under the direction 
of the controller.  When this 
message is displayed, 
execution of the recipe 
cannot be resumed 
automatically. 

Press any key to clear the message. 

Call for service. (See Note 1 below.)  

    



through 



     

interrupt-related problem 

While one of these messages 
is on display, the controller 
outputs are held at state in 
use when the problem was 
detected. 

Cycle the power to the controller. If the 
message recurs and persists, call for 
service. 

Note 1: A host computer can wear out the EEPROM by writing to it too many times.  
Do not write the setpoint to the EEPROM when you are writing a temporary setpoint 
to the controller, such as when you are ramping to a final setpoint under the direction 
of a MODBUS master. 
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Section E – Appendices  
 

This section contains information about: 

 frequently asked questions – see page 33-1 
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33. Frequently Asked Questions 

Introduction 
Before you call for tech support, please look at this chapter to see if your question is 
covered here.  If you do call for technical assistance, be ready to supply the following 
information:  

 complete model number of controller 

 symptoms of the problem 

 unusual events, if any, that preceded the problem 

 remedies you have already tried 

How do I change from thermocouple to RTD (or vice versa)? 
To change the type of sensor used (or to switch to a linear input), go to the input 
menu and change the input type specified (see 19.5).  If you change to a linear input 
type, you can use input menu parameters to scale the input. 

You must also change the analog sensor jumper settings (see 19.3) and calibrate for 
the new input type (see Chapter 31), and for PID control you must retune (see 
Chapter 29). 

Why doesn’t the PV displayed match the value on a thermometer 
in the process? 

Unless the thermometer and the sensor providing input to the controller are very 
close to one another, their readings will not match in some applications, because of 
temperature variations within the process.  However, if you want the controller to 
maintain the setpoint value at the location of the thermometer, instead of at the 
location of the sensor, use the input menu’s bias parameter for RTD or thermocouple 
inputs.    Applying bias allows you to compensate for any difference between sensor 
temperature and the location to be measured.  The process variable and setpoint will 
be offset by the value entered for the bias parameter.  (See 19.6.1.)  

For example, suppose you want the process to be 150 F.  However, the sensor 
providing input to the controller is so close to the heater that it reads 50 degrees 
higher than the process at the location of interest to you.  Enter –50 as the bias 
value.  Enter the setpoint of 150.  The setpoint 150 will be displayed.  However, the 
controller will use a setpoint of 200.  The process value displayed will also be offset, 
so that when the temperature at the sensor location next to the heater is 206 F, the 
controller shows 156, the temperature at the location of interest in the process. 



2C and 4C Controller Installation, Configuration, and Operation Guide 

33-2  Athena Controls, Inc. 900M231U00A 

Why does my compressor cycle so often? 
If the controller’s output type parameter is set to PID, the controller attempts to 
moderate the rate of change of the PV.  PID control is not appropriate for devices 
such as compressors that are either on or off.  Change the output type to on/off.   

 When the on/off output action is configured for reverse action (heating 
applications), the controller will apply 100% output if the process temperature is 
below the setpoint and 0% if the PV is at the SV.   

 When the on/off output action is configured for direct action (cooling 
applications), the controller will apply 100% output if the process temperature is 
above the setpoint and 0% if the PV is at the SV. 

The result of switching from PID to on/off will be a reduction in the cycling of the 
compressor.  The trade-off is greater oscillation of the process temperature. (If there 
is still too much cycling, introduce hysteresis to the on/off control as described in 
1.6.3.1.) 

Why doesn’t the controller communicate with the host 
computer? 

When a controller has been communicating successfully with a MODBUS master or 
Multi-Comm host computer, then stops communicating, the cause is most likely 
damage to the network wiring.  However, before going to search for the fault, take a 
quick look at the communication settings on the controller’s serial menu.  Make sure 
that the controller ID has not been changed, and that the other communication 
settings match those used by the host.  (See Chapter 28.)  

Why isn’t the setpoint displayed all the time? 

The controller’s      (display) menu contains a      (setpoint blanking) 
parameter that can be used to specify the number of seconds the setpoint is 
displayed.  Once the configured time period has elapsed the setpoint display will go 
blank and remain blank until any key is pressed.  Pressing any key will cause the 
controller to display the setpoint again.  The setpoint will remain on display until the 
period specified in the setpoint blanking parameter has elapsed. 

If you want the setpoint to be displayed all the time while the unit is in a control mode, 
turn off the blanking function by setting the setpoint blanking parameter to OFF.   
(See 20.2.2 or 20.3.2.) 

The last digit of the PV display changes very frequently.  How 
can I slow it down? 

If the display is configured to show one or more decimal places, those values might 
change frequently, sometimes so quickly that the value is hard to read.  Go to the 
     (display) menu and increase the value of the      (display filter) 
parameter.  The display filter parameter is used to specify the minimum time period 
between changes of the displayed PV value.  The display filter value has no effect on 
control. (See 20.2.2 or 20.3.2.)   

In contrast, the input menu’s input filter does affect control, because the input filter is 
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used to specify the time period over which the controller will average the input values 
before using the value in the calculation of control output values.  (See 19.6.3 or 
19.7.4.) 

Why is the setpoint changing?  I haven’t touched the controller! 
As described in 1.7, the setpoint used (and displayed) when the controller is 
operating in “normal” mode (automatic) is not always entered by the operator using 
an optional display board’s keypad.  The active setpoint can come from a recipe or 
from a host computer. 
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34. Index 
 

A 
A1 and A2 indicators in Multi-Comm, 8-1 
access levels 

described, 1-7, 30-1 
menus, 15-5 

access privileges in Multi-Comm, 6-4 
Add Controller window (Multi-Comm), 7-8 
adding controllers in Multi-Comm, 7-5, 7-8 
address for controller, 3-4, 3-5, 7-3, 7-8, 7-9, 28-1 
alarm action, 1-12, 21-8, 23-3 
alarm annunication, 5-4 
alarm delay, 21-10, 23-5 
alarm menu, 18-6, 23-1 
alarm operation, 1-12, 21-9, 23-4 
alarm outputs, configuration of, 21-4 
alarm outputs,configuration of, 21-8 
alarm setpoint, 21-11, 23-6 
alarm value, 21-11, 23-6 
alarms 

configuration, 23-1, 23-3 
inhibiting, 21-10, 23-5 
LEDs indicating state, 15-7, 15-10, 15-12, 15-14 
methods of annunciation, 1-4, 1-11, 8-1, 15-7, 15-10, 15-12, 

23-1 
Multi-Comm, 8-1 
types supported, 1-11 

ALr menu. See alarm menu 
analog inputs 

configuration parameters for, 19-1 
jumper settings, 3-2 
supported sensor types, 2-6 

analog output cycle time, 21-6 
Append Step button (Multi-Comm), 12-2 
Apply button (Multi-Comm), 11-2, 12-11 
auto reset, 1-8, 22-6, 22-7, 22-8, 29-1, 29-5, 29-6 
automatic mode. See normal mode 
Autotune 

damping menu, 1-7, 18-6, 24-1, 30-2 
display, 15-2 
in Multi-Comm, 10-1 
parameters adjusted, 22-6 
selection display, 1-6 

B 
baud rate, 3-9, 7-2, 7-4, 28-1 
bias, 19-7, 19-10, 33-1 
blanking, 20-4, 20-6, 33-2 
bumpless transfer, 1-4, 16-6 

C 
cabling 

communication, 3-8 
input/output, 3-17 
power, 3-12 

calibration 
permission to do, 1-7, 30-2 

calibration menu, 18-7 
calibration procedure, 27-1 
Change Password window (Multi-Comm), 6-3 

changing 
fixed output percentage, 16-6 
mode, 16-5 
setpoint, 16-5 

communication 
option card, 28-1 
settings in Multi-Comm, 7-2, 7-4 
settings in PC, 3-9 
setup, 3-8 

communication card grounding, 3-9 
communication LED, 15-8, 15-10, 15-13, 15-14 
Communications Setup window (Multi-Comm), 7-4 
configuration 

communication parameters, 7-2 
display, 15-4 
effect on output state, 15-4 
example, 16-12 
general information, 18-1 
importance of sequence, 1-14 
parameter sequence, 18-5 
permission to access, 1-7, 30-1 
sequence, 1-14 
using Multi-Comm, 11-1 
viewing and changing values, 16-11 

configuration (access level), 1-7, 30-2 
Connector field (Multi-Comm), 7-4 
control menu, 18-6, 22-1 
control types supported, 1-8 
controller addresses, 3-4, 7-3, 7-8, 7-9, 28-1 
Controller menu (Multi-Comm), 5-7 
controller parameter sets, saving and loading with Multi-Comm, 

13-2, 13-4 
controller recipes. See recipes (controller) 
CtrL menu. See control menu 
current inputs, 19-1, 19-4, 19-10, 20-5 
cycle time, 21-6 

D 
damping parameter, 24-1 
DAT file, 6-6 
data bits, 3-9, 7-2, 7-4 
data format, 28-2 
Data Format field (Multi-Comm), 7-4 
deadband for on/off control 

configuration, 22-4 
example, 1-9 

decimal position, 20-3, 20-5 
default address, 3-5 
default output assignments, 2-4 
default values for parameters 

accepting, 18-8 
list, 18-3 
message when loaded automatically, 32-2 
restoring, 3-4, 26-3 

Delete Step button (Multi-Comm), 12-3 
deleting controllers in Multi-Comm, 7-9 
deleting login accounts in Multi-Comm, 6-6 
derivative action, 1-8, 22-6, 22-7, 29-1, 29-3, 29-5 
detection of option boards, 3-6 
deviation alarms, 1-12, 21-9, 21-11, 23-4, 23-6 
Device Manager, 3-10 
digital inputs 

specification, 2-6 
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digital outputs. See outputs 
dimensions, 2-5, 4-1 
DIP switch settings, 3-4, 7-3 
direct output action, 21-5, 21-6 
display at startup, 1-15 
display menu, 18-5, 20-1, 20-5 
down key, 15-2, 16-2 
dSPL menu. See display menu 

E 
Edit menu (Multi-Comm), 5-7 
editing login accounts in Multi-Comm, 6-6 
EEPROM 

storing address, 3-4, 7-3, 28-1 
write error, 32-2 
writing setpoints, 1-11 

EMC files, 13-3 
error codes, 29-4, 32-1 
events for recipes 

alarm action, 23-3 
configuration, 25-11, 25-12 
indication, 1-12 

excitation voltage jumpers, 3-3 

F 
factory (access level), 1-7, 30-2 
factory default values for parameters 

accepting, 18-8 
list, 18-3 
restoring, 26-3 

failsafe outputs, 26-2 
File menu in Multi-Comm, 5-6 
filtering 

display, 20-3, 20-5, 33-3 
input, 19-8, 19-12 

finding controllers (Multi-Comm), 7-5, 7-8 
fixed output percentage 

and manual mode, 1-6, 15-2 
changing, 16-6 
permission to change, 1-7, 30-1 

four-wire sensors, 3-16 
fuse rating, 2-6 

G 
Graph window (Multi-Comm), 9-3 
grounded thermocouples, 3-12, 3-15 
grounding, 3-9, 3-12, 3-16 

H 
hardware requirements for Multi-Comm computer, 5-4 
highest reading, 26-3 
Hold function in Multi-Comm, 12-6 
Holdback Band field (Multi-Comm), 12-3, 12-10 
holdback parameter, 25-1, 25-5, 25-9 
hysteresis for on/off control 

configuration, 22-4, 22-5 
example, 1-9 
limited by input scaling, 19-11 

I 
IEEE register ordering, 28-2 
inhibiting alarms, 21-10 
InP menu. See input menu 
input bias, 19-7, 19-10, 33-1 
input failure, 26-2 
input jumpers, 3-2, 19-2 
input menu, 18-5, 19-1, 19-2 
input type, 19-4 

inputs 
bias, 19-7, 19-10, 33-1 
failure, 26-2 
filtering, 19-8, 19-12 
scaling, 19-11 
wiring, 3-17 

Insert Step button (Multi-Comm), 12-4 
installing Multi-Comm software, 6-1 
integral action, 1-8, 22-6, 22-8, 29-1, 29-5, 29-6 
interrupt (unexpected or invalid), 32-3 
inverse band alarms, 1-12, 21-9, 21-11, 23-4, 23-6 

J 
J4, 2-6, 3-14 
jumpers 

analog sensor, 3-2 
input, 19-2 
remote excitation, 3-3 

K 
keypad 

functions, 16-1 
using, 16-5 

keypad lockout (access level), 1-7, 30-1 

L 
latching alarms, 1-12, 16-10, 21-8, 23-3 
LEDs 

alarm indication, 15-7, 15-10, 15-12, 15-14 
alarms, 23-1 
communication indication, 15-8, 15-10, 15-13, 15-14 
output state indication, 2-7, 15-7, 15-9, 15-11, 15-14 
status, 2-7 
zone indication, 15-6, 15-8, 15-11, 15-13 

linear inputs, 1-14, 19-1, 19-4, 19-10, 20-5 
Load button (Multi-Comm), 13-5 
loading default parameter values, 3-4, 26-3 
logging in to Multi-Comm, 6-2 
logging out of Multi-Comm, 6-6 
logging PV and SP values in Multi-Comm, 14-1 
Logging window (Multi-Comm), 14-1 
login accounts in Multi-Comm:, 6-4 
loop break detected, 32-1 
loop break time, 26-2 
lowest reading, 26-3 

M 
manual mode 

changing mode with Multi-Comm, 10-1 
display, 15-2 
permission to change outputs, 1-7, 30-1 
selection display, 1-6 

manual reset, 1-8, 22-6, 22-7, 29-1, 29-5, 29-6 
manual tuning procedure, 29-5 
MCS files 

closing, 7-10 
creating, 7-10 
opening, 6-2, 7-8, 7-10 
removing zone from, 7-9 
saving, 5-6, 7-9 

menu access key, 15-2, 16-2 
menu overview, 5-6 
menu system in controller 

accessing, 16-11 
menu system in controller 

display sequence, 15-4 
permission to access, 1-7 

menu system in controller 
display sequence, 18-5 
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menu system in controller 
permission to access, 30-1 

milliamp inputs, 19-1, 19-4, 19-10, 20-5 
millivolt inputs, 19-1, 19-4, 19-10, 20-5 
MODBUS address. See address for controller 
Modbus protocol 

Autotuning with, 29-2 
calibration with, 31-4 
configuring communication parameters, 28-1, 33-2 
manual tuning with, 29-5 
reading error codes, 32-1, 32-2 
recipe execution, 15-3 

MODBUS starting addresses, 3-4, 7-3, 7-8, 7-9, 28-1 
mode/enter key, 15-2, 16-3 
model number breakdown, 2-2 
modes of operation 

changing in Multi-Comm, 10-1 
displays, 15-2 
permission to change, 1-7, 30-1 
selecting, 1-6, 16-3 

mounting dimensions, 4-1 
MULTI login account, 6-2, 6-3 
Multi-Comm application 

alarm annunication, 5-4 
Autotuning with, 29-2 
calibration with, 31-4 
computer requirements, 5-4 
executing recipes, 15-3 
features, 5-1 
installation, 6-1 
logging in, 6-2 
manual tuning with, 29-5 
reading error codes, 32-1, 32-2 
serial communication, 33-2 

Multi-Comm recipes. See recipes (Multi-Comm) 
Multi-Comm Setup files 

adding controllers to, 7-6 
closing, 7-10 
creating, 7-10 
deleting zones from, 7-9 
opening, 7-10 
saving, 5-6, 7-9 

Multi-Step Ramp 
invoking in Multi-Comm, 12-10 

N 
naming controllers in Multi-Comm, 7-8, 7-9 
network addresses, 3-4, 7-3, 7-8, 7-9, 28-1 
network wiring, 3-8 
normal band alarms, 1-12, 21-9, 21-11, 23-4, 23-6 
normal mode, 1-6, 1-10, 15-2, 16-6, 33-3 

O 
on/off control 

advantages and disadvantages, 1-9, 33-2 
configuration, 21-5 
output type, 21-4 

on/off deadband 
configuration, 22-4 
example, 1-9 

on/off hysteresis 
configuration, 22-4, 22-5 
example, 1-9 
limited by input scaling, 19-11 

Open button, 12-11 
Open Recipe window (Multi-Comm), 12-5 
open sensor detected, 15-3, 32-1 
operator login accounts in Multi-Comm, 6-4 
Operator Login window (Multi-Comm), 6-2 
Operator Setup window (Multi-Comm), 6-4, 6-5, 6-6 
Operator window (Multi-Comm), 6-4, 6-5 
optional cards, 3-6 
optional display board, 2-7, 15-1 
Options menu (Multi-Comm), 5-9 
order codes, 2-2 

OutP menu. See output menu 
output failsafe values, 26-2 
output menu, 18-5, 21-1 
output range for PID, 21-7 
outputs 

default assignments, 2-4 
functions, 1-4 
LEDs indicating state, 2-7, 15-7, 15-9, 15-11, 15-14 
specifications, 2-6 
state during standby mode, 15-4 
state on power up, 1-15 
use for alarms, 1-4, 21-8 
wiring, 3-17 

overlays, 16-1 
overlays for display boards, 15-1 
overshoot, 1-8, 1-10, 17-4, 17-5, 24-1, 29-3 

P 
parameter display sequence, 18-5 
Parameter Set tab (Multi-Comm), 13-2, 13-4 
Parameters function in Multi-Comm, 11-1 
parameters, viewing and changing in Multi-Comm, 11-1 
parity, 3-9, 7-2, 7-4, 28-2 
part numbers 

accessories, 2-3 
communication cards, 2-2, 2-3 
display boards, 2-2 

passwords in Multi-Comm, 6-3, 6-5 
permission levels in controller, 1-7, 30-1 
permissions in Multi-Comm, 6-4 
PID control 

advantages and disadvantages, 1-8, 33-2 
instructions for quick setup, 17-1 
output action, 21-6 
output type, 21-4 
tuning, 24-1, 29-1 

Polling Frequency field (Multi-Comm), 7-4 
port settings, 3-9 
power failure resume, 25-10, 32-3 
power supply, 2-3, 2-6, 3-12, 3-14, 3-15, 3-16 
power wiring, 3-12 
powering up controller, 1-15 
PRF files, 13-3, 13-5 
privileges in Multi-Comm, 6-4 
process alarms, 1-11, 8-1, 21-9, 21-11, 23-4, 23-6 
process lag, 1-8 
process value 

displaying, 15-2, 33-3 
highest, 26-3 
lowest, 26-3 
viewing in Multi-Comm, 9-2, 9-3 
viewing with optional display board, 15-1 

proportional band, 1-8, 22-6, 22-7, 29-1, 29-3, 29-5, 29-6 
Proportional-Integral-Derivative control. See PID control 
pushbutton purposes. See SW assignments 
PV. See process value 

R 
RAM error, 32-2 
RAM, writing setpoints, 1-11 
ramp events, 1-12, 23-3, 25-11 
Ramp Time field (Multi-Comm), 12-3, 12-11 
ramp times, 25-1, 25-11 
Ramp to Setpoint Function. See Single-Step Ramp function 
ramp/soak execution 

directed by external host, 15-3 
feature described, 1-5 
holding, 1-6, 15-2, 16-8 
resuming, 1-6, 16-8 
starting, 15-2, 16-8 
termination state, 16-9 

ramp/soak menu (controller), 1-7, 1-12, 18-6, 25-1, 30-2 
Ramp/Soak Menu (Multi-Comm), 5-9 
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range 
PID output, 21-7 
setpoint, 19-12 

rate of change, 1-8, 22-6, 22-7, 29-1, 29-3, 29-5 
RCP file, 12-3 
Recipe Control window (Multi-Comm), 12-6 
Recipe Editor window (Multi-Comm), 12-2 
recipe events 

configuring, 25-11, 25-12 
dedicating alarm, 23-3 
indication, 1-12 

recipe holdback parameter, 25-5, 25-9 
recipe option, 25-4 
Recipe tab (Multi-Comm), 9-5, 12-9 
recipes (controller) 

configuring in Multi-Comm, 12-9 
configuring with optional display board, 25-1 
execution directed by external host, 15-3 
holding, 1-6, 15-2, 16-8 
parameters, 25-1 
resuming, 1-6, 16-8 
running in Multi-Comm, 12-12 
running with optional display board, 16-8 
setpoint, 1-11 
starting, 15-2, 16-8 
termination state, 16-9 

recipes (Multi-Comm) 
configuring, 12-2 
described, 1-5 
running, 12-5 

recognizing controllers (Multi-Comm), 7-5, 7-8 
recovery, 1-8, 17-4, 17-5, 24-1, 29-3 
recycle number, 25-10 
register ordering, 28-2 
relays, 2-3 
remote excitation voltage jumpers, 3-3 
Repeats field (Multi-Comm), 12-2, 12-10 
resume from power failure, 25-10 
Resume function in Multi-Comm, 12-7 
reverse output action, 21-5, 21-6 
reversed sensor detected, 15-3, 32-1 
RS file, 12-11 
r-S menu. See ramp/soak menu 
RTD inputs, 1-14, 19-1, 19-4, 19-7, 20-3, 33-1 
Run Recipe Controller Selection window (Multi-Comm), 12-5 

S 
safety information, I, 3-12 
Save Parameter Set window (Multi-Comm), 13-3 
scaling inputs, 1-14, 19-11 
security access levels 

described, 1-7, 30-1 
menus, 15-5 

self-diagnostics failed, 15-3, 32-2 
sensor failure, 26-2 
sensor ground, 3-12 
sequence of configuration parameters, 1-14 
serial menu, 18-7 
setpoint 

alarm, 21-11, 23-6 
at recipe termination, 25-6, 25-9 
changing in Multi-Comm, 9-4 
changing with optional display board, 15-1, 16-5 
displaying with optional display board, 15-2 
ramping to, 1-15, 16-8, 16-9, 25-5 
sources, 1-10 
specifying range, 19-8, 19-12 
viewing in Multi-Comm, 9-2, 9-3 
viewing with optional display board, 15-1 

setpoint display blanking, 20-4, 20-6, 33-2 
setpoint only (access level), 1-7, 30-1 
setpoint plus mode (access level), 1-7, 30-1 
Setpoint window (Multi-Comm), 9-4 
Single Step Ramp function 

configuring in Multi-Comm, 9-5 

described, 1-5, 1-15, 16-9, 25-5 
invoking in Multi-Comm, 9-5, 9-6 

soak events, 1-12, 23-3, 25-12 
Soak Level field (Multi-Comm), 12-3, 12-11 
soak levels, 25-1, 25-11 
Soak Time field (Multi-Comm), 12-3, 12-11 
soak times, 25-12 
software requirements for computer 

Multi-Comm, 5-4 
SP. See setpoint 
specifications, 2-1 
standard outputs, 1-13, 21-1, 21-6 
standby mode 

accessing, 16-5 
changing mode with Multi-Comm, 10-1 
operational display, 15-2 
selection display, 1-6 

Start Find Controllers function (Multi-Comm), 7-5 
starting addresses, 3-4, 7-3, 7-8, 7-9, 28-1 
status LEDs, 2-7 
stop bit, 3-9, 7-2, 7-4 
Stop function in Multi-Comm, 12-8 
supervisor menu, 26-1 
SUPr menu. See supervisor menu 
SW assignments, 15-1, 16-2 
switch settings, 3-4, 7-3, 7-8, 7-9, 28-1 
System Properties, 3-10 

T 
technical support, 33-1 
termination state, 25-6, 25-9 
Termination State field (Multi-Comm), 12-2, 12-8, 12-10 
thermocouple inputs, 1-14, 19-1, 19-4, 19-7, 20-3, 33-1 
three-wire sensors, 3-16 
Timeout field (Multi-Comm), 7-5 
transformer, 2-3, 2-6, 3-12, 3-15 
trend graphs, 9-3 
troubleshooting, 32-1, 33-1 
Tune function, 10-1 
tunE menu. See Autotune damping menu 
tuning 

automatically, 29-2 
manual procedure, 29-5 
parameters, 1-8, 22-1, 22-6, 29-1, 29-3, 29-5, 29-6 

two-wire sensors, 3-16 

U 
units of measure, 1-14, 20-4 
unresponsive processes, 12-3, 12-10 
up key, 15-2, 16-2 
user (access level), 1-7, 30-1 
User Id field, 6-5 
user interface, 15-1 

V 
View menu (Multi-Comm), 5-7 
voltage inputs, 19-1, 19-4, 19-10, 20-5 

W 
wiring 

communication, 3-8 
input/output, 3-17 
power, 3-12 

Z 
zone indication LEDs, 15-6, 15-8, 15-11, 15-13 
zone selection, 15-1, 16-1 
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Warranty 
 

Two-Year Limited Warranty 

THIS EQUIPMENT IS WARRANTED TO BE FREE FROM DEFECTS OF MATERIAL AND 
WORKMANSHIP. IT IS SOLD SUBJECT TO OUR MUTUAL AGREEMENT THAT THE 
LIABILITY OF ATHENA CONTROLS, INCORPORATED IS TO REPLACE OR REPAIR THIS 
EQUIPMENT AT ITS FACTORY, PROVIDED THAT IT IS RETURNED WITH 
TRANSPORTATION PREPAID WITHIN ONE (1) YEAR OF ITS PURCHASE. 

THE PURCHASER AGREES THAT ATHENA CONTROLS, INCORPORATED ASSUMES NO 
LIABILITY UNDER ANY  

CIRCUMSTANCES FOR CONSEQUENTIAL DAMAGES RESULTING FROM ITS USE OR 
FROM IMPROPER 

HANDLING OR PACKAGING OF SHIPMENTS RETURNED TO THE FACTORY. 

COMPONENTS WHICH WEAR OR WHICH ARE DAMAGED BY MISUSE ARE NOT 
WARRANTED. THESE INCLUDE CONTACT POINTS, FUSES, ELECTROMECHANICAL 
RELAYS, AND TRIACS. UNITS WHICH HAVE BEEN MODIFIED BY A CUSTOMER IN ANY 
WAY ARE NOT WARRANTED. 

Other than those expressly stated herein, THERE ARE NO OTHER WARRANTIES OF ANY 
KIND, EXPRESS OR IMPLIED, AND SPECIFICALLY EXCLUDED BUT NOT BY WAY OF 
LIMITATION, ARE THE IMPLIED WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE 
AND MERCHANTABILITY. 

IT IS UNDERSTOOD AND AGREED THE SELLER’S LIABILITY WHETHER IN CONTRACT, IN 
TORT, UNDER ANY WARRANTY, IN NEGLIGENCE OR OTHERWISE SHALL NOT EXCEED 
THE RETURN OF THE AMOUNT OF THE 

PURCHASE PRICE PAID BY THE PURCHASER AND UNDER NO CIRCUMSTANCES SHALL 
SELLER BE LIABLE 

FOR SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES. THE PRICE 
STATED FOR THE EQUIPMENT IS A CONSIDERATION IN LIMITING SELLER’S LIABILITY. 
NO ACTION, REGARDLESS OF FORM, ARISING OUT OF THE TRANSACTIONS OF THIS 
AGREEMENT MAY BE BROUGHT BY PURCHASER MORE THAN ONE YEAR AFTER THE 
CAUSE OF ACTION HAS ACCRUED. 

SELLER’S MAXIMUM LIABILITY SHALL NOT EXCEED AND BUYER’S REMEDY IS LIMITED 
TO EITHER (i) REPAIR OR REPLACEMENT OF THE DEFECTIVE PART OR PRODUCT, OR 
AT SELLER’S OPTION (ii) RETURN OF THE PRODUCT AND REFUND OF THE PURCHASE 
PRICE, AND SUCH REMEDY SHALL BE BUYER’S ENTIRE AND EXCLUSIVE REMEDY. THE 
SPECIFICATIONS PUT FORTH IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT 
NOTICE. 
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Unit Repairs 

It is recommended that units requiring service be returned to an authorized service center. Before 
a controller is returned for service, please consult the service center nearest you. In many cases, 
the problem can be cleared up over the telephone. When the unit needs to be returned, the 
service center will ask for a detailed explanation of problems encountered and a Purchase Order 
to cover any charge. This information should also be put in the box with the unit. This should 
expedite return of the unit to you. 

This document is based on information available at the time of its publication. While efforts have 
been made to render accuracy to its content, the information contained herein does not purport to 
cover all details or variations in hardware, nor to provide for every possible contingency in 
connection with the installation and maintenance. Features may be described herein which are 
not present in all hardware. Athena Controls assumes no obligation of notice to holders of this 
document with respect to changes subsequently made. 

Proprietary information of Athena Controls, Inc. is furnished for customer use only. No other use 
is authorized without the written permission of Athena Controls, Inc. 

 


